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l. Introduction

A. Overview

MicroStaffer serves as a complete system solution for Medical Staffing Agencies. It manages all aspects of staffing, schedul-
ing and availability tracking as well as payroll and billing.

MicroStaffer features include:

Calendar Staffing Windows: Here, employees are scheduled at facilities.

Real-Time/Date scheduling: No need to remember codes. Use real time clock entries from a user-friendly drop
down.

Employee Profile Tracking: Track all aspects of your Medical Staff including Licenses, Insurance Policies, Health
Certifications, Skills, Certifications and much, much more...

Ticklers and Alerts: Your staffers are automatically notified during scheduling when important dates (Licenses,
Physicals, Insurance Policies) have or are about to expire, when errors such as double bookings occur, when
orientations have not been performed or when employee/facility incompatabilities exist.

Tax Withholding Payroll Processing: Fully integrated payroll processing including Tax withholding for Federal,
FICA, Medicare, State, Deductions etc. (for Tax Library subscribers)

Dropdown list navigation throughout: No need to navigate using tedious dialog windows. Each dropdown has
built-in context sensitive search capability.

Customizable Invoice forms: Move, resize or otherwise customize for your individual needs. We can even custom
program your invoices for you!

Multi-tiered rate and shift schedules for both clients and employees: Allows for entry of commonly worked shifts
and rates based on those shifts.

Payroll and Billing adjustments: Ability to deduct and add amounts to invoices and payroll.

Check advances collections processing: Allows you to deduct non-worked hours from future payroll checks.
Multi-company enabled: Run several companies with the same software installation.

Multi-User: Fully multi user network capable with built in record locking.

State of the Art Reports & Query Manager: Multitude of instantly accessible on-line reports including staffing, payroll
and invoicing. Every report has print and export capabilities allowing for export to Excel, Text etc.

Advanced Technology: Open architecture allows for easy customization and is highly scalable.

Customizable: Ability to create your own data entry fields for both employees and customers and also run reports
based on the data in those fields.

Security Interface: Allows for different access types for different users.

Optional Web Module: Allows your customers and employees to enter orders & availabilities, view schedules etc.
using a standard Web Browser such as Internet Explorer or Netscape Navigator.

Email and Phone-Dial Enabled: Instantly send emails from within MicroStaffer. Create email lists from reports. Mail
schedules, confirmations, profiles, documents and much, much more with the click of a button. Instantly dial phone
numbers with the click of the mouse and correctly enabled phones.
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B. System Requirements

1. Client Workstations

*|IBM Compatible PC running Windows XP Professional, 2000 or NT 4.0
*Min. 800x600 256 Color Display.

At least 50 MB Free Disk Space.

*Min. 128 MB Ram.

2. Network Server

*Windows 2000, 2003 Server Operating System
*Microsoft SQL Server 2000
*Min. 1 GB Ram

Please contact us to discuss Multi-User installations in more detail.

3. Running on Windows 2003 Terminal Server

Dedicated Windows 2003 Terminal Server

1 GB Ram

Windows 2003 Terminal Server Access Licenses
Internet connection with port forwarding to Port 3389

C. Manual Use

The MicroStaffer User Manual is intended as a basic guide for the MicroStaffer Medical Staffing software. All attempts have
been made to clearly explain the use of MicroStaffer. For ease of use, employees/nurses are defined as “Employee” and
facilites where they work are defined as “Client”. MicroStaffer allows you to define these however you wish, but for consis-
tency, the manual refers to them as “Employee” and “Client”.

The MicroStaffer User Manual is separated into types of use. The first sections deal with first time setup of
MicroStaffer and explanations of all of the important codes used within the system:

Introduction
Connection Settings
System Setup and Administration

The next sections deal with the everyday use of MicroStaffer:

Using MicroStaffer — Staffing & Availability Tracking
Using MicroStaffer — Invoicing & Payroll Processing
Using MicroStaffer — Reports & Queries

Using MicroStaffer — Mail Merge

Using MicroStaffer - Document Manager

Using MicroStaffer — Web Access Module

The concluding sections are basic information:

Import/Export
Troubleshooting & FAQ'’s
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Il. Connection Settings

The following instructions detail the proper connection settings for MicroStaffer client workstations accessing Microsoft SQL
Server based systems.

1) Run the MicroStaffer Connect program by clicking Start->Programs->MicroStaffer->MicroStaffer Connect from the
Windows Start button.

2) When the MicroStaffer Connection Settings Window appears, select Microsoft SQL Server 7.0 (Driver) from the
dropdown next to Connection Type.

3) Click on the Configure button.

4) The SQL Server Client Network Utility window will open.

5) Select the General Tab and Click on Add.

6) The Add Network Library Configuration window will open.

7) Check the TCP/IP radio button under ‘Network Libraries’.

8) Under ‘Server Alias’, enter the name of the 2000/2003 server. This is the machine where the Microsoft SQL Data-
base Server is running.

If you do not know the name of the 2000/2003 Server you can obtain the name by right clicking on the Network Neighborhood
Icon on the 2000/2003 Server’s desktop and Selecting the ‘Identification’ tab. The 2000/2003 Server’'s name is listed next to
‘Computer Name'.

9) As you type into the ‘Server Alias’ field you will note that the ‘Computer Name’ field under ‘Connection Parameters’
will also be filled in with the same name. The reason for this is as follows: The ‘Server Alias’ field is merely a description of
the connection whereas the ‘Computer Name’ field is the actual name of the 2000/2003 Server (or the 2000/2003 Server’s IP
address).

Note: You can also add only the Server’s IP address into Computer Name field. Use the IP address if you are having
problems connecting with the Server's name.

10) Leave the default Port Number at 1433

Click on OK.
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12) SQL Server Client Network Utility window should now contain the new Server Alias

O S0QL Server Client Metwork Utility

General | M ebwiark. Lihrariesl DB Library Options

[f thiz client cannok use the server computer name and the default Met-Libran to connect
m| to SOL Server, change the default Met-Library or add a zerver aliaz with the required
— 2
=0 connection parameters.

Diefault network: libran: Mamed Fipesz j

Server aliaz configurations

Server alias | M ebwork: library | Connectioh parameters |

zerver] 1433

Bemove

Edit..

i

] I Cancel Apply | Help |

configuration and settings may look similar to this:

13) Click OK again. You will be returned to the MicroStaffer Connection Settings window.

14) In the ‘Server Name'’ field enter the name of the 2000/2003 Server that you used for the ‘Server Alias’ on the SQL
Server Client Network Utility window. In the above example it would be ‘server1’.

The ‘Server Name’ on the MicroStaffer Connection Settings window MUST match their ‘Server Alias’ on the SQL Server Client
Network Utility window.

15) In the ‘Database’ field, enter the name of the MicroStaffer database (usually this is SBA).
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a) Production Database: sbha

=7 MicroStaffer Connection Settings

Connection Type: ||"."|il:r|:|S|:|ft SOL Server [Driver]

Server Mame: |$erver LConfigure

Databaze: |3I:|a

k. | Cancel |

The window should look similar to this:

Click OK.

12
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lll. System Setup & Administration
A. Starting MicroStaffer for the First Time

When MicroStaffer starts up for the first time after installation you will be asked to log in. Please refer to Logging In on
what User ID and Password to use the first time you access the system. (Next section).

After logging in, you will then be prompted to create a New Company Profile.
Click on OK and the Company Setup Window will open and allow you to enter company data.

Once you have finished entering your New Company data, closing and saving the Company Setup Window will open the
main MicroStaffer Interface.

You will be able to edit all Company data should you need to make any changes later.

B. Logging Onto MicroStaffer

When MicroStaffer first starts up you will be asked to log in. The Login Window will open and ask you for the following:

User ID: Enter a user id that was assigned to you by the Systems Administrator. The Administrator’s user id is ADMIN. Use
this id to access the system for the first time. The initial password for the ADMIN user is USER.

& MicroStaffer Tip:
The ADMIN user id password should be guarded and/or changed frequently. This user id has complete and
unrestricted access to all functions of the system and cannot be deleted or renamed.

l. Password: Enter the password.

1. Select Company: When there is more than one Company defined in the system, the company dropdown will
appear and allow you to select the desired company you wish to access.

4 Logon to MicroStaffer

Enter a Uzer |0 and pazsword to log onta kicroStaffer.
__‘ )

« 0K
User ID: |admin €3 Caneel
Password: |
% Help
Company: |Medical Staffing Agency - —
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C. Setting User Preferences in MicroStaffer

The MicroStaffer user preferences window sets system wide preferences for each individual user. This window can be
accessed from anywhere in the system by clicking on the User menu item located on the Standard Windows menu within
MicroStaffer or by clicking the Preferences button on the tool bar.

1. Date & Time Format: Allows you to switch between a drop-down calendar date format or a standard keyboard sensitive
date format. This affects the date field throughout MicroStaffer. The time format allows you to switch between an AM/PM
format and a 24 hour format (military time).

2, Peachtree DDE: Defines settings for Automatic data synchronization with Peachtree Accounting.

3. BW Access: Defines settings for Automatic data synchronization with Business Works Accounting system.

4. Great Plains: Defines settings for automatic data synchronization with Great Plains.

- =]

ah (5 = <& Eg EEE & i} [ B = 2 ® -

Emplopee  Availabiity  Contacts  Documents  Customer Staffin Orders Inwaicin Pagroll  Preferences  Reminders  Motifications  Email  HelpTopics Re-Connect  Exit

-} Set Systems Preferences

Date & Time Formal | Peachtree DDE | BW Access | Great Plains

‘2 Aply
System Diate Format:  # |se Dropdown Calendar
" Use Control Panel Shortdate Format % Help

Time Display Format: | h:mm &M /PR -

Feady |Regions: Dff _[10/17/2006 9:43 AM
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D. Using the MicroStaffer Reminders Window

MicroStaffer allows you to enter Reminders which can be displayed either by opening the Reminders window directly from the
Standard Windows menu within MicroStaffer or by checking the box on the Reminders window to display Reminders upon log

in to MicroStaffer.

Note that you can date your Reminders to only be displayed when they become current.

1. You can turn off display of reminders by checking the ‘Do not Display Reminders when logging in’ checkbox.

2. If you only wish to display reminders when current reminders exists, check the box labeled ‘Only display when Active
Reminders Exist’.

3. Reminders can also be marked as completed (‘Done’) or Inactive. You may, of course, also delete any reminders.

-\ MicroStaffer - Medical Staffing Agency
File Employee Customer vendor Staffing Invoicing Payroll Reports System User ‘Window Help

W B N 2 W B K % & ® F 5 o= 2 B

Customer  Staffing  Orders  Inwoicing 5 Payroll  Prefersnces  Feminders  Motifications  Email  Help Topics

Employss  Avaikbility  Contacts  Documen e

-} Reminders

[ Dane Dats D escription

[]  05/12/2005 Call.Jane at<YZ Hospital to schedule contiact negatiation M
! Edit

il il Marge Credsrtial E rpiration Letters
& Delete
&} Close

+ Display &l

" Display Current

[~ Da Nat Display Reminders when Logging Ih
v Only display when Loggin In if Active Reminders Exist

|Regions: O |05/12/2005 10:28 &M

Ready
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E. The System “User” Notifications Window

The MicroStaffer System User Notifications window alerts users of both Internal (Non-Web) and External (Web Access
Module) data flow events. For Client Orders and On-Line Applications submitted via the optional Web Access module, the
User Notification Window acts as a gatekeeper for MicroStaffer which allows the user to process the item into MicroStaffer or
delete any unapplicable or duplicate information before it reaches MicroStaffer. The display mode and colors of system
notification types may be changed within “System Settings & Ultilities” and selecting the “Notification Settings” tab (see
manual section). This allows for quick visual recognition of different types of system notifications.

The notifications may include:

1. Customer Orders: (External) Orders submitted from customers via the Web Access Module. Users must be assigned as
Account Reps to the facility submitting the order in order to be notified about the order. (Account reps are created in the
Customer Setup facility on the Web tab). Orders may be deleted or processed into MicroStaffer.

2. Employee Availability: (External) New Availabilities and changes to existing availabilities from the Web Access Module.
Users must be assigned as Employee Reps to the submitting employee to be notified of the changes in availability. (Account
reps are created in the Employee Setup facility on the Web tab). Availabilities flow directly into the Employee Availability of
the submitting Employee.

3. On-Line Applications: (External) Applicant data submitted via the Web Access Module. Users may delete the submis-
sion or process/transfer it into the Employee Leads window.

4. Employee Sign-On Bonus or Referral Bonus ticklers: (Internal) If any sign-on bonus or referral tickler has been met.
These bonuses and the employee to notify are set up on the Employee Setup window. Entries are for informational purposes
only, they can only be deleted.

5. Follow Ups: (Internal) There are a variety of Follow Up categories that may be entered in MicroStaffer. There are Follow
Ups for Employees; Employee Leads; Customers; and Customer Leads. Check the user to notify in the Follow Up tab.
Entries are for informational purposes only, they can only be deleted.

-} MicroStaffer - Medical Staffing Agency. El@lgl
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F. Company Setup

The Company setup is the name of the company that will be using MicroStaffer. A variety of information is maintained for the
company created here.

NOTE: MicroStaffer allows for the creation of more than one company but certain important information is not shared between

companies. The most important is the employee data and billing/payroll information. An example of a multiple company set
up would be if there are separate companies for temporary staffing and home health care.

1. Creating a New Company

To Add a New Company profile:

1. Select System from the Main Menu button and Select ‘Company Setup’.
2. The Company Setup window opens with the information of the current Company.
3. Click the ‘New’ button.

4. Proceed to enter the information.

- MicroStaffer - Medical Staffing Agency

File Employee Customer Vendor Staffing Inwoicing Payroll Reports  System  User  Window  Help
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TaxID#: | - [~ Enable TaxWithhalding for this Company
[~ UseTD Gross for FICA Wagebase
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2. Editing Company Info

a) Company General Info

The General Tab on the Company Setup window captures the following information:

2.

10.

Name: Enter the name of the company (Required).
Tax Id: The Tax ID Number for the company. (Required).

Enable Tax Withholding Checkbox: (Payroll Tax Library Subscribers Only) Check this box to enable tax withhold
ing during Payroll Generation. If this box is NOT checked, no taxes or deductions will be applied to any payroll
checks. Note: You must subscribe to and have the MicroStaffer Tax Library installed on your PC for any tax with
holding to be applied.

Use YTD Gross for FICA Wagebase: (Payroll Tax Library Subscribers Only) Check this box if you wish to use
theYTD Gross earnings as FICAwagebase. The MicroStaffer tax library will normally use the YTD FICA in determin
ing when the FICA Wagebase has been reached. Checking this box will indicate that the YTD FICA Wagebase will
be calculated from the YTD Gross. This is used mainly for systems that start during the payroll year and have
incomplete FICAYTD values.

Address: Stores the street, city, zip, state, phone and fax numbers.

‘Define Customer as’ Field: Allows you to define the customer field throughout MicroStaffer. For the sake of
consistency, this manual will refer to customers as clients. This field name will be changed to whatever you define
here throughout the MicroStaffer system.

‘Define Employee as’ Field: Allows you to define the employee field throughout MicroStaffer.For the sake of
consistency, this manual will refer to employees as employees.

Define Type of Client: Sets a default value in the client type selection on the client set up screen. The default value
may be overridden within the client set up screen. Select from the dropdown: Facility, Patient or Billing Entity.

OT Accrual Method: OT can be accrued using Shift Date or Date Shift was booked. This allows you to modify the
order in which Overtime sums up its hours.

Charge and Same Day Booking Bonuses: These fields allow you to assigh company wide default pay and
bill bonuses for both charge pay and same day bookings.

Whenever you designate a specific shift as ‘Charge’ or ‘Same-Day Booking’ on the Shift detail window, the hourly
rates entered into these fields will be added to the regular rates applied to the shift. This holds true for both Pay and
Billing rates.

These bonus rates will also be included in overtime and holiday pay calculations.
Note that you may also specify employee specific Charge and Same-Day Booking bonus rates on the Employee
Setup window’s payroll tab. The employee specific rates will be added/subtracted from the company rates shown

here. They do NOT override them.

You must check the ‘Charge’ and/or ‘Same-Day Booking’ checkboxes on the Shift Detail window for these bonuses
to be applied.
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b) Invoice Setup

20

The Invoice Setup Tab on the Company Setup window allows you to customize the appearance of your invoices. Since many
companies use pre-printed forms or do not wish to display all the information on our standard default invoice, we have created

this tab to allow you to change the way your invoices will display and print. Please contact MicroStaffer for a quotation if

additional customization of invoices is desired.

Displayed is a sample of an invoice that can be modified in this way:
Moving objects: Move objects into their desired location by clicking on them and dragging them into a new location.
When you are finished moving them, release the mouse button.

1.

Change Object Attributes: Change the attributes of objects by clicking the right mouse button on them. A popup menu will
appear with the following items:

2.

* Reload Default: Reset all the original default settings for invoice display.

+ Remove: Removes the selected object from the invoice.

» Align: Set the alignment of the text to align to the left, center or right. (Text and Data Columns only)

* Font Bold: Toggle from regular font to bold font. (Text and Data Columns only)

* Font Size: Changes the size of the text. (Text and Data Columns only)

+ Zoom: Zoom in and out of the invoice display. This is used for editing purposes only and will not be saved.
* Print: Prints a sample of the invoice.

-} MicroStaffer - Medical Staffing Agency
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Ready |Regions: OFF  [05/12/2005 12:33 P

Sales Tax: Enter any desired Sales Tax percentage. Sales tax is used on Custom Invoices and Invoice Export.

3. Taxable Portion: Enter the percentage of gross revenue subject to sales tax. Used primarily on Custom Invoices and

Invoice Export.
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c) Company Custom Info Setup

The Company Custom Info Setup tab on the Company Setup window allows for maintaining custom data entry fields for both
Employees and Customers. The fields that are created here will be available for data entry on both the Employee Setup and
Customer Setup windows respectively.

Custom data fields are intended to allow you to enter data that is not otherwise tracked in the system. For example, you
could create fields for contract expiration dates, who obtained the contract, etc. Employee custom data can include tickler
enabled date fields. The fields created here are later available on reports and queries.

There is a limit of 40 custom fields for Employee data and 25 custom data fields for Customer data.

The following is entered:

&

Description: Enter the description for the data field. (Required)

Type: The data type of the fields. Valid types are: (Required)

. Date - Will permit an “Alert on Staffing Sheet” tickler to be created when on the employee custom info tab.
. Whole Number

. Currency

. Decimal

. Text

MicroStaffer Warning

When you remove a custom info field from the list on this window, the field and all its associated data is also removed from
each employee or customer depending from which list it was removed

-1\ MicroStaffer - Medical Staffing Agency
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d) Default Taxes (Payroll Tax Library Subscribers only)

The Default Taxes tab on the Company Setup window allows you to indicate which Tax types or Deductions will be added to
an employee’s list of Taxes and Deductions on the Employee Setup Window’s payroll tab when creating a New Employee.
(Subscription to the MicroStaffer Tax Library is required for processing tax withheld payroll using MicroStaffer).

Simply select an item from the dropdown list and click on the Add button. This will add the selected Tax or Deduction to the
list of default Taxes and Deductions.

Each time a new employee is added into the system, this list will be used to indicate which taxes and deductions are
automatically assigned to the new employee. Of course, you will be able to add and delete these default taxes and deduc-
tions for any individual employee.

3\ MicroStaffer - Medical Staffing Apency
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e) Other

Enable Great Plains Integration for MicroStaffer - Check this box to enable the MicroStaffer Integration with MicroSoft
Great Plains.

Make Time Sheet Indicator Mandatory on New Invoice Window - Check this box to make it mandatory to have the
timesheet checked for a shift to be included on a new invoice. Checking this box places a check in the timesheet option on
the invoice window and disallows the box to be unchecked.

Make Time Sheet Indicator Mandatory on New Payroll Window - Check this box to make it mandatory to have the
timesheet checked for a shift to be included on a new payroll check. Checking this box places a check in the timesheet
option on the payroll window and disallows the box to be unchecked.

.. MicroStaffer, - Medical Staffing Company

Fie Employee Customer Wendor Staffing Invoicng Payrol Reports System User Window Hel
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raffing Orderz = B ifi ‘ il -Connect

L1 Staifli -f. Company Detail - Medical Staffing Company

Company:

General | Invoice Setup Custom Info Setup Defautt Taxes  Other

[ Enable Great Plains Integration far MicroStaffer

I~ Make Time Sheet Indicator Mandatory on Mew Invoice Window

¥ Make Time Sheet Indicator Mandatow on Mew Papral Window

X} Clase

Ready |[Regions: Off  [12/05/2005 10:24 A




MicroStaffer User Manual 24

Copyright [1 1999-2005 DCT Computer Systems Inc.

G. User Setup & Security
1. Access Tab

The User Setup window allows you to create and manage users and their respective access levels within MicroStaffer.
Each company created in MicroStaffer has its own users, each with his/her different access levels.

The only user that cannot be modified or changed in any way other than to modify the password, is the ‘admin’ user. This is
the administrator login with access to all areas of the system.

1. To create a New user, click on the New button.
2. Enter a user id (Max. 8 Characters).
3. Enter user name and password. These are required.

Below is a list of the different items on the User Setup window:

A. Access Rights: This section lists the different function groups within MicroStaffer under the Groups list. Each time
you select a different group, the list of specific functions on its right changes and lists each item that security levels
can be set for.

The security levels are:

1. No Access/Hidden - User cannot see the control in any way.
2. Read-Only - User has access and can view data but cannot save it.
3. Full Access - User has complete viewing and editing access.
B. Kill Logins: This checkbox is only available on Network systems running Microsoft SQL Server. When this box is

checked, the user can Kill any process using the Systems Settings window’s Login tab.

C. Set Like: This option lets you set the current users access rights to the same settings as the one you select from
this dropdown. Does not carry over user information set on the System Tab.

-§. MicroStaffer, - Medical Staffing Agency. E”E”z‘
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D. Review On-Line Applications: When this checkbox is checked, the selected user will be able to view New Internet
submitted on-line applications in the System Notifications window (Web Module enabled systems only).

2. System Tab

The System Tab on the User Setup window allows you to designate Account Reps and Employee Reps for any user in the
system.

Account Reps wil be notified of any new Orders and other Web Based information received from Clients via the optional
MicroStaffer Web Access Module. These will appear in the System Notifications window for the marked user.

Employee Reps wil be notified of any new Employee Availabilities and other Web Based information received from employees
via the optional MicroStaffer Web Access Module.

Using the ‘Set like:’ feature does not carry over information on the System Tab. Therefore, it must be set for each new user, if
applicable.

. MicioStaffer - Sample Medical Staffing Company
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3. User Regions

The MicroStaffer application allows you to assign one or more Regions to users, if necessary. User Regions are especially
useful when dealing with Staffing companies that have several offices but wish to use one integrated MicroStaffer system.
Here, Regions could be assigned as offices. Users would only see information relating to their Region or Office. Global
users, such as Managers or System Administrators, however, would be able to see all activity and get the complete picture.
Users can also mix and match Regions to view data in many different ways. The only user who may not have regions
assigned is the ‘admin’ user. This user will always be a Global user.

The use of User Regions is optional. If you do not wish to use the Regions capability, do not enter regions codes in the List
Manager facility.

To assign Regions to users, you must access the User Regions window. This window is accessible by selecting System-
>User Regions from the Main Menu.

. User Regions x|
ser: |-.||:|hn Hortar - hortan ;l
" Dizable Region Filters for this User
{* Activate Fegion Filkers for this User
v Default Selected Regions when Creating Mew Employee and Customer Records
Selected R egion Select Al
v BROM: - BROMX
v MN&ASS - MASSAL & SUFFOLE
[ MEMJ - MORTHEAST R
[ WYL - MEW YORE CITY
v OFF1 - OFFICE 1
v OFFZ - OFFICE 2
[ OFF3- OFFICE 3
- LE - QUEENS & BROOKLYHM
[ Sl-STATEM ISLAMD
[ W -WESTCHESTER

‘:I» Cloze | B Save T

Assigning Regions to users will result in Region Filtered access. You must check the ‘Activate Region Filters for this User’
Radio button for any Regions filters to be applied.

Once you have selected to apply Region filters, you must then also check one or more Regions from the Regions list.
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The following is a list of guidelines and recommendations that relate to User Regions and their impact on the
way MicroStaffer’s functionality changes.

1.

Users who are assigned to Specific regions and have the Regions Filter enabled will see only information that
pertains to Employees and/or Customers that fall within those regions. Also, if an employee or Customer does not
have any regions assigned, they are considered Global. All users see any Global Employee or Customer records.

A user who does not have the Regions filter enabled will be considered a Global user. Global users see all
Employee and Customer records as well as all users.

If the ‘Default Selected Regions when Creating New Employee and Customer records’ checkbox is checked, every
time a user Adds a new Employee or Customer, the regions from that user will be automatically assigned to the new
Employee or Customer record. Of course, the user may modify the default regions.

All areas of the MicroStaffer system will be filtered. This includes Employee and Customer maintenance, Staffing
and Scheduling, Availability entry and matching, Invoicing and Payroll and all Reports.

You may use Regions to enable multi-office capabilities within MicroStaffer. For example, say you have 3 differentr
egional offices. To enable users from each office to see only information that pertains to their office, you may want
to access the List Manager and create the following three regions:

OFF1  Office 1
OFF2 Office2
OFF3 Office 3

Once these regions have been created, you would assign all users to their appropriate region. Then, these users
could assign Employees and Customers to each office also.

With this in place, users from Office 1 would only see Employee and Customer data for those records with regions in
Office 1. Of course, you may add additional regions to further define users within Office 1 through 3.

Users who do not have the Regions filter enabled would see activity from all the above offices.
The status bar at the bottom of the MicroStaffer system indicates whether the Regions filter is enable for a user.

When a region is deleted, the assignment of the deleted region is removed from all Users, Employees and
Customers.

Payroll and Invoice generation are also region enabled. Only entries that fall within the Regions list of the user will
be included in processing payroll and billing. Users must ensure the proper sequence of check numbers and invoice
numbers. We recommend that you assign specific ranges of numbers if you are planning a regional office
configuration.

The ‘admin’ user cannot have the Regions filter set. This user will always be a Global user.
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H. System Settings & Utilities

1. Status Code Maintenance

Status Codes are used on the Staffing Sheet Shift Detail window to specify what status a given shift currently has. Status
Codes are not company specific and will be used by all companies set up within MicroStaffer. Status Codes are maintained
within the System Settings & Utilities menu selection from the System menu item.

Several default status codes are installed with MicroStaffer. These include: Scheduled/Firm; Tentative; Customer Cancelled;
Employee Cancelled; No-Show; Customer Sent Home; Scheduling Error.

This tab allows you delete a status (unless it is the Scheduled/Firm or Tentative status or if it has been used in the system).
You may deactivate a code if you no longer wish to use a code that has been previously used.

You may add your own statuses in addition to the standard status codes. Display letters and colors allow for quick visual
recognition of certain status types on the Staffing Sheet/Calendar.

If a status code is not checked as active it no longer appears in the system.

There can only be one default status code and it is the status that is assigned automatically for each new shift upon entry
into MicroStaffer.

Status codes can also be set to billable and payable which indicates whether shifts of their type are pulled in during payroll
and/or invoice generation.

The Tickler Checkbox indicates that any shift with a Status that has this checkbox checked will test for Double-Booking or
other Staffing enabled ticklers (these are the ticklers on the Ticklers & Staffing tab of the System Settings & Utilities menu
selection).

The Type definition for the Status Codes are used by various Management Reports and Queries within MicroStaffer. Select a
Type for the Status Code from the dropdown. Types are: Undefined, Working and various Cancellation Types.

-3 System Settings

Status Codes IMDduIes l Ticklers & Staffing l Laginz l Taxes l
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[ woking v |

. Tentative. .o N ¥ I I [ T [Cancelbyhger +| Mave
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2. Ticklers and Staffing

Ticklers are used during the Staffing Process to allow you to prevent certain types of staffing conflicts such as excessive
hours worked, double-bookings etc.

Here is a list of each tickler and it's specifications:

1.

Check for Weekly Hours Exceeded: This is a basic Overtime tickler. When a shift is booked (i.e. Status is Firm
and double confirmed) this tickler will sum all the hours worked for the given week and alert the user if the number of
hours specified has been exceeded.

A. Disabled, by Employee, by Employee and Customer: This dropdown lets you either disable the tickler
or specify on what basis to summarize the hours.
1. By Employee: This will summarize the employee’s hours regardless of which Customer or Facility
he or she worked at.
2, By Employee and Customer: This setting will summarize the employee’s hours only for the
Customer at which the current shift is being booked.

B. Max Hours: This specifies the threshold that will set off the tickler. Any hours worked in excess of this
number will set off the tickler.

C. Week starts on: This specifies the day of the week from which to begin the hours-worked calculation. For
example, if we specify Monday, it will add up all hours worked beginning on the previous Monday and ending
on the following Sunday.

D. Action: This dropdown lets you set a warning only or disallow booking when the tickler fires. Warning Only
results in a window that warns the user of the tickler. Disallow booking results in not allowing the booking.

@ MicroStaffer Warning
This tickler calculates hours at the job and (for performance reasons) does not take into consideration any

breaks, dinner or lunch periods.

Daily Hours Exceeded: This tickler will display a message during scheduling if the number of hours specified has
been exceeded on the day that the shift is being booked. For example, if an employee works 24 hours in one day
and the number of hours specified in this tickler is 16, as soon as a shift is being booked that exceeds the 16 hour
limit, the tickler will fire. The Action dropdown allows a warning or a disallow booking flag for the tickler.

Check for Same Shift Different Customer: This tickler will test to see if a shift has been scheduled for the same
time period at a different customer. For example, if you are trying to schedule an employee at Customer A for a 7a-
7p and that same employee has already been put down for a 3p-11p elsewhere, the tickler will fire. MicroStaffer will
only fire this tickler if there is an overlap in shifts.

Check for Same Shift for Same Date and Customer: This tickler checks to see if the same person
was booked for the same customer in exactly the same shift.

Check for Mandatory Orientation: This tickler first checks the mandatory orientation status box of the client
facility to see if an orientation is mandatory. Then it cross checks against the employee to see if an orientation for
the client has been completed.
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6. Displaying Skill or Employee Type on Staffing Windows: This setting allows you to choose if you want the Skill
or Employee Type to be displayed on Staffing Sheets and Calendars.

H B = 2

Emplopse  Availability  Contaces
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Ready |Regions: Off __|04/10/2007 12:10 PM
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3. Logins (Networked Systems Only)

The Logins Tab is only visible on Network Systems running under Microsoft SQL Server 7.0/2000.

This tab displays the current active connections to the database.

Among the fields on the list are:

SPID: Unique process ID number

Network User Name: This is the Windows NT/2000 user id who is using this SQL Server
connection. Itis NOT the MicroStaffer login.

Login Time: Shows the time the user first logged into MicroStaffer.

Inactive Since: Displays the last time a command or action was initiated by the user.

Minutes Inactive: Displays the minute the user has been inactive on the system.

This tab also allows a user to Kill an active process. Killing a process disconnects the user from the SQL Server. Only
users with ‘Kill Process’ authority as defined on the User Setup and Security Window Link are allowed to kill another user’s
process. A user can always Kill his/her own Orphaned processes (See below).

&? MicroStaffer Tip
Occasionally, a user may have his/her connection abruptly severed from the server such that the client process is unable to
tell the network to close the connection properly. This is what is often referred to as an ‘Orphaned Process’.

One common cause of orphaned sessions arises when a client computer loses power unexpectedly, or is powered off
without performing a proper shut down. Orphaned sessions can also occur due to a ‘hung’ application that never completely
terminates, resulting in a dead connection. When this occurs, MicroStaffer will allow the user to clear this connection by
clicking on the Kill button.

Note that MicroStaffer will always allow the owner of a process to kill any of his or her own processes thereby freeing up the
connection. It will never allow the user to kill their own Current Process, however.

f System Settings

Statuz Codes I todules I Ticklers Logins |Ta:-:es I

Currently active MicroStaffer zeszsions

SPID Metwork User Mame Lagir Tirne Inhactive Since  Minutes Inactive Wy 2 kil
Friday 1256 PM | 1256PM | 000 [ [E

0Ok I &3 Cancel | & Apply | =2 Print % Help |
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4. Taxes List Setup (Payroll Tax Library Subcribers only)

The Taxes Tab located on the System Settings and Utilities window allow you to both view System Defined Tax and Deduc-
tion Types as well as create new Custom Defined Tax and Deduction Types.

System Defined Tax and Deduction types cannot be renamed.

To create a New Custom Tax or Deduction you must click on the Add button. To modify an existing Tax or Deduction, select
the desired Tax/Deduction from the list and click on the Properties button.

The Tax Properties window will allow you to enter settings for both Employee and Employer specific taxes and deductions.

1. Type: Select whether this is an employee or employer specific tax.
2, Name: Enter a descriptive name for the new Tax or Deduction. For example, 401K or Vacation Fund.
3. Calculation Type: This field indicates how the tax or deduction will be calculated. The three choices are:
A. Fixed Amount: The system will deduct a Fixed Dollar Amount for each check.
B. % of Gross: The system will deduct a percentage of the gross pay for each check.
C. Hourly Rate: The system will multiply the hours worked by the amount of the deduction.
D. % of Net: The system will deduct a percentage based upon the net pay of each check.
4. Annual Limit Using: You may select whether the deduction has an annual limit at which to stop. The choices are
as follows:
A. No Limit: The deduction will be taken indefinitely.
B. Annual Amount: The deduction will stop once the total amount deducted for an employee has reached
this amount.
C. Annual Wagebase: The deduction will stop once the employees total gross pay for the year has reached
this amount.
D. Default Amount: Enter the default amount you wish to set for this item every time this deduction is added
to an employee record.
E. Deduct Last: Check this box to deduct this item last after all other calculations
5. Default Rate: Enter the default amount or percentage for this deduction. This will be the amount entered into

the deduction field each time it is added to an employee record. You may also indicate whether to deduct this
amount only once per payroll year.

6. Maximum % of Net: This field indicates the maximum percentage of the net for the deduction.
7. Remove from all Employees: When this is checked, the deduction will be removed from all employee records.

8. Deduct taxes from corporations: Check this box to deduct taxes from employees marked as corporations.
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I Tax/Deduction Properties

o [
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5. Notification Settings

The Notification Settings tab allows for definition of viewing criteria for the System/User Notifications window. It allows the
user to define specific display formats for different types of System Notifications for quick visual recognition of important
System Notifications such as Customer Orders received via the optional MicroStaffer Web Module.

For each notification item type you may define a text display color, background color (from the dropdown) and text formats
(bold, underline, italic - place a check in the box to select).

-f./System Settings

Stalus Codes | Modules | Ticklers & Staffing | Logins | Taxes  Motification Settings }

Maotification ltem Text Color Background Calar Underine
Employes Web Availability ark Green ﬂ
Employes Sigrr-On Bonus “hite
Emplovee Referral Bonus S - | hi= 0 -]
Customer Follow-Up hite
Customer Lead Follow-Up "wihite
Customer ‘w'eb Orders S - | hi= 0 -]
Employes Follow-Lp EETS - (i 00 |
Emplopes Lead Follow-Up S - | i 00 -]
On-Line &pplication S - | hi= 00 -]

1|4

4

4] 4

1

1
I B I e i e e Y
N B B i e e
AN BN e B i e e

4

Carcel Apply & Brint
!

Ready |[Regions: OfFF  |01/16/2006 12:05 PM
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6. Other

You may change the definition of the Region field title using this option.

= B eee =
& = == < dh B EEE & [ ", = 2 i ms
Employes  Availability  Contacts  Diocuman e Tearch Facility Sraffing arders Inwaizing Payrall Feminders  Motifications Email Help Topics  Re-Connect Exit

-§./System Settings

Status Codes Modules Ticklers & Staffing ] Logins ] Taxes ] Matification Settings

Define Region as l@ ion]

Ok | € Cancel | 2 Apply

Ready |Regions: OFf |07/12/2007 1:16 P
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I. Online Backup

1. Backup

This feature allows the manual creation of a backup file as listed on the screen.

To access this feature, select Backup under the main menu’s System Button.

- =]

L = s i) B i ? ® L

Employee 2] Staffing ol atifications sl HelpTopics Re-Connect

3 Backup Database to SOL Server

This will Create a backup of your current database in a file named: webdamo_mshak bak in the
default backup folder of pour Miciosoft SOL Server installation.

Itis strongly recommended that you mave this file arto an altemate lacation [C0,Flash Drive etc
to protect against medis faiure or any other event that may cause imevarsable data loss

@ &

Ready |Regions: Off

|04/09/2007 12:21 PM
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J. List Manager
The List Manager window found under the System tab maintains lookup codes and descriptions for various items tracked
within MicroStaffer. The following items can be managed:

1. Skills List

The skill codes and descriptions that flow throughout the system to both employee and shift records. Whenever a
code is assigned here, it will be available for selection on the employee skill tab, when staffing and on reports.

2. Work Areas/Units

Allows specification of work areas. Work areas can be used to define both payroll and billing rates specific to a
certain work area.

3. Employee Types

The system wide Employee types such as RN,LPN, CNA etc. These can then be assigned to each employee.
Employee types can be used to define both payroll and billing rates specific to a certain employee type. Employee
type matching is used for “Who’s Available” matching criteria as well.

4. License Types

The License Types that are used on the Employee profile tab on the Employee Setup window. Examples here are
DL - Drivers Licenses, NL - Nursing License etc.

5. Insurance Policy Types

The Insurance Policy Types that are used on the Employee profile tab on the Employee Setup window. For ex-
ample, MI - Malpractice or LI - Liability Insurance.

6. Certification Types

The Certification Types that are used on the Employee profile tab on the Employee Setup window.

7. Heath Screening Types

The Health Screening Types that are used on the Employee profile tab on the Employee Setup window. Examples
here are TB - TB Test etc.

8. Background Check Types

Background check type codes are used in the Employee Profile area to define different types of background
checks.

9. Skills Checklist Types

Skills checklist types are used in the Employee Profile are to define different skill checklists maintained for
an employee. NOTE: Skills checklist documents may be attached to the employee profile for licensed users of the
Scanning & Imaging module.

10. Skills Rankings

Skills Rankings are used when assigning skills to specific employees. Once created here you can specify the
degree of competency in a give skill on the employees skills profile.
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11. Contact Types

Specify Employee, Customer and Vendor contact types. Each type should have Reason and Result codes (a
Reason for the contact and the susequent Result of the contact). These codes become available when entering
contact records for Employees, Customers and Vendors.

12. Referral Source Types

Referral sources are used when entering Employee and Customer leads to identify the source of the Employee or
Customer. For example, you could enter such sources as Magazine AD, Web Site etc.

13. Annual Review Types

These are used on the Employee profile to specify what type of annual reviews may be entered.

14. Region Type Codes

Region Type codes identify and allow groupings of Customers and Employees.

15. Work Codes & Rates

Work Codes & Rates allows for creation of a work code and rate if needed for assignment of a Work Code to a shift.
This is particularly helpful in calculating worker's compensation rates when the rate changes based upon the type of
work performed. After a work code is created here, it can be set as the default work code for a shift as defined in the
customer set up shift tab. Default work codes can be overridden in the shift detail window.

16. Test Types

These codes are used on the Employee Profile to maintain tests taken.

17. Training Types

These codes are used on the Employee Profile to define and maintain trainings taken by the employee.

18. Favorite Client Ranking

This allows for the definition of a ranking system for client preferences by employee.

19. Employee Checklist

Define a checklist of items for an employee. A preloaded employee checklist comes with MicroStaffer. If you wish not
to use all of the preloaded checklist items, you may select a code and delete it. The employee checklist is main-
tained for each employee in the checklist selection under the Employee tab. Iltems on the checklist may be marked
as mandatory which will cause a tickler during scheduling if the mandatory item is not complete. When a checklist
item is added, there will be an option to add the item to all employees. Select Yes to automatically add to the
employee checklist or No to add the items to the available code list to maintain for each specific employee.

20. Customer Checklist

Define a checklist of items for each client/facility. Examples of checklist items may include an executed contract or
receipt of client/facility policies. To add a code, click the Add button. You will be asked if you wish to add this
checklist item to all clients. If you answer Yes, the item will be added to all clients. If No, it will be added to the
available code list to maintain for each specific client. Type in the code, a description of the item and click the
mandatory box if you wish completion of this item to be mandatory. The client checklist is maintained for each client
in the checklist selection under the Client tab.
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21. Vendor Checklist

Define a checklist of items for each vendor. The vendor checklist is maintained for each vendor in the checklist
selection under the Vendor tab. The Vendor checklist works in the same manner as the Employee and Client
checklist items above.
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MicroStaffer - Sample Medical Staffing Company
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K. System Options

The System Options area of MicroStaffer allows the creation of system wide default values for a variety of items. This allows
you to configure MicroStaffer to meet your needs.

1. Employee & Client Setup

Allow editing of Client Comments — Allows the author of any comment on the Client Setup window to modify the com-
ment even after it has been saved. Option Value is On or Off.

Allow editing of Employee Comments — Allows the author of any comment on the Employee Setup window to modify the
comment even after it has been saved. Option value is On or Off.

Default Expiration Days on Employee Profile Items — Allows a system wide default of expiration days on Employee
Profile Items. Note that the default value may be overridden in the Employee Profile area if necessary. Option value is the
default number of days before or after expiration date.

Automatically Check Employee Profile Ticklers — Allows a system wide default to automatically check the tickler box
when setting up new Employee Profile Items. Note that the tickler box may be manually overridden if necessary. Option value
is On or Off.

Warn of Duplicate Employee External Id — When turned on, this option will warn you if a duplicate External Id exists for
an employee. (External Id’s may be used to synchronize with other packages ie. QuickBooks etc.)

Warn of Duplicate Client External Id — When turned on, this option will warn you if a duplicate External Id exists for a
client. (External Id’s may be used to synchronize with other packages ie. QuickBooks etc.)

Allow Duplicate Social Security Numbers - When turned on, this option will allow for entry of duplicate social security
numbers entered into the system. When turned off, any duplicate social security numbers will not be allowed.

Automatically Check all Profile Documents for Printing - This option, when thurned on, will automatically check all
Profile documents for printing or email whenever you open the Profile window.
B

£ Detault Expiration Days on Employes Profil tems . (-7)
B1 Automatically Check Employes Pro icklers. (On;
7 warn of Duplicate Employvee External ID...(ON)
B3 warn of Duplicate Cliet External ID...(On)
+- @ Staffing and Scheduling
+- @ Payroll
i

Invoicing
+ @ Scanning and Imaging

Fieady [Regions: Off __[05/01/2005 11.21 AM
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2. Staffing & Scheduling

Disallow Scheduling Employee with Expired License(s) — Option value On or Off. If turned On, this option will prevent
the scheduling of any employee with one or more expired licenses.

Disallow Scheduling Employee with Expired Insurance Policy(s) — Option value On or Off. If turned On, this option will
prevent the scheduling of any employee with one or more expired insurance policies.

Disallow Scheduling Employee with Expired Certification(s) — Option value On or Off. If turned On, this option will
prevent the scheduling of any employee with one or more expired credential items.

Disallow Scheduling Employee with Expired Health Screening(s) — Option value On or Off. If turned On, this option will
prevent the scheduling of any employee with one or more expired health screenings.

Disallow Scheduling Employee with Expired Test(s) — Option value On or Off. If turned On, this option will prevent the
scheduling of any employee with one or more expired tests.

Disallow Scheduling Employee with Expired Training(s) — Option value On or Off. If turned on, this option will prevent
the scheduling of any employee with one or more expired trainings.

Disallow Scheduling Employee with Expired Annual Review(s) — Option value On or Off. If turned on, this option will
prevent the scheduling of any employee with one or more expired annual review items.

Display Mileage for Availability Searches — Option value On or Off. If turned on, this option will display the distance in
miles between the location of the employee and the client on the Who'’s Available window.

Display Margin for Availability Searches — Option value On or Off. If turned on, this option will display the potential shift
profit margins on the Whao’s Available window.

Disallow Scheduling Employee with Missing Mandatory Checklist Items — Option value On or Off. If turned on, this
option will prevent scheduling of any employee who has one or more missing mandatory checklist items.

Disallow Scheduling Employee with Expired Background Checks - Option value On or Off. If turned on, this option will
prevent the scheduling of an employee with one or more expired background checks.

Display Gross Hours and Shift Count in Staffing Calendar Window Headers - Option Value On or Off. If turned on, this
option will display groo hours and shift count in the staffing sheet window header.

Allow Dropdown Edit of Work Area on Shift Detail - This option will allow users to manually type in a work area when
editing a Shift Detail Record. Quick Edit feature.
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3. Payroll

Adjust Open Advance Checks when Shift is Modified — Option value On or Off. If turned on, when users make a change
to a shift and the shift has been paid on an open advance, this option will modify the advance to reflect the changes in the
job.

Utilize Contractor/Employee Pay Type Logic — Option value On or Off. If turned on, MicroStaffer allows you to create two
Employee Type definitions (C=Contractor, E=Employee) and then create pay rates based upon these. MicroStaffer will then
apply a C rate to Contractors and an E rate to Employees.

Payroll Benefit Validation — Option value On or Off. If turned on, this will enable the Payroll Bengefit 8 hour validation.

Ignore Trailing Partial Shift Holiday Pay — Option value On or Off. If turned on, this will ignore the partial overlap into
Holiday pay when a shift ends just before the holiday starts.

Select Pay Stub Rate Display — Option values: Regular Rate, Average Rate or Blank. This sets the option for the printing of
the pay rate on the payroll check stub.

Use Parent for Payroll O.T. — Option value On or Off. If turned on, when calculating O.T., the hours worked will be totaled
by all locations for the Parent facility.

Pay both Daily and Weekly O.T. — Option value On or Off. If turned on, when calculating O.T. and an overlap between
weekly and daily occurs, both will be paid. If turned off, only weekly O.T. will be paid.

Use First Pay Date as Hire Date — Option value On or Off. If turned on, when an employee is paid for the first time
MicroStaffer will use the first worked date as the hire date.

Remove Daily O.T. Hours while calculating Weekly O.T. — Option value On or Off. If turned on, any daily O.T. hours will
be removed from the calculation of weekly O.T.

Adjust Regular Pay Rate Downward to Offset O.T. — Option value On or Off.

Ignore Leading Partial Shift Holiday Pay — Option value On or Off. If turned on, MicroStaffer ignores the partial overlap
from holiday pay when a shift starts just before the holiday ends.

Partial Holiday Overlap Minutes — Option value is selected from dropdown.

Enable Burden Margin Adjustment Logic — Option value On or Off. If turned on, this option will adjust the display of profit
margins by incorporating employee burdens as entered in the Employee Detail window found on the Payroll tab.

Add Additional Pay Items to Shift Detail Pay rate Display — Option value On or Off. If turned on, this option will adjust
the display of pay rate on the Shift Detail by including the Additional Pay Item amounts.

Select Settings for Shifts with OT and Holiday Pay - Option value is selected from dropdown. This option will allow you to
select how the payroll system will handle shifts that qualify for both OT and Holiday Pay.

Select default Payroll Period when adding a new Employee - Option value is selected from dropdown. This options
sets the default payroll period (eg. Weekly, Bi-Weekly etc.) when adding a new Employee into the system.
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4. Invoicing

Use Control Panel Short Date for Invoice Date on all Invoice Exports — Option value On or Off. With this option on, the
export file for all invoice exports will format all dates in the same way as the Windows Control Panel short date. With this
option off, it will use the MM/DD/YY format.

Ignore Trailing Partial Shift Holiday Amount — Option value On or Off. When turned on, MicroStaffer ignores the partial
overlap into Holiday amount when a shift ends just before a holiday starts.

Use Parent for Billing O.T. — Option value On or Off. If turned on, when calculating O.T. the hours worked will be totaled by
all locations for the Parent facility.

Bill both Daily and Weekly O.T. — Option value On or Off. If turned on, when calculating O.T. and an overlap between
weekly and daily O.T. occurs, both will be billed. If turned off, only weekly O.T. will be billed.

Enable Billing Entity Parent Logic — Option value On or Off. If turned on, the Invoice generation process will bill shifts
assigned to Billing Entities on the Shift Detail window.

Generate Separate Invoices for Siblings — Option value On or Off. If turned on, you can generate separate invoices for
Sibling Facilities.

Remove Daily O.T. Hours while calculating Weekly O.T. — Option value On or Off. If turned on, MicroStaffer will remove
daily O.T. hours when calculating weekly O.T.

Ignore Leading Partial Holiday Amount — Option value On or Off. If turned on, it ignores the partial overlap from holiday
amount when a shift starts just before the holiday ends.

Partial Holiday Overlap Minutes — Option value is selected from dropdown.
Add additional Bill Items to Shift Detail Bill Rate Display - Option value On or Off.

Select settings for Shifts with OT and Holiday Billing Pay - Option value is selected from dropdown. This option will
allow you to select how the Invoice Generation System will handle shifts that qualify for both OT and Holiday Pay.

=ED|

Staffing Grders Invaicing

Invoi
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5. Scanning & Imaging

Incoming Image Format Id — Option value selected from dropdown. Defines the storage file type code for scanned in
images.

Storage Image Format Id — Option value selected from dropdown. Defines the storage file type code for images.

B B

Emplopes  Availability  Con e Staffing Orders

3. System Options

and Client Setug
+ @ Staffing and Scheduling
+-4 Payrol
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F3 ncoming Image Format ID.01)
3 storage Image Format 10,013
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L. Email Functions in MicroStaffer

1. Email Overview

MicroStaffer features a variety of Email enabled functions which can be used to Email reports, schedules and profiles to one
or more recipients.

The following is an overview of these functions:

1.

Send To...: This can be both a Button or Right-Click menu item depending on the Report or Window. Selecting this
option will send the contents of the report, schedule or profile(s) to the MicroStaffer Email window as an Adobe
Acrobat .PDF file.

Note: You must have the Adobe Acrobat PDF writer installed on your PC for this function to be enabled.
For more information on the Adobe Acrobat writer please go to the Adobe website at:
http://lwww.adobe.com

Accessible from:

A. Reports - Employee Listing, Customer Listing, Work Summary, Shift Status, Check & Invoice Registers
B. Schedules - Staffing Sheet, Employee Availability and Schedule window...

C. Employee Profile Window

D. Document Manager

Copying Employees and/or Customers to the Recipient List...: This function allows you to copy the selected
employees and customers to the Microstaffer Email window thereby allowing you to send emails to a number of your
Employees and Customers.
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2. MicroStaffer Email Window

The MicroStaffer Email window can be accessed and called from various areas in the system. For example:

1.

2.

By clicking on the Email Menu item under the Window menu item on the MicroStaffer Main menu.

Right clicking on various reports throughout the system including most Standard reports under the Reports menu
and Employee Profiles

The Email window consists of the following areas:

A.

Recipients: This area lets you specify to whom you wish to send the message. To add recipients right click on the
list and access the dropdown menu:

1.
2.
3.

Add - Adds a recipient to the list.

Delete - Deletes a recipient from the list.

Paste Recipient - Pastes the recipient from the recipient clipboard. The recipient clipboard can be filled
from various reports (Employee Listing, Facility Listing, Shift Status etc) and the Employee Profile by right
clicking and Selecting ‘Copy Selected ... to the Recipient List...".

Export List to Messenger - Opens the default Email Client Application window with all the addresses in the
list.

Send Separate Message... Checking this box will result in separate Email messages sent to each recipient in the
list. Note that unless this box is checked the message will be sent to a group of recipients.

Subject: Standard message subject

Body: Standard message body.

Attachments Tab: Lists any attachment .PDF files that will be sent. Note that you can rename the files. Only
attachments created within MicroStaffer can be sent.

-}. MicroStaffer - Sample Medical Staffing Company.
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3. Email Setup

To fully utilize the attachment capabilities for the email function, it is recommended that emails be sent directly from within
MicroStaffer. Email setup is accessed by selecting the Setup button on the Email screen. Please contact your IT staff for
site specific assistance in setting up email or contact MicroStaffer technical support for the most up to date information.
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M. Client Setup

1. Creating a New Client

To Add a New Client:

1. Select Client->Setup from the Main Menu or click on the Client Setup Toolbar.

2. The Client Setup window opens in New Mode.

OR Click the New button located on the Client Setup window.

-§ MicroStaffer - Medical Staffing Agency
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2. Editing Client Info

a) Accessing Client Data

To view and modify Client data, select Client->Setup from the Main Menu or Click the Client Toolbar item. When the Client
Setup window opens, select a Client from the Client Dropdown in the top left corner of the window.

croStaffen - Medical Staffing Agency
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b) Client General Info

The Client General Info tab on the Client Setup Window tracks basic information about the client.

1.

2.

10.

1.

12.

13.

Name: The name of the client.(Required)
Address: Enter the Street, City, State and Zip of the client (Required).

Inactive: Check to make a client inactive. NOTE: To display clients marked as Inactive, check the Display Inactive
box at the top of the screen.

Orientation Mandatory: Check this box if orientation at the client site is mandatory. The ‘Check for Mandatory
Orientation’ box on the Ticklers & Staffing tab of Status Code Maintenance must be checked if you wish a tickler or
disallow function for orientation at this client.

Type: Define the type of client from the pulldown menu. You may override the default type using the dropdown. Note:
the system defaults to the default type set up on the Company General info tab.

Billing Address: You can enter a separate billing address. Use the ‘Same as above’ checkbox to use the regular
mailing address as the billing address.

Invoice Fields: These fields appear on the default invoice form. See Company Invoice Setup for more details on
how and where these fields appear. (Billing enabled systems only.)

Custom Invoice: Allows you to assign a custom invoice programmed to your specifications to be assigned to this
client. Custom invoices are created by the MicroStaffer technical staff. Please contact MicroStaffer for more informa
tion regarding custom invoices.

Parent: This dropdown allows you to assign a parent client. If you assign a parent client that is different from the
selected client, all billable entries will be billed on invoices for the parent client. However, all rate and shift informa
tion will be drawn from the current client. Please refer to various options regarding the billing of Parents and Siblings
in the System Options area of MicroStaffer.

External ID: This is a field, which can be entered by you as you wish. It will allow you to synchronize your clients
with any other systems that contain client data.

Region: Enter one or more Regions for this Client. Regions are defined on the List Manager window and can be
used during scheduling and availability matching. Regions are optional.

Display Inactive: Checking this box allows for display of Clients marked inactive.

Display Billing Ent.: Checking this box allows for display of Clients marked as Billing Entities.
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c) Client Contacts and Directions

The Client contacts tab on the Client Setup window allows you to view and modify Phone and Contact information for the
selected Client. (For Web Module enables systems - the direction information entered here will be accessible to employees

via the web module.)

& Clicking on the Phone Icon next to each phone number will open the Windows Phone Dialer application with the
selected number and allow you to automatically dial using your PC. Note that your phone system must be TAPI configured

for this function to be enabled.

EJ Clicking on the Email Icon next to each email address will open your Default Email Client Application with the selected

email address. You must fill in the email address for this function to be enabled.

- MicroStaffer - Medical Staffing Apency
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d1) Work Areas/Units

When the Client type code found on the general info tab is defined as a Facility, the heading for this tab is Areas. Work
Areas define the areas where shifts are being worked. For example, if the customer is a Hospital, then you could enter the
various Units and Departments at the hospital.

Work Areas will be used on the Staffing Sheet to further specify the exact location of the shift. Many customers require
shifts or place orders by a specific area only.

The Available Areas dropdown lists all areas for all Customers in this Company

You can either create a New Area by typing in its description or select an area from the list. If you add a New Area, it will
become part of the global area’s list. All areas assigned to this Customer will be available on the Staffing Sheet.

-} MicroStaffer - Medical Staffing Agency
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d2) Patient

When the client type is defined as Patient on the general info tab, the tab is titled Patient. Here, you may enter information
pertinent to the patient and their care.

icroStaffer, - Home Health & Companion Services

File Caregiver Client “endor Staffing Invoicing Payroll Reports  System  Utilities User window  Help
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e) Setting up Shifts
The Shifts tab on the Customer Setup Window is one of the Key areas within MicroStaffer. It is the place where shifts are

defined for use on the Staffing Sheet and upon which both pay and billing rates will be based.

At least one shift type is required for each Customer!

Navigation
1. Add: Create a new shift by Clicking the Add button.
2, Move: Reorder the shifts by selecting a shift row and clicking the up and down arrows. The order of the shifts on
this tab will be reflected on the Staffing Sheet.
3. Delete: Deletes the selected shift.
@ MicroStaffer Warning
L Once you delete a shift, it will be permanently removed. The staffing sheet will still display any

booked shifts for this shift type, but you will no longer be able to add any new shifts of this type.

Data Entry Fields

1. Shift Name: Enter a Description for the Shift. For example, Day 8 or Day 12 Hour Shift. (Required)

2 Shift Duration: Select the Start and End Time of the Shift (Required).

3. Type: Select the type of Shift (Required). Types are used for Availability Matching.

4. Color: This dropdown allows you to select the color to use for the shift header banner on the staffing sheet. Thisis a

useful visual recognition tool to differentiate between shifts.

5. Inactive: If you check this box the shift will no longer be visible on the Staffing Sheet (unless there are existing
shifts for the selected period).

6. Work Code: Enter an optional work code for the shift. Work codes are defined in the List Manager window and are
used for a variety of reporting purposes. When you assign a work code to a shift, this work code will automatically
be used as the default work code when you enter a new shift on the Shift Detail window (it may overridden).

7. Display of Shift name and Shift Start and End times on Staffing Sheet: These two check boxes located at the
bottom of this tab allow you to choose whether you wish to display the Name of the Shift or Shift Start and End
times on the staffing sheet

ﬁ? MicroStaffer Tip
If you decide not to schedule using the shift based methodology, you could simply enter one shift for a given
customer and check these two boxes. This would be akin to non-shift based staffing.

&? MicroStaffer Tip

If you have many clients with the same shifts, create a “master client” to be used as a template for adding new

clients. Then simply access the Client information and use the Save As button. Please refer to the Client Save-As
section for more information.
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roStaffer - Medical Staffing Agency
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f) Client Custom Info

The Client Custom info Tab on the Client Setup window allows for viewing and modifying Custom Data as was defined in the
Company Setup window-> Custom Info Tab.

The fields created on Company Setup flow into this tab. There is a limit of 25 custom information fields.

The custom information may be queried or reported on using the Client List Report.

-§|MicroStaffer - Medical Staffing Agency
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g) Client Holiday Schedule

The Client Holidays tab on the Client Setup window allows for viewing and modifying both one-time and recurring holidays.

In order to pay and bill additional amounts for holidays, you should enter the holiday periods for each client here.

Navigation
1. Add: Create a new Holiday by clicking the Add button.

2. Delete: Deletes the selected Holiday.

Data Entry Fields

1. Holiday Name: Select the desired Holiday from the list or type in a New Holiday Name. (Required)

2. Start Date: Select the Start date for this Holiday (Required).

3. Start Time: Select the time of day at which the Holiday rates take effect for the above Start Date. (Required).
4. End Date: Select the End date for this Holiday.(Required)

5. End Time: Select the time of day at which the Holiday rates end for the above End Date.(Required).

@ MicroStaffer Warning
The Start Date and Time must precede the End Date and Time. MicroStaffer will not allow you to save the data if

any row has a Start Date and Time that comes after the End Date and Time. Also, if the holiday duration is greater
than one day, there will be a warning message. You may, however make the holiday duration as long as you wish.

6. Recurring Holiday: If this check box is checked, the Holiday will be in effect for every Year based on the Start and End
Date Month and Day.

@ MicroStaffer Warning
Do not enter the same recurring Holiday more than once. MicroStaffer will not validate the entries for duplicates

and Holiday pay may be more than intended.

7. Bill@,Pay@: Indicates at what multiple the regular billing and payroll rates should be calculated.

&? MicroStaffer Tip
Holiday pay is usually calculated at Time and One Half. Therefore, you would enter 1.5 here. Also, if you do not

wish to bill at holiday rates but only pay, then enter 0 and 1.5 respectively.

8. Holiday Shift Copy Feature: Basic holidays may be copied from one facility to another using the copy button. NOTE:
The holiday shifts will be deleted and replaced with the current schedule of any customers you select.
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edical Staffing Agency
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h) Client Comments

The Comments Tab on the Client Setup window allows you to enter ongoing comments for the selected client.

+ Any user can view the list of comments.
+ Only the user who created the comment can delete his/her own comments.

+ The ‘admin’ user can delete any comments.

MicroStaffer - Medical Staffing Agency
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4} Close | M Hew | & Delete | B Save ‘ lz) Save ds...

Ready |Regions: Off__[05/17/2005 12:54 PM

61



MicroStaffer User Manual 62

Copyright [1 1999-2005 DCT Computer Systems Inc.

i) Client Documents

The Client Documents tab on the Client Setup window allows you manage images, Rich Text format documents and .pdf files
created with the MicroStaffer Document Manager module.

croStaffer - Medical Staffing Agency
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j) Overtime (Payroll and Billing Systems Only)
The Overtime Tab on the Client Setup window allows you to enter settings for calculating overtime for payroll and/or invoic-
ing.

To enable the overtime calculations you must check the Pay Overtime and Bill Overtime checkboxes for Payroll and Billing
respectively.

You can calculate both weekly OT and/or daily OT.
1. Pay Overtime / Bill Overtime: Indicates whether you wish to pay and/or bill overtime based on the following settings.

2. Hours Used to Calculate Overtime: Use these settings to select whether to sum the total hours used in deciding

when overtime starts. For example, you may add up an employees total hours for the week or just those hours
worked at this specific Client.

3. Percentage vs. Dollar amount factor: You may set the type of overtime that is given. If you choose to select
percentage then, the Pay Factor and Bill Factor fields will hold percentages. If you choose to select Dollar amount
then, the Pay Factor and Bill Factor fields will hold dollar amount values such as $2.00 per hour.

4. Weekly and Daily OT: These settings allow you to enable whether to pay and/or bill weekly and/or daily OT.

5. Advanced settings: Use the Advanced settings to set Blended overtime settings.
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k) Contacts

The Client Contacts Tab allows you to view and enter contacts between you and your client such as requests for orders,
cancellations, sent profile information etc.

Note that you must define Contact Reasons and Contact Results in the List Manager window.

icroStaffer - Medical Staffing Agency.
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The Follow Up Tab within Client Records allows for the entry of reminders or information that needs some sort of follow up
action. Follow Ups may be entered for users other than the user entering the initial Follow Up. Follow Ups appear on the
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1) Follow Ups

System User Notifications window for the assigned user(s).

Simply click Add, type in a date for the Follow Up and the information. Click the users to be notified with the follow up and

save. Use Only Notify field to select a single user.
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m) Web

The Web tab is used for setting Internet access properties that allow your customers access to your MicroStaffer system
using the Optional MicroStaffer Web Access module.

The Web Access Module allows selected customers to view Schedules, Enter Order, View Availabilities etc.

1. List of Authorized Users: Enter the User Names and Password that allow selected Customers access to your Micro-
Staffer system via the Web.

2. Account Reps: Indicate which MicroStaffer internal users are designated as account reps for the selected Customer.
Account reps will receive notifications when the Customer enters new orders and will be responsible for processing
these new orders for entry into MicroStaffer’s staffing sheets.

3. Working Status for Availability Searches: One of the functions available to Customers via the Web Access Module is
to perform availability searches. The status(s) you indicate here will decide what is deemed to be a working shift so
as to remove any available Employees from availability searches should they be booked with a status as set here.

i\ MicroStaffer - Medical Staffing Agency.

Fil=  Employee Customer Vendor Staffing Inwoicing  Payroll Reports  System  Utilities  User  Window  Help

o @ = < B = & ] & L = @ o

Employse  Mvailability  Contacts  Decument tc  Customer  Staffing Ordarz  Invaisin g Payrell  Prefarsnces  Feminders Motifications  Email  Help Topics  Exit

-f Customer, Setup - Chester County Hospital

Customer: | Chester County Hospital >| T Display Inactive [ Displap Billing Ent.

General ] Contacts & Directions 1 Areas ] Shifts 1 Custom Info ] Holidays I Commerts Documents ]OT.] Contacts Web 1
List of Authorized Internet Users

Lser ID Mame/Description | Password [Active|  Last Modified By tod Time
3 nan Jpass Administrator |05
|bobbi Admiristrator  [05/10/2005 915 &

Account Reps

Selected | Userld User Marne > Select Al
=

abraharnm Susan webster
r angel0l Shannon Ralston Un-Select All
r bassing Theresa Bassing
r bobbi babbi

Winrking Status for Availabiity Searches

[ 8= =

3 Close | #oeee | msae | lsevess.

Ready |Fiegions: Off _|05/17/2005 1.02 P
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n) Client Save-As

The Save As button on the client setup window allows you to clone one client from another.

This feature is a time saving device that allows you to create a new customer from an existing client and inherit such time
consuming data entry items as Holidays, Areas, Shifts and Billing and Pay Rates.

This function is used in the following way:

1. Open an Existing client. This will be the client that will serve as the template for the new client.
2. Click on the Save-As button. The ‘Save Client as...” window will open.
3. Enter the name of the New client. Also select which items to copy. Note that Shift definitions and standard

rates are automatically copied over.

4. Click OK and you will be returned to the Client Setup window with the New client record already selected.

I Save Customer as...

Thizs feature allows you to create a new Customer wsing the selected Customer.

M arne;

Optional Data to be Copied

[ Halidaps
[ “Work Areaz
[ Custom R ates

Select All

 OK 4 Cancel | & Help |
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N. Client Rates Setup
1. Client Pay Rates

The Client Pay Rates Setup window allows you to view, modify and delete Pay Rates for a Specific Client and Shift.

Note that every Client has at least one Shift Type and each Shift Type has at least one Payroll Rate. This rate is called the
Standard Rate and its properties, other than the rate amounts, cannot be modified.

The Standard Rate is applied whenever no other rate applies to the Shift in question.

If you wish to create unpaid breaks you must have at least 3 rate rows. The middle row will represent the break. For
example:

Row 1 7am -12pm

Row 2 12pm - 12:30pm (Break)

Row 3 12:30pm to End of shift

MicroStaffer also allows you to create a wide array of Custom Rates through its Rate Wizard Window.
The Rate Wizard Window lets you create Rates using Various Criteria such as Employee Type and Work Area.

To Create or Modify a Custom Rate for any specific Shift, open the Pay Rates Setup Window and Select both the Customer
and Shift for which the Custom Rate will be applied to.

To Create a New Rate, click the New button. To Modify the Properties of an existing Custom Rate, select the rate and then
click the Properties button. Both actions will open the Rate Wizard Window which will guide you through the Rate Setup
process.

1. After the window opens, click the Next button and enter a descriptive name for this Custom Rate.

2. Click Next and select whether to use one or more employee types for this rate.

3. Ifyou choose Employee Types, you may select Specific Employee Types on the following Tab.

To select more than one Type, hold down the CTRL key while clicking on each Employee Type.

You may also skip the Employee Type criteria.

On the next tab you may specify Work Areas to use for this rate. Again, to select more than one Area, hold down the
CTRL key while clicking on each Work Area.

6. Note, you must select at least some type of criteria to complete the process. Also, the selected criteria may not overlap
with any other rate’s criteria.

Once you have selected the criteria, you may enter rates for each day of the week.

If you wish to create split shift rates, click on ‘Add Rate Period’ and enter the next period’s start time and rates.

You may create an unlimited amount of splits within each shift.

0 Click on ‘Finish’ and you will return to the Pay Rates Setup window.

o A
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roStaffer - Medical Stai

File Employvee Customer ‘endor Staffing Invoicing Pawroll Reports  System  Edit User  ‘Window Help

S B N & B OB OB O=®= & B OB O = 2 9B

Employes  Availabilty  Contacts  Documents  Customer  Staffing  Orders  lwoicing  Pagroll  Proferences  Reminders Mevifications  Email  HelpTopics  Exit

Pay Rates Setup

Customer: |Ehestar County Hospital

Shifts and R ates

j [ Display Inactive

= m Day 7-3:30........[7:00 am - 3:30 pm]
£ (5878) - Standard Rate

5861] - LPN-C-NH-74-3F
58031 - CNA-C-NH-74-3P
[5895] - CRT-CNH-74.3P

<-4 Evef.....[200pm-11:30 pm]

-4 Might 8 [11:00 pm - 7:30 am)

+ @ Day12.......[7:00 am - 7:30 pm)

e !, Hight 12........(7:00 pm - 7-30 am]

&} Close

Description

Rate D

Dezcription:

Last Modified Or

Last Modified By
Employee

: 5874
¢ RM-C-NH-74-3F
¢ 07/26/2003
t Jackie James
Type Criteria

Employee Type:

: AN -RN

Shift Period: [7:00 &AM - 3:30 PH)

Fate Starts af Ends at.

(1. 7:00 &M 11:00 AW

[ [i1:004H [11:30AM 3700 F700] F.00) 300

37o0[ Ja00] m00

[ [1:304H [530 PM 3700 F700] F.00) 300

37o0[ Ja00] m00

[Right Click to Copy Rate Rows or Rate Grid]

LT [Erdofshit [ se00] ze00[ =8.00[ 3s00)

Date Range: [

Start: |

4000 4000 4000

B Save

M HNew
tl Properties

‘8 Delete

Expart Item
Code

x| End |

Fieady

[Fiegions Off __[05/23/2005 10:29 &M
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2. Client Bill Rates Setup

The Bill Rates Setup window allows you to view, modify and delete Bill Rates for a Specific Customer and Shift.

Note that every Customer has at least one Shift Type and each Shift Type has at least one Billing Rate. This rate is called
the Standard Rate and its properties, other that the rate amounts, cannot be modified.

The Standard Rate is applied whenever no other rate applies to a given shift.
MicroStaffer also allows you to create a wide array of Custom Rates through its Rate Wizard Window.

The Rate Wizard Window lets you create Rates using Various Criteria such as Employee Type, Work Areas and Specific
Employees.

To Create or Modify a Custom Rate for any specific Shift, open the Bill Rates Setup Window and Select both the Customer
and Shift for which the Custom Rate will be applied to.

To Create a New Rate, click the New button. To Modify the Properties of an existing Custom Rate, select the rate and then
click the Properties button. Both actions will open the Rate Wizard Window which will guide you through the Rate Setup
process.

1. After the window opens, click the Next button and enter a descriptive name for this Custom Rate.

2. Click Next and select whether to use one or more employee types for this rate.

3. Ifyou choose Employee Types, you may select Specific Employee Types on the following Tab.

To select more than one Type, hold down the CTRL key while clicking on each Employee Type.

You may also skip the Employee Type criteria.

On the next tab you may specify Work Areas to use for this rate. Again, to select more than one Area, hold down the
CTRL key while clicking on each Work Area.

6. Note, you must select at least some type of criteria to complete the process. Also, the selected criteria may not overlap
with any other rate’s criteria.

Once you have selected the criteria, you may enter rates for each day of the week.

If you wish to create split shift rates, click on ‘Add Rate Period’ and enter the next period’s start time and rates.

You may create an unlimited amount of splits within each shift.

0 Click on ‘Finish’ and you will return to the Bill Rates Setup window.

o A
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roStaffer - Medical Staffing Agency

File Employee Customer Wendor Staffing  Inveidng  Payroll

Hh OB I &

Reports  Syskem it User

B B & B

tWindow  Help

i =l @ e

Employee  Availabilty  Costacts  Documents  Customer  Staffing  Orders  Ivoicing Pagroll  Preferences  Reminders  Motifications  Email

Help Topics  Exit

Bill Rates Setup

Customer: |Ehesler County Hospital j [ Digplay Inactive

‘:L Cloze

Shifts and Rates Description
=-%F Day 7-330.......(7:00 am - 3:30 pm) ol 3977p B Save
£] 363 Sda'd fiate Diescription: AN-NH-74-3P s
3982) - LPN-NH-7-3P Last Modified On: 07/26/2003
3983] - CNANH-74-3P Last Modified By: Jackis James
3984 - CRT-NH-74-3P Employee Type Criteria N0} Eroperties
Eve 8......[300 pm - 11:30 pm)
Might 8.........[11:00 pr - 7:30 am)
Dap12 [7:00 am - 7-30 pm)

M HNew

Employes Tppe: RM - RM & Delete

Shift Period: [7:00 AM - 3:30 PH)

2. [i:00aM fi1:304M 5300 5300 s3o0| saoo| saoo[ s0.00[ 6000
3. [11:20aM [z20PM 5300 5200 s5200[ s200[ sa00[ e0.00[ 6000 Expott ltem

Code

4. [330PM [End of Shift s300[ 5300 5300 s5a00[ eoo0[ e0.00] 6000

[Fight Click to Copy Fate Flows or Flate Grid]

Date Range: | Start: | v End: |

Ready |Regions: O |05/23/2005 10:35 AM
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3. Customer Pay and Bill Rate Copying

It is possible to copy entire sets of rates for one shift and customer to another set of shifts for other customers.

For example, say you have 12 customers all with the same shift types (e.g. 7a-3p, 3p-11p etc.) Now, you wish to update all
the rates for all of them and they all have the same rate setups.

In this case, you can highlight the shift in the Rate Treeview and click on the Copy Button.

This will open the Copy Rates window. Once the window opens, it will display a list of Shifts that are eligible for copy
operation given the shift that is being used as the source of the copy.

In order for a shift to be eligible, it MUST have the same start and end times as the source shift.

So, you can copy all the rates from the 7a-3p shift at Customer A to any other 7a-3p shift in the system.

@MicroStaffer Warning When you copy rates from one shift to another, it will remove ALL existing rates from the target
shift and replace them with rates from the source shift. This action CANNOT be undone.

You can also copy rows of rates.

Simply select the rate row then go to the Regular Windows menu located at the very top of the MicroStaffer application and
select Edit->Copy.

Then, to paste the copied rate row, simply select Edit->Paste while on the target rate row.

1‘ Copy Rates

Below iz a lizt of Shiftz which are eligible for Bate Copy operation.

Target(z]
Customer S hift Start Time End Time Copy
St Elmo's Medical Center 104 B m 300 PM
Select Al
Claze
Help

I1ze the CTRL-Fey to Select Multiple [tems
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O. Client Checklist

1. Maintenance of Client Checklist ltems

The purpose of the Client Checklist is to provide the MicroStaffer user with a means to track and maintain pertinent and/or
mandatory information for each client. Rather than digging through piles of paperwork, the necessary information is main-
tained and accessible right at your fingertips.

The Client Checklist Codes are created in List Manager found under the System tab. Codes which are added to all at the
time of setup will be displayed when you select Checklist under the Client tab. See screen below

If you wish to add more Client Checklist items that may not have been applicable to all clients, click Add.
To quickly mark all items complete, incomplete or to delete all, simply right click an item to access the shortcut.

Please refer to the Mail Merge (Letter), Email (Send) and Export sections of this user manual for use of each function.

-J. MicroStaffer - Medical Staffing Agency

File Employes Client Ysndor  Staffing ng  Payroll Reports  System  User ‘window Hslp

Yy = A <& B EEE & it iEd] 1y = ? L

Emplayes  Awailability  Contact: c  Documentc  Client Ffing Orders Invaicin Pagroll  Praforences  Reminders Motifications  Email  HelpTopics  Exit

tdandatary Status Last Updated by

Copy of Policy Manual received Qincomplele @Complete | | Administrator
Drirections o facility — " |ncomplete ¢ Complete Administrator

E xecuted Contract rd " |ncomplete T Complete \ Administrator

| o | @ooee | it | o= L | & sena [ Export

Ready |Regions: Off __|06/01/2005 1:57 PM
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P. Client Leads

Client Lead information is the foundation of recruiting new business. MicroStaffer provides the ability to easily track and
maintain this information so that you may continue to develop your company’s relationships. Client Lead information is easily
transferred to active client status. Client Lead information may be reported, used for email or mail merge purposes.

1. Creating a New Client Lead

Select Leads from the Client menu.

General Info

The required general information for the client lead is the name. All of the other fields are optional.
Contacts & Directions

Comments

Documents

Contacts

-} MicroStaffer - Medical Staffing Agency

File Employes Client Vendor Staffing Invoicing Fayrol Reports Systsm Ussr Window Help

N = = & B3 EEE & B iE] iy = @ o

Emplopee  Avallsbility  Contaces  Documents  Clint Satin Orders Invaicin, Pagrall  Preferences  Feminders Notfiestions  Email  HelpTopies  Exit
Floy y a iy IpTop!

. Client Lead Setup - New: |:"E|E‘

Client Lead: | j

Generall Contacts & Directions | Commerts | Documents | Cortacts

Hame: | [~ Drientation Mandataory D
Address:
——
City, 5t.Zip.: | | =] Region(z): Modify.

Tope: [Facilty (Hospital. Mursing Home...) <]

Last Madified by: | Ore |

Wobse | mNew | @peele | Wsae | @Tese |

Ready |Regions: Off__|0E/01/2005 2:02 PM
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2. Editing Client Lead Information

To edit an existing Client Lead information, simply select the Client Lead from the dropdown, make any changes and Save.

3. Transfer Client

To transfer a Client Lead to an active client, select the Client Lead from the dropdown and click Transfer. This will open up the
Client Setup window with the transferred information. You must save the information within the client setup window for the
transfer to be complete.

4. Client Lead Documents

The Document Manager for Client Leads. Please refer to the Document Manager section of the user manual for detailed
instruction.

5. Client Lead Checklist

MicroStaffer allows you to create and maintain a Client Lead Checklist similar in function to the Client Checklist. The Client
Lead Checklist is transferred along with the other data when transferring to active status.
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Q. Patient Setup

The Patient Setup facility is found under the Client tab. Patients may be created to track private duty scheduling within a
client facility. This patient information may then be tied to a shift at a facility on the Shift Detail window. In most general

staffing, this facility will not be needed.

1. General Information

The required information to add a new patient:

ID — Must be unique (MicroStaffer will disallow duplicate id’s)
First Name

Last Name

D.O.B. — Date of Birth

Gender — Select from dropdown

Extra general Patient information:

Address

Phone

Frequency of Service

Client — Select client where patient is located from dropdown
Region(s) — If applicable

2. Primary Care Provider Information

76

This tab is currently for informational purposes only. Select the type of Primary care Provider from the dropdown and enter

any applicable information.

3. Medical History

This tab is currently for informational purposes only. Check the box to select which item to enter information within.

-} MicroStaffer - Medical Staffing Apency

File Employes Client Wendor Staffing Inweicng Payroll Reports System  Ubifies User Window Help

P o] 23 < B 553 & i & +Y = @ o+

Emplopes  Awailability  Contacts D k= Client Stafing Orders luvaicin Pagrall  Praference e Remindurs Notification = Email  HelpTopics  Exit
ploy: ¥ g e P Topi

-} Patient Setup - New Patient

Patiert: |

General | Primay Care Provider | Medical Histary |

D
First Mame: | Last Name: | M

D.0.B. [0070070000 Gender: | =~ ssM: [

Address: |

Frequency of Service:
Address2; |

City, State. Zip: | Client: |

Home Phone #: [ 1 -

Fegion(s): | Moty

Last Madified On: Last Madified By: System ID: 38

Woose | @ see | g@poee | @ Search ™ New

Ready |Regions: O |0E/01/2005 2:09 P
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R. Employee Setup

1. Creating a New Employee

To Add a New Employee:

1. Select Employee->Setup from the Main Menu or click the Employee Toolbar.

2. The Employee Setup window opens in New Mode.
OR Click the New button located on the Employee Setup window.

MicroStaffer Note: Employee information can also be transferred to the Employee Setup window by using the Transfer
button found on the Employee Lead window. Also, the optional MicroStaffer Web Module has an on-line application
function which allows the on-line application to be processed into the Employee Leads area for continued recruit-
ment. From there, transfer to active employee status is as simple as clicking the Transfer button.

-} MicroStaffer - Medical Staffing Agency
File Employes Customer Vendor Staffing Irwoicing Payroll Reports System  View Utilities User Window Help

o @ ot < &g 553 & 2] [ iy = R o

-f. Employee Setup - New

Employee: | x| = M S g [ Sub-Contractor -

[~ Show Teminated

General I Profile I Skills I Custom Info I Comments ] Documents 1 Payroll ] Contacts ] Follow Up ]Web}

Fhone
Eist Name: | e Mumber Descrption
Last Hame: [
Address: |
[
i EMsit |
st gip: =] Pager E-Mai |
EELLLS B Cell E-Mail: |
Tiepe: =l se [ ] Referal Type: |
Date of Birth: | 0040070000 MNotify [~ 7 Dayps |Before  ~ Pisferred by: |
Date Hired: [00/00/0000 [ |nactive
i | [~ Teminated Date: |00/00/0000
Eile:
Reagion(s): | P adify.
o External ID: Last Modified by: | On: |

Total Mumber Entered to Date: 199 Ticklers: [] Sign-On Borws [ ] Astenal Bonus

1 ERE |28 @

Freason: |

&} Close | @ | W sae | gpPoie |

|Regions: O |05/17/2005 1:05 PM

Ready
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2. Editing Employee Information

a) Accessing Employee Data

To view and modify Employee data, select Employee->Setup from the Main menu or click on the Employee Toolbar Item.
When the Employee Setup window opens, select an Employee from the Employee Dropdown in the top left corner of the

window.

10.

1.

12

13.

14.

15.

b) Employee General Info
Name: Enter the first name and last name of the Employee.(Required) Middle initial is not required.
Address: Enter the Street, City, State and Zip (Required).
SS#: Enter the Social Security Number of the employee (Required). Must be unique.
Type: Select an employee type from the dropdown. Employee types are created in the List Manager area.
Sex: Select from dropdown.

Date of Birth: Enter date of birth. Click notify box and set tickler if you wish to be notified in Staffing Center of
approaching birthday.

Date Hired: Date of hire. Check inactive box if the employee is inactive.
File: Areference field. Optional.

Region(s): Users may assign one or more regions for any Employee. Regions can assist with matching Employees
and Customers for Orders, Availabilities and other scheduling functions. Regions and region codes are created and
managed in the List Manager window.

External ID: This is a field that can be entered per user needs. It will allow you to synchronize your employees with
any other systems that contain employee data. For example, if you are using another software package for ac-
counting purposes, just enter the ID from that package for the given employee here.

Phone: MicroStaffer provides the ability to maintain multiple phone numbers for each employee. If your system is
enabled with the appropriate telephone software and hardware, you may dial an employee direclty by using the
phone icon next to the phone number field. Please contact MicroStaffer technical support for more specifications.

Email: Enter multiple email addresses for employee if applicable. MicroStaffer will populate email address within
email composer window when applicable. Click on the icon next to the email address to open a blank composer
window.

Referral Type/Referred By: If applicable, select the referral type from the dropdown and type in the name of the
referring employee.

Terminated: Check box if employee has been terminated. Reason is optional. Please note, you will need to search
separately for terminated employees by clicking Show Terminated box at the top of the screen.

Sign-On Bonus, Referral Bonus: MicroStaffer allows you to create Ticklers that notify you when certain Employ
ees have met Sign-Up and Referral bonus conditions. These bonuses are typically met by an employee working a
certain number of shifts after they are signed up, or, if they recommend another employee, once that employee has
met the bonus requirement, the referring employee gets a referral bonus. The ticklers created here are displayed in
the System User Notifications Window.
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User Window Help

Y = ? 13

Emall  HelpTopics  Exit

File Emplovee Customer Vendor Staffing Invaicing  Payrall System  Wiew  Utilities

h o it <> i) Bl EEE & =
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Employee Setup - Rogers, Sharon (RN)

Employes: s, Sharon [HH] EJ W S leEie [ Sub-Contractor -

[~ Show Terminated

General l Profile I Skillz ] Custom Info 1 Comments ] Documents ] Payroll 1 Cortacts ] Followy g lWebl

) i — Phane
Eirst Mame: |Sharon M1 Mumber Description
Last Name: [Rogers |215.552-4055 [Home

Address: |[7B07 M. Chicot Apt. BF |215-SBD-TB‘33 |Ee\|
[ [
Ciyr [Phiadelphia E-Mail: [sales@microstaffer. com
St Zip.: P4 x| pg1s2 Pager E-Mail.
S5 No. |838-83-0544 Cell E-Mail: |
Type RN = Sex [ =] Fieferral Type: | Contractar Referal

Date of Birth: | 03/14/7967  Motify [» 7 Days [Before ¥ Referred by: [Lisa Loving CNA,

Date Hired: |09/03/2002 [T |nactive
[~ Teminated Date: | 00/00/0000

File: [Dr
Reason: |
Fregion(s} Modiy

| 132 Extenal ID: [ROGERSOOT Last Modified by: | Administrator On: [04/28/2005 2:26 PM

EEE2EE

Total Number Entered to Date: 133 Ticklers: Sign-On Bonus ] Referral Bonus
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Employee Setin - Bnaare Sharnn (N1
Employee Referral Bonus Ticklern
Employee:

v Active Effective Date: |05/17/2005 v
General l Pi

First Nam Min. # of Shifts Worked: 25 ? o
Last Narme in. # of Hours Worked: 250.00

Hourz are Time-infTime-Dut Only
Addres:
Worked Status: | Scheduled/Fim =] |

[ Count Invoiced Shifts Only [ Count Paid Shifts Only

User to Motify: |Adm|n|slrator - admin j

MNaotify Message: |Hefe|ra\ bonus due to Jane Doe

Date of Bit Last Modified by: | On: |

Date Hirex

Eil

Fegions| €3 Cancel
o ||

Tatal Mumber Entered to Date: 193 Ticklers: Sign-On Borws || Referal Bonus
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c) Employee Profile

The employee profile tab on the Employee Setup window allows you to enter detailed information for each employee such as
licenses, certifications, skills etc. The employee profile may be quickly generated to email or print with copies of supporting
scanned in documentation (if applicable).

Please note that you must create types for most of these in the List Manager window.

To add a new item, click and existing item in the tree or header item and then click the New button. To edit an item, select it
and click Edit or double click. You can also expand and collapse all items in the tree by right clicking on the tree.

Iltems that are tickler enabled allow for an alert to be enabled for a user defined number of days before (or after) the expiration
date of the profile item. Please note: a default number of days may be set in the System Options menu - Employee and
Client setup - Default Expiration Days on employee Profile Items.

Tickler enabled items may also be defined so that an employee may not be staffed until a specific expired profile item is
taken care of. The options are set on the System Options menu.

Documents may be attached to profile items by selecting the document in the documents tab and then dragging and drop-
ping the document to the applicable employee profile item. Alternatively, right click on the profile item to view a list on options
for attachment. This will allow for attachment of documents when generating an employee profile using the Profile button.

NOTE: To remove a document from being attached to the Employee Profile, right click on the document within the Profile and
select “Remove Attached Document”. This will remove the document from the profile but retain the document on the Em-
ployee Documents tab. (Be careful, the delete selection will delete the entire document).

The following items can be added and edited using the employee profile tab:

Licenses (tickler enabled)
Insurance Policies (tickler enabled)
Certifications (tickler enabled)
Customer Incompatibilities
Orientations Performed

Customer Preferences

Job History

References

: Background Checks (tickler enabled)
10. Education

11. Health Screenings (tickler enabled)
12. Annual Reviews (tickler enabled)
13. Tests Taken (tickler enabled)

14. Training Courses Attended

15. Skills Checklist (tickler enabled)

©OoNOOAWN =

Click the Profile buttom to quickly generate an employee profile for the active employee. Format the displayed Profile using
the Format tab. Profile may be printed (including or excluding supporting documentation) or emailed. Attached profile
documents may require the use of a licensed version of the Scanning & Imaging module.
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d) Employee Skills

The Skills tab on the Employee Setup Window allows you to assign or remove a skill from an employee’s profile. You may
either select a Company wide skill from the dropdown or type in a new skill and add it to the selected list.

New skills added on this tab will become part of the Company global skills list.
Skills are used to describe the abilities of Employees. They are used in identifying and grouping employees for staffing

purposes. The skills list will be available on the Employee Setup window and the Employee List query window. Skills and
rankings are an option on the Employee Profile report.

Navigation

1. Add: Add a skill to the Selected Skills list by choosing a skill from the dropdown or typing in a new
skill and clicking the Add button.

2, Delete: Deletes the skill from the selected list.
Data Entry Fields
1. Skill Code: An abbreviation for the skill.
&‘? MicroStaffer Tip
Try to make the skill code descriptive. It acts more as a short name than just a code and
will appear on report and query windows.

2, Skill Description: The description of the skill.

3. Skill Ranking & As of Date: Rankings are maintained on the List Manager Window.

-1/ MicroStaffer - Medical Staffing Agency

File Employes Customer Vendor Steffing Inwoicing Payroll Reports System Wiew Ublties User Window Help
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| Skill Code Description Rank. A of.
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e) Employee Custom Info

The Employee Custom info Tab on the Employee Setup window allows for viewing and modifying Custom Data as was
defined in the Company Setup window’s Custom Info Tab.

Date fields can be Tickler enabled. This means that when a date for a custom info field falls within the parameters of the
tickler, a message will appear when the employee is being scheduled on any of the Staffing Windows.

croStaffer, - Medical Staffing Agency

File Employee Customer Yendor Staffing Inwoicing Pawroll Reports  System  Wiew  Ubiities User ‘Window Help

4 ® T > m B K = & =B @B L o= ?
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Contractor Company:

US Citizen?: h’es

Green Card/work Permit 3 |
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f) Comments

The Comments tab allows for entry of comments regarding the employee. Simply type in the Comment and save.

icroStaffer - Medical Staffing Agency

File Employee Client “endor Staffing Inwaicing Payroll Reports Swskem  Wiew  Lkilties User  Window Help

S - - @ e Ef EEE & i &) & = ? ® B
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dg) Employee Documents

The Employee Documents tab on the Employee Setup window allows you to manage images and Rich Text format
documents created with the MicroStaffer Document Manager module.

Please refer to the Document Manager section of this manual for specific instruction on the use of the options.

Documents may be attached to corresponding Employee Profile items by opening the profile item, moving to the document
tab, right click the document and drag and drop to the profile tab. Alternatively, a document may be attached directly to the
profile item by selecting the profile item on the profile tab and right clicking to access the options. Refer to the generated
Employee Profile for further options regarding emailing or printing documents attached to an Employee Profile.

Display options are selected by clicking the appropriate radio button. The choices are:

- Show All
- Show Profile Documents Only
- Show Non-Profile Documents Only

-{ MicroStaffer - Medical Staffing Agency =]
File Employee Facility Wendor Staffing woicing  Payroll Reports  System  Wiew  Utilities  User  Window Help
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h) Employee Payroll Info

The Employee payroll tab on the Employee Setup window allows you to view and modify withholding and year-to-date gross
earnings information. This information can be used for exporting payroll data to any external payroll system.

Data Entry Fields

1. Pay Period: Select the desired pay period for this Employee. This field is critical when used to calculate withholding. It
will also allow you to filter which employees to pay on the New Payroll window. Among other filter criteria, the New
Payroll window allows payroll to be run for employees that fall under all pay periods or just one specific period. See
the New Payroll for more detailed information on this setting.

2. Corporation: Check this box if you wish to pay this employee as a corporation. If this box is checked, the Tax ID and
Corporate Name fields become enabled. No taxes will be withheld.

3. TaxID & Corporate Name: Enter the Tax ID and Corporate name if you have checked the Corporation
checkbox.(Required)

4. Federal Tax Fields:

Marital Status: Select the desired federal tax marital status.

Allowances: Enter the number of allowances up to 10.

Additional Tax: Enter any additional federal tax to withhold from each paycheck.

Exempt: Check this box if the employee is exempt from federal taxes as indicated on form W4,

oDow>

5. Direct Deposit Checkbox: Select whether this employee will be paid via Direct Deposit.

6. Charge and Same-Day Booking bonuses: See Company Setup for more information on these fields.

-i MicroStaffer - Medical Staffing Agency. r;”‘il _|
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i) Contacts

The Employee Contacts Tab allows you to view and enter contacts between your company and your employees. Contacts
may include offering work, request for paperwork, etc. There is a contact report on the report tab.

Note that you must define Contact Reason and Result codes in the List Manager window.

Contacts may also be entered quickly by clicking the Contacts button.

- MicroStaffer - Medical Staffing Agency
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j) Follow Up

The Follow Up Tab on the Employee Setup window allows for entry of follow up reminders to system users for items specific
to the employee. The entered follow ups will appear in the System User Notification window when the item becomes active.
Select “Only Notify” and pick a user from the dropdown list to quickly select a single user for notification.

File Employee Faciity vendor Staffing Invoicing Payroll Reports System Wiew  Utilities

User Window Help
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k) Web Access

The Web Tab on the Employee Setup window allows you to enter a User ID and Password for the Selected Employee to
have access to the MicroStaffer Web Module.

With this User ID the Employee can log into your MicroStaffer Web module using any common Web Browser such as
Internet Explorer or Netscape Communicator.

Please contact MicroStaffer sales for more information on purchasing the optional Web Module.

icroStaffer - Medical Staffing Agency
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S. Employee Specific Rates

Employee specific Pay and Bill rates can be set up on the Employee Rates window. This window is accessible from both
the Invoice and Payroll menu items on the main MicroStaffer menu.

@?Microsmffer Warning Please note that Employee Specific Pay and Bill Rates take precedence
over Customer Specific Pay and Bill rates. If the MicroStaffer Payroll and Invoicing module find

an applicable Employee Specific rate, this rate will be used over any other Customer Based
rate.

Employee Specific rates give you the ability to create a Pay or Bill rate or rates for a single employee. In other words,
custom rates for employees.

To select which type of rate you wish to add, edit or delete, select the applicable ‘Pay Rates’ or ‘Bill Rates’ Tab on the
Employee Rates window.

Employee rates offer you great flexibility in that there are several categories of rates you may create. The following is the
hierarchy that MicroStaffer uses when deciding which Pay and Bill rate to apply for Employee Specific Rates:

1. Global Employee Rate - Rate that has no attributes at all.

2. Work Area Rate - Employee rate for One Specific Work Area.

3. Customer Rate - Arate for one Customer only.

4. Customer & Work Area - A rate for one Customer’s specific Work Area.

5. Customer & Shift Category - Rate for specific Customer and a specific Shift.

6. Customer, Shift & Work Area - A rate designed for one specific Shift, Customer and Work Area.

For example, say you created a pay rate for Employee Janet Smith. Rate is for when she works in any ER.
Now, whenever Nurse Smith works any ER at Any facility, the receives this rate.

Later, you create a rate for her that is higher. This rate is a special rate for St. Luke’s ER only.
Now, whenever Nurse Smith works in the ER, she receives the ER rate, unless, she works at St. Luke’s.
The entry of Breaks and Split Rates is described in the Client Rates setup section in this user manual.

Note: You can copy and paste one or more rates from one employee to another by Right-Clicking on the White
Rates List window.
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“f- MicrosStaffer - Sample Medical Staffing Company
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T. Employee Checklist

The Employee Checklist facility is provided to maintain a checklist of items for each employee either prior to hiring or
continued maintenance of new items as they become needed.

Employee Checklist codes are created in List Manager found under the System tab. MicroStaffer can also disallow schedul-
ing an employee who has missing mandatory checklist items. This would have to be turned on within the System Options
facility under Staffing and Scheduling. Please refer to System Options for more assistance.

1. Maintenance of Employee Checklist Items

Select Checklist from the Employee menu item and choose an employee to work on from the dropdown. The Employee
Checklist Codes which were added to all employees at the time of setup will be displayed.

-} MicroStaffer - Medical Staffing Agency
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If you wish to add more Employee Checklist items that may not have been applicable to all employees, click Add.

To quickly mark all items complete, incomplete or to delete all, simply right click an item to access the shortcut. To mark
one item at a time, click the dot for complete or incomplete. Notes for specific items may also be entered. Remember to
save any changes made to an employee checklist.

You may send reminders to employees regarding incomplete checklist items. Please refer to the Mail Merge (Letter), Email
(Send) and Export sections of this user manual for the use of each function.

NOTE - If the System Option to disallow scheduling an employee with missing mandatory checklist items is turned on,
MicroStaffer will NOT allow booking of any employee with an incomplete checklist.



MicroStaffer User Manual 94

Copyright [1 1999-2005 DCT Computer Systems Inc.

U. Employee Leads

The ability to maintain and track employee lead information is key in recruiting stellar employees to your agency. No more
lead information falling through the cracks, it is all at your fingertips!

Processing of On-Line Applications (Optional — Must have MicroStaffer Web Access Module)

Employee lead information may be transferred from the MicroStaffer Web Access Module if your MicroStaffer System
includes this powerful option. The information gathered from the On-Line Application Form within the MicroStaffer Web
Access module will flow into the System Notifications window. Only MicroStaffer users who have the ‘review On-Line Appli-
cants’ checkbox on the User Setup Window check will have the ability to view new applicant data within this window. From
the System Notifications window users may forward on-line applicant data to the Employee Leads window or delete unsuit-

able applicants.

-f MicroStaffer - Medical Staffing Agency EIEIEI
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To enter new Employee Lead information, select Leads from the Employee menu. The only required information at this time
is first and last name. The following items are optional (see Employee Setup for detailed descriptions of each item):

Profile Items
Skills
Comments
Documents
Contacts
Follow Up
Custom Info

Transfer Employee Lead to Active Status
To transfer an Employee Lead to an active employee, select the Employee Lead from the dropdown and click Transfer. This
will open up the Employee Setup window with the transferred information. You must click save in the employee setup window

for the transfer to be complete.

Employee Leads may be inactivated by checking the Inactive box .
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V. Vendor Setup

MicroStaffer provides the ability to create vendors that will provide subcontractors if necessary. The client still orders the
staffing through your agency but you will subcontract the work out if no suitable employees exist within your available staffing
pool. Employees for the vendor are created within Employee Setup and flagged as a subcontractor for their respective
agency. Throughout MicroStaffer, this employee will be highlighted so the user is aware of their subcontractor status. As an
added bonus, within the availability filters the user has the opportunity to display only employees, only subcontractors or all
available.

1. Creating a New Vendor

The creation of a vendor is very similar to the setup of clients.
General Vendor Information

Name — Required.

Address

Active/lnactive flag

Tax D

Region (if applicable)

Worker's Compensation

General Liability

External Id

Contacts & Directions

Comments — Entry of any comments pertinent to the vendor.

Documents — Vendor’s supporting documentation (may include copies of insurance policy for example).
Contacts — Entry of contacts with the vendor with reason and outcome codes.

Editing Vendor Information
To edit vendor information, simply select the vendor that you wish to edit from the dropdown. Make any necessary changes
and save.

- MicroStaffer, - Medical Staffing Agency
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W. Vendor Checklist

The purpose of the Vendor Checklist is to provide the MicroStaffer user with a means to track and maintain pertinent and/or
mandatory information for each vendor. Rather than digging through piles of paperwork, the necessary information is main-
tained and accessible right at your fingertips.

The Vendor Checklist Codes are created in List Manager found under the System tab. Codes which are added to all at the
time of setup will be displayed when you select Checklist under the Vendor tab.

This screen includes Vendor Checklist Codes added to all vendors.

-} MicroStaffer, - Medical Staffing Agency
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1. Maintenance of Vendor Checklist Items
If you wish to To quickly mark all items complete, incomplete or to delete all, simply right click an item to access the
shortcut.

Please refer to the Mail Merge (Letter), Email (Send) and Export sections of this user manual for use of each function.
add more Vendor Checklist items that may not have been applicable to all vendors, click Add.
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Ready |Fiegions: Off __|0B/03/2005 524 At
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IV. Using MicroStaffer - Staffing & Availability Tracking

A. Staffing & Scheduling - Staffing Sheet

1. Staffing Sheet & Calendar Overview

The Staffing Sheet & Calendar represent the heart of the MicroStaffer system. They are where Employee/ Client shifts
are scheduled. Well over 90% of all activity in the system will occur on the Staffing Sheet or Calendar. Once employees,
clients and rates have been set up, the staffing sheet & calendar will allow you to easily create shifts that automatically pull
in all this information.

To access this window, select the Staffing->Staffing Sheet from the Main menu or click on the Staffing Sheet toolbar item.
The following Topics cover this Window:

1. Navigating on the Staffing Sheet and Calendar
2. Adding a New Shift

3. Editing Shift Information

4. Making a Shift Payable and Billable

5. Copying a Shift
6. Deleting a Shift

-§ MicroStaffer, - Medical Staffing Agency

File Employee Customer Yendor Staffing Inwoicing Payroll Reports  System  Edit Wiew User ‘Window Help

h @ &= 2 i Bl £t & B E 1Y =1 @ e

Employee  Availability  Contocts  Document ts  Customer  Staffing Orders  Invaicing Fayroll  Preferences  Freminders Motifications  Email  HelpTopics  Exit

.{/Staffing Sheet - Chester, County Hospital Tuesday, May 10, 2005 through Monday, May 16, 2005

Ready

Euslumer.‘EheslerEUunly Hoszpital j Week Slarlmg. < [[0BAM0/20058 | > | 33| View: |7 w | Days
Staffing Sheet l Calendar l General Info & Rates l Options I Trawel l
Tuesday | Wednesday | Thursday | Friday | Saturday | Sunday | Monday A
05/10/2005 051172005 05/12/72005 05/13/72005 05/14/2005 05/15/2005 05/16/2005
[Day ) 30P
Samuel, & Tz [Karpeh, M Tz [Karpeh, M Tz [Abraham, M Tz [Zachau, P Tz [Rogers, 5 T3 [Zachau, P %
] 7o0a-330P [P [Fl 7oos-330r (] [F] roos-zaor [F] [F] roon-zaor [F] |F] moon-zoor [F] |F] tooa-zzor [ ] ro0a- 400 [F]
=] Order P [PEDS  Order  RNE IPEDS  Orider  RHE Order Frl |ED Order Ler |ED Order Ler |ED Order LPH
Karpeh, M TE Karpeh, M = Augustine, S T
1 rooa-z30F ] O 7ooa-za0F [ | T | Pl mooa-z30F [ [0 raoca-za0r [
PEDS RAE ICCU  Order PEDS  Order  ANE Order ED Order LPH
‘ ‘ ‘ ‘ ‘ ‘ [0 Fao0a-z30F [
ED Order LT
[Eve 8] 300P-11:30P
Abraham, M RogerS.E ok |Fogers, 3 5 [Fogers, § 75 |Fogers, § 75 [Daviz, & TS
Fl =00F-tzor [F] [F] sl | F |71 z00F-zoos F] [F s00r-tsor [ [F] s00F-n30r Fl [F] w=00P-tsor [F] |0 w00F-usr [
Fu LD Ordar [ e Order (i) Order LPr |LeD Order Ler |ED Ordar Fr lED Ordar LFH
Samuel, £ Tz |Zachau, P 5 [Davis, & 75 [Fiogers, § T3
[ =o0F-ftsor [ F zooF-t0or ] [ z00F-n30F @] [F] z00P-fiwor Fl Fl sor-izses F [ sor-isor [
Ordar (] Order [l ) Order Len |ED Ordar FH OG0 Order Len |ED rdar LFH
Chappelle, M TE Cheriarcv'(;\ o
[ =o0F-ttsor [ 1 zo00F-tt0F [F] [F] o (aom |}
Ordar ED Ordar Fr ED Order  RN-E
Zachau, P Tz [Augustine, S s
] z00F-te:F [F] [F] w00F-130F 7]
ED Order LF Order
Johnson, & 7= [Mei,L TS
Pl z00F-te;r [F] [F] w00F-130F 7]
H Order Frl Order
Samuel, & T
Fl z00F-1o0r  [F]
[T COrder LFTI
[Night &) 11:00 iy
Kelly, 3 T [Karpeh, M T [Samuel, & Tz [Kelly, = amuel, & 75 [Davis, & s
F] 1045 -7155 F] [Fl toor-7458 F] [Fl toor-7a0s [ F] wsor-7ooa ] [F] O woor-7a0a ] |F] nooR-730a [F]
ED Ordar EH Ims Order  RN-E LD Order [ ) rder Fr |LGD Order Ler |ED Ordar FH
Jordan, b T= |Kelly, = T Samuel, A = Kelly, & TS
F1 toor-s00s F [Fl 10450 -7308 F] F toor-7308 ] F toor-7308 [F]
Mz rr-E lED Ordar = LiD Order ] 3 Ordar
Jordan, M TS
] ti5F-z008 [F]
[ Order  EN-E
[Dap 12] 7:004-7:30F |

|Regions: Off  |05/18/2005 11:14 &M
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2. Staffing Sheet & Calendar Navigation

The Staffing Sheet displays shifts by Client for any 7 to 35 day period in a spreadsheet like format. To select a client for
which to display shifts, general-and-rate information, make a selection from the dropdown located in the top left corner of this
window.

The Staffing Calendar displays similar information not on a Shift Basis but rather on a Calendar like spreadsheet format.
Since all clients must have at least one shift type defined, at least one row will always appear on the staffing sheet window
once a client has been selected.

To change the starting day of the staffing sheet, select a date from the Standard Date Dropdown located in the top right hand
corner of the staffing sheet window.

To change the number of days you wish to view, simply select a different number from the ‘View Days’ dropdown.

ﬁ? MicroStaffer Tip
If you type in the date into the ‘Week Starting’ field using the keyboard, you must hit the enter key or tab of the date field for
the data to be retrieved

The Staffing Sheet and Calendar may be printed or emailed in a variety of formats. Simply right click on the staffing sheet and
select “Schedule” from the drop down for options.

The Staffing Sheet and Calendar may also be copied by selecting Copy from the “Schedule” selection. Select the customer
to use as a basis, the date range and the target start date for the schedule to be copied.

-} MicroStaffer - Medical Staffing Agency

File Emplovee Customer Wendor Staffing  Inwvoicing Payroll Reporks  Swskem  Edit Wiew User  Window Help

ah = it <> iz g - & it [ Iy = P e

Emplopee  Awvsilsbility  Contacts  Document tz  Customer  Staffing Orders Inwsicing Pagroll  Preference = Reminders Motificstionz  Email  HelpTopice  Exit

-} Staffing Sheet - Chester County Hospital Tuesday, May 10, 2005 through Monday, May 16, 2005

Eusmmer|EhesterEnuntyHnspilal ﬂ Wesk Starting: <<| < ||09/10/2008 | > | > | View Sl ~| Daps

Staffing Shest Calendar ] General info & Retes | Optins | Travel |
Tuesday Wednesday Thursday Friday Saturday Sunday Monday
05/10/2005 05/11/2005 05/12/2005 05/13/2005 05/14/2005 05/15/2005 05/16/2005
Samuel, & T HDgErS,E ok [Blake,M 75 |Zachau, F 15 [Zachau,F 75 [Augustine, 5 75 |Zachau, F TS
F roos-zs0F F]F] ol Cor F 7o0s-730P ] F] s00P-is0p F]F] ro0a-x00 @] F] Oro0A-ss0P @] |F] T00s-400P [F]
[(=0) Order LPM L&D Order LPN CHNA JED Order LFM IED Order LPN Order ED Order LPM
Kelly. 5 s [Kelly, 5 75 [Rogers. & 5 [Rogers. 5 s [Adeleke. Y Fogers. & s
1 w04sF-7i5s [F] |[F] 0ssR- 708 B F] wooF-1zo0a F] |F] soor-nzor [F] (P orooa-taor FlF] voa-zsor ][O voos-zme [
ED Order RN IED Order A LED Order LPN L&D Order LPH IED Order RrIED Order LPN IED Order LPM
dordan, 1 s |FEE, L 5 [Samuel, A 75 [Kelly, & 75 [Johnson, & 75 [Davis, & TS
F] ttooP-s00a F] F] toor-tzo0a @] [F] s00P-itwoF @] [F osoe-roos F]F] s00P-tsor ] F] s00F-tsoP @] |00 mo0s-ss0P [
5 Order RN-E |ED Order LizD) Order LFN IED Order IV I ES Order RN IED Order RH IED Order LPM
Karpeh, M T5 |Karpeh, M TE |Samuel, & T |Samuel & TE |Samuel, A s Chenar;@ ok
Fl 7oos-z20F [ ] noor-748s ] F] noor-7z0a ] F] noor-7aos [F] (F] ozoor-moor [F] F]s VQUF' F O zowor-nzor [
PEDS Order FRM-E IMS Order FM-E IL&D Order LPH L&D Order LPH 1M Order LPN IED Order FRN-E IED Order LPM
Abraham, 1M Karpeh, 11 75 [Karpeh, 1M 5 [Abraham, M s [Davis, & 5 [Augustine, 5 TS
Fl soor-ts0F ] F] rooa-ssor ] P rooa-ssor [ [F] oreca-zar ] F] 0P tsor ] F] s00R-tsor @] |00 w00F-nser [
RN IFEDE Order FN-E IPEDE Order RN-E Qrder RN ED Order RN Order ED Qrder (0]
Karpeh, T5 [Chappelle, M 75 [hei, L TS

‘D 300P-n30F [ ‘[l 7:005 - 3:30P El‘ ¥ 7o0a-330P [F] |[F] z00r-n3oP [F] [F] zoop-nsop #F] [ voor-7aoa [
Order ccu Order =3 Order RN-E |ED Order Order Order LPM

PED: FM ED
Zachau, P 7= [Rogers. 5 TS
O zo00F-zor [ 1 z00F - ti0r F] [F] s00r-1zaos F] O 7o0R-7e0a [
Order ED Order LPM L&D Order LPH IED Order LPMN
Fiogers, & TS
F s00F - t30F @] [0 7o0F-7s0a [
L&D Order LFM IED Order LFM

Samuel, & s
] 1oor- 7308 [F]
L&D Order LPN

Davis. & TS
1 noor-7z08 &
ED Order RN

Kelly, & TS
] 1ooF - 7a0a F]
M3 Order RN

Jordan, M TS
1 nise-sooa F]
[XES Order RN-E

Ready [Regions: O __|05/15/20015 11:16 &M
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3. General Info & Rates

The General Info & Rates tab provides the user with quick access to basic information about the customer and lists the rates
for same. To change the display options for the rates, select the radio button for the type of display desired (hourly or shift
totals). You may also print all of the rates displayed.

- MicroStaffer - MedTemps, Inc.
File Employee Customer ‘Yendor Staffing  Invoicing Payroll Reports  System  Edit Wiew User  ‘Window Help

o = et <> iz B EEE & = [ 1Y = @ ® m-
icis Fremis nnec xil

Employec  Availability  Contacts  Document ts  Customer  Staffin Orders Invaicin Payroll  Preferences  Reminders  Motifications  Email
ploy v 9 9 0

.{. Staffing Sheet - Bobbi't Test Facility Friday, Dec 2, 2005 through Thursday, Dec 8, 2005

Customer: |Bubbl'l Test Facility ﬂ wieek Starting: << | < |[[12/02/2005 | > | >>|Wiew |7 w | Daypz
Statfing sheet | Calendar General Info & Rates ] Options | Trawel |
Mame: [Eabbi't Test Facility Phone: [B105552222 =]
Address: [85 High Street Fau: | |
| Contact: | =]

City, St.. Zip.: [Exton, P& 19341

Employee Hourly Pay Rates

Shift, | Manday | Tuezday |W’ednesday | Thursday | Friday | Saturday | Sunday
Test
[4847] Standard Rate [ [ [ [ [ [ [
£:45 AM - End of Shift...oocoooen | ooo | ooo | ooo | ooo | ooo | oo | oo
FA-IP
[4849)] Standard Rate
700 Ak - 17:00 Ak 20.00 20.00 20.00 20.00 20.00 20.00 20.00
11:00 Ak - 11:30 AM 20,00 20,00 20,00 20,00 20,00 20.00 20.00
171:30 AM - End of Shift................. 20.00 20.00 20.00 20.00 20.00 20.00 20.00

Ready [Regions: Off __[12/02/2005 11:06 &M
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4. Using the Options Tab

The Options Tab on the Staffing Sheet window allows you set various filter and formats for retrieving and viewing data on both
the Staffing Sheet and Calendar.

honN

wWoNoO O

Status: Use this filter to display only shifts with the Selected Status. You can use the List feature by entering a
comma-separated list of Status ID’s (eg. 1,3,4).

Confirmation Status: This filter allows you to view shift that are confirmed or not with either Employee and/or Client
Order Status: Use this filter to view orders, open orders, filled orders etc.

Area: Allows you to retrieve only this shifts for the select area. Again, you can use the list feature by entering a
comma-separated list of area codes (eg. MICU,SICU,CCU etc.)

Desired Skill: As with Areas, you can filter the Staffing Sheet and Calendar using Skill Codes.

Employee Type: Allows for viewing of shift for selected Employee Types. List feature allows for multiple Types.
Specific Shift: This Shift Filter will result in only those shifts being displayed that are select in this Dropdown list.
Time Sheet: You may choose to view only shift with Time Sheet received or not.

Display Filled Shifts Only: When this box is checked, only rows with at least one shift that has an employee
assigned to it will be displayed.

Suppress Blank Rows...: When this box is checked, the staffing sheet will not display any rows that do not have at
least one shift or order. Very useful for printing. Applies only to the Staffing Sheet.

- MicroStaffer - Medical Staffing Agency

File Employss Customer Vendor Staffing Invoicing Payroll Reports System Edit Visw User Window Help

s @ et = B EEE i) B, = @ -
Docu

Employes  availability  Conta Customer Staffing Orders Invaicing @ Paprell  Prefarence: s Reminders Motification: = Email  HelpTopicc  Exit

-{/Staffing Sheet - Chester County Hospital Tuesday, May 10, 2005 through Monday, May 16, 2005
Customer: | Chester County Hospital ~l Week Starting <<| < |[05/10/2005 ~| > | >> | View: [FHNNE_~] Days
Staffing Shest Calenciar ] General Info & Rates Options: ] Travel ]

The following fitsrs can be used to display only shifts on both the Statfing Sheet and Calendar that fall within the settings you specify below

Filter [ Select [ Fiom [ To [ 1 Reset
LT RN [ == =1
Corfirmation Status [Far=—— ~] Customer - Emplayse: -
Order SRS e [==aLL =
BB [ =
Desired 5kl [ &= =
Employee TYRe...ooooovrveveecvcveee [ == =
S5pecific Shift [ El
Time Sheet AT =
[~ Display Filled Shifts Only
[~ Suppress Blank Fiows on Staffing Sheet

Fieady |Regions: O |05/18/2005 11:18 &AM
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5. Adding a New Shift

A new shift can be added to the Staffing Sheet in one of two ways:

1. Since a minimum of one row always appears for every shift type, simply right-click on an empty or occupied cell for the
desired day and shift type and the Sheet Popup Menu will appear. Just select Add from the menu and the Shift
Detail window will open allowing you to enter the required information.

2. Ifthere are any empty cells on the sheet, just double click on an empty cell for the desired day and shift type and the
Shift Detail window will open allowing you to enter the required information. This is basically the same operation as
Editing a Shift.

@ MicroStaffer Tip
If you want to insert a shift, that is placed prior to an existing one, right click on the cell where you want to place the preced-
ing shift and select Insert from the Sheet Popup Menu.

-{. MicroStaffer - Medical Staffing Agency

File Employes Customer WVendor Staffing Inwoicing Payrol Reports  System  Edit Wiew User  Window Help

s & i <> i) B EEE & i ik Y = ? o

Employee  Availability  Contacks  Documents  Customer  Staffing Orders Invaicing Pagrell  Preferences  Feminders Notifications  Emsil  Help Topics Exit

-3 Staffing Sheet - Chester County Hospital Tuesday, May 10, 2005 through Monday, May 16, 2005
Customer: | Chester County Hospital =] wieek Starting: ﬂﬂ [05/10/2005 -] ﬂﬂ Wiew: [T+ | Daps
Staffing Sheet l Calendar l General Info & Rates l Options l Travel l
Tuesday | Wednesday | Thursday | Friday | Saturday | Sunday | Monday | Lo’
05/10/2005 05/11

Samuel, & = [Karpeh. 1 G 1
B 700a-330F ] [F] ro0a- eneral l Comments ] History ] Invoice & Payroll ] Call List ]
lcu Order LPM IFEDS _ Ord Current Rates for this Shift
Ermployes:
Karpeh, I TS e | _ =] ﬂ Type | Amount Hours |
%D; DDO”";?’?'DP RE E':U 7 DDQ{; Customer. |Chester County Haspital -l Pay Rate (56781 $170.00 9.50
Date: |05/10/2005 Bill Bate [3963]: $244.00 8.00
Shift: RN GATEE f [ Time Sheet 0K Margin:| 30.33%

Abraham, I Fogers, L Start/End Time: |7:004AM = | | 230 PM [~ MoBreak
1 z00F-1ts0P ] 7] 30 Status: [Scheduled/Frm =
RN LD rd.

Confirmed with Employee: [~ 221 Bil M [~ Dant il
il Mo ant Bl

Confimed with Customer: [ B3| with: - Pay: Mo [ Don'tPay

=]

‘El Z00F - 1:30P El‘
Order

||:| 300F - maoP [ | Customer Order: [ Quantity: |1 | Ordered by: b
Order
Area: ~| Desired Skil: | | Twpe: | ]
Mote: | wi: [HOSP |
Filled On: [00/00/0000 By | _=| Bill Ta: [Chester County Hospital =]
[" Chage [ Same-Day Booking Patient: bt
‘ ‘ 1D Last Modified by: | O |
el & 75 [Karpeh, 1M1 0k |[€ cancel who's failable |
F] 1045k -7a8s [F] [F] wooF 4 @
El rder Ord.
Jordan, 1 T (Kelly, 5 s T
] nooF-gooa [F] [F] 1w045P-7308 [F] ] nooP-7a0s [F] ||Z| 100F - 7:304 |Z||
(25 Order RN-E |ED Order RN L&D Order LFN M Order RM
dordan, B T
Fl s -s00a ]
[Nk Ordar FN-E

Fieady |Regions: Off  |05/18/2005 11:22 A
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6. Copying a Shift

Copies the Contents of an existing shift to create a new shift for another date, shift type or Client.

The data that is copied is as follows:

1. The Employee (if any) of the selected shift.

2. The Confirmation Statuses.

3. The Order indicator.

The remaining information defaults as if this was a New Shift.

Copying of shifts can be done in one of two ways:

1. Right click on the shift you wish to copy and select Copy from the popup menu. The shift is now in the copy buffer.
Then Right click on the shift type where you wish to paste the copied shift.
A. Paste Add: Adds the shift after the last shift for this slot.

B. Paste Insert: Inserts the shift just before the shift located at the mouse pointer.

2. Click on the shift you wish to copy and, while holding down the right mouse button, drag-and-drop the shift to its desired
location.

-} microStaffer - Medical Staffing Agency
File Emplowvee Customer Yendor Staffing  Inwvoicing Pawroll Reports  Swskem EdiE Wiew User  Window Help

h = == ) ] By == B [ Y = 2 o

Employee  Awsilability  Contacts  Documents  Custamer  Staffing Orders  Invaicing Fagroll  Preferences  Feminders Notifications  Email  HelpTopics  Exit

-{ Staffing Sheet - Chester County Hospital Tuesday, May 10, 2005 through Monday, May 16, 2005

Custamer. |Chaster County Hospital ﬂ week Stamng:ﬂj 05102005 - Aﬂ\r"iew 7 - | Daps

Staffing Sheet 1 Calendar I General Info & Rates ] Options ] Travel ]
Tuesday | Wednesday | Thursday | Friday | Saturday | Sunday | Monday 5
05/10/2005 05/11/2005 05/12/2005 05/13/2005 05/14/2005 05/15/2005 05/16/2005

[Day 7-3:20] 700 30P
Samuel, & 5 [Karpeh, 1 5 [Karpeh, 1 75 [Abraham, M = [Zachau, P 75 [Rogers, 5 T [Zachau, P TS
Fl 7o0s-330F @] [F o0s-30F F ([F ro0s-30F @] (F] roos-zior F]F] oroos-z0r F]F] rona-3sr [F]F] 7oA -400F 7]
cu Order LPN IPEDE Order RN-E IPEDS Order RN-E Order R IED Order LPM JED Order LPM IED Order LPN
Karpeh, M1 TE Karpeh, M s Augustine, S TS
] 7ooa-zz0Pp ] [0 wooa-330F [ ] 7o0a-230F [F] F 7ooa-zzor ] O vooa-zzor [
PEDS Order FRN-E ICCU Order PEDS Order FM-E Ordar ED Order LPN

‘ ‘ ‘ ‘ ‘ ‘ [0 7o0s-z30F [
EC! LPT

Ordar

[Eve 8] Z00P-11:30F
Abraham, 1 Hogers.E o [Fiogers, s 75 [Rogers, 5 75 [Fogers, 5 75 [Davis, & s
F z00F-tt20F @] [F] sol Coom F A z0F-1zma ] [F] s nsr F] |[F]osor-nar F] F]osor-tnwor B[O soF -t [
RN L&D Order LPN L&D Order LPM L&D Qrder LPM L&D Qrdar LPM JED Ordar RN ED ardar LPN
Samuel, & 75 [Zachau, P 75 [Davis, & 75 [Pogers, 5 T
[0 zooP-1m30Fp [ F 3 Edit na0P [F] ] zoor-naor [F] F] x00P-12z0a [F] (O zo00r-nsor [
Order L&D e LFN IED Order FM L&D Ordar LPH IED Order LPN

Add Shift:

Copy all

’ Chappelle, N TS Chenars'c; ok
1 =00F-130F [ Insert Shift F] zo0F-naor [F] ] 2 -GDP [Ea]
Ordar Delete ED Qrdar RN JED Ordar RN-E
Zachau, P & |Augustine, 5 T
‘ ‘ DEIB“_BA" [ =zo0r-nz0P [F] [F] 300P-n30F [F]
Job Ticket 4 ED Oreler LFH Order
add Orderis). .. Johnzon, & TE (el L T
Fl zo0F-nz0r [F] ] a00F -naor [
s Ordar ) Ordar
‘ Samuel, & TS

Kelly, 5 T3 [Karpeh, M T8 [Samue 5 [Samuel, A 5 |Davis, & TS
[F] wsse-7Ea [F] [F] moor-7sss [F] [F] n Schedule vooa [F] [F] noor-7a0a [F] [F] noor-va0a [F]
ED Order RN M Order RM-E IL&D ler RN L&D Order LFM JED Order RM

wiho's fvailable, ..

F z00P-tooF [F]
[N COirder LN

-

Jardan, I 75 [Kelly. 5 TS 5 Kelly. S s
& 1tooF - s0s @] [F] 1R -0 F] Employse L | & 1oor -ra0a [
Mz Order RN-E |ED Order BN 13 LPM Mz Ordar RN
Jordan, M s
F] iti5p-z00a [F]
PAS Order FM-E

Copy the Selected Shift to the Clipboard |Regions: Off  |05/18/2005 11:24 &M
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7. Editing Shift Info

You can view and edit the information for a shift on the Staffing Sheet in one of two ways:
Right click on the desired shift cell and select the Edit option from the Sheet Popup Menu.
2. Double click on the desired shift cell.

In both cases the Shift Detail Window will open allowing you to view and modify the data for the selected shift.

MicroStaffer - Medical Staffing Apency

Filz= Employvee Customer vYendor Staffing  Inwoicing Payroll Reports  System  Edit View User  Window Help

i = bl s i g E— & it & i = ? 3

Emplopes  Avsilability  Gontacks  Documents stomer  Staffing Orders  Invicing  Payrell  Preferences  Feminders Mot

nz  Email  HelpTopics  Exit

«|Staffing Sheet - Chester County Hospital Tuesday, May 10, 2005 through Monday, May 16, 2005
Cuztomer: |Ehesler County Hozpital ﬂ Week Starting: ﬂﬂ,ml A >3 | Wiew: m Days
Staffing Sheet l Calendar l General Info & Rates l Options 1 Travel l
Tuesday | Y¥ednesday | Thursday | Friday | Saturday | Sunday | Monday | e

05/10/2005 05/11

Emﬁ;\ - E Em??h'ggl i General l Comments l Higtany l Invaice & Paprol l Call List l
[0 Oircler LFR IFEDS  Ord Enploves: FETTRETENET » Current Rates for this Shift
Karpeh, M g . — Type | Arnount Hours |
QDS"“WQ’;?:WP HE Ic:cl:u 7=°°S{; Customer. |Chesler County Hozpital ﬂ Pay Rate (52781, $170.00 3.50
‘ ‘ Date: |05/11/2005 - BEill B ate [3563): $244.00 8.00
Shift; |Day F-330.......[F:00 am - 330 pm] ﬂ v Time Shest OF targin: | 30.33%
Ebraham, 1 HUQEISIEL Start/End Time: | 7:004M | |3:30PM = |[ Mo Break
3007 - 11:20F 20l ,—_l
(Kl L Status: [ Scheduled/Fim -
Confirrned with Erploves: v B i .
1 zo00m-nz0F [ J Bil: ez [ Don'tBil
Crder Confimed with Customer. ™ B2| with [ w]  pay ves [ DontPay
‘D 200 - 30P [ ‘ Customer Order. W Quantib: [T w | Ordered by: | |
Ord.
= Ares [PEDS =] DesiedSkil [SUP =] Type: [RNE =]
Mote: | wi: [MURH -]
‘ ‘ Filed Orc [05/09/2005 By [Administrator - admin | Bill Ta: [Chester County Hospital | —
[ Charge | Same-Day Booking Patient: -
‘ ‘ ID:| 13954 Last Modfied by [dministrator O | 05/09/2005 11:11 &M

Kelly 5 75 [Karpeh, M oK | €3 Cancel Swha's Available |
Fl 1045k -7058 F] [F] ook - =4
El rde ETRIEE Ord,

O Order

Jordan, 1M s [Kelly. 5 L s

] mooe-zoos ] [F] nase-Fans ] [F] 100F - 7308 |Z|| ||Z| 00F - 7:308 [F]

ME Order RHN-E IED Order RN L&D Order LPN [NE3 Order RN
JJordan, 1 T3
F 5P - s00a [F]
NS Qrder RN-E

Ready |Regions: OF  |05/18/2005 11:26 AM
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B. Staffing & Scheduling - Shift Detail Information

1. Overview

105

The Shift Detail Window allows you to view and modify the data for a particular shift. This window is only accessible from the

Staffing Sheet or Calendar Window by Adding a New Shift of Editing Shift Info.
The Window contains five tabs to edit and display information about a shift:
General Info

Comments

History
Invoice & Payroll Info

Call List
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2. Shift General Info

The General Info tab on the Shift Detail Window allows for viewing and editing of key data for a shift on the Staffing Sheet.
1. Employee: Select the employee for this shift. Thisis NOT a required field since you could be entering an open order.
2. Client: Select the client from the dropdown where the shift will be worked.

3. Date: Enter the date of the shift.

4. Shift: Select the shift type. (Shift types are created on the Client Setup/Shifts tab).

5. Start and End Time: The start and ending times for this shift. These times will default to the starting and ending shift
times as defined on the Client Setup window’s Shift Setup Tab. However, you may modify these times as you wish
to within 4 hours prior to the start time and 8 hours past the end time of the shift as defined on the Client Setup
window’s Shift Setup Tab. (Both Required).

6. No Break: Check this box when a break was not taken. It will adjust the pay and bill rates to reflect the new payment
status. (Note; Arate must be setup to include an unpaid break period for this to have any effect).

7. Confirmed with Employee and Client: These two checkboxes indicate whether the shift has been confirmed with both
the employee and client. They are designed to allow a level of confirmation. Both must be checked for a shift to
become billable and payable. Clicking on the Email Icons will send a Confirmation Email to either Employee or
Client. (Reconfirmation is also available by clicking on either Confirmed hyperlink to access a reconfirmation area).

8. Status: Select a status from the status code dropdown for the shift. (Status Codes are created within the System
Setting & Utilities window.

@MicroStaffer Warning
A shift is not billable or payable until it is Confirmed with both Employee and Client and has a status that is
defined as billable & payable.

9. Employee/Client Notified: When the shift status is Employee Canceled or Client Canceled, this checkbox becomes
visible. It allows you to indicate that the canceled party has been notified of the cancellation.

10. Order: This checkbox indicates that the shift was an order.
ﬁ? MicroStaffer Tip

To enter unfilled or open orders, check this box and do not assign an employee. Then, when the order is filled, just
assign the employee and check the employee and client confirmation boxes.
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Shift Rates Info (Current Rates for this Shift): This list displays the shift rates for the shift. It calculates the
number of hours worked for billing and payroll purposes and multiplies the applicable billing and payroll rates respec-
tively. (Displays only when using purchased billing and/or payroll modules.) Clicking on the pay or bill rate allows
you to view the properties/amount of the rate and override the length of an unpaid break period if it is set up within
the original rate. (NOTE: To handle a “No Break” situation, you must check the No Break box on the Shift Detall
window).

Area: The area where the shift will be worked. (This may have been populated by entry of an order via processing
from the optional MicroStaffer web module, or manual order entry via PRN Order Entry. Not required but is an
optionalfilter in the “Who’s Available?” area). Areas are defined for each customer on the Client Setup Window’s
Areas Tab.

Desired Skill: Enter the desired skill for this shift. Primarily entered for orders. (This may have been populated by
entry of an order via processing from the optional MicroStaffer web module, or manual order entry via PRN Order
Entry. Not required but is an optional filter in the “Who'’s Available?” area).

Type: Enter the employee type. If an employee has been selected to staff this shift, this defaults to the employee
type as defined on the Employee Setup window but it can be changed. (This may have been populated by entry of
an order via processing from the optional MicroStaffer web module, or manual order entry via PRN Order Entry. Not
required but is an optional filter in the “Who’s Available?” area).

Note: Enter any notes associated with shift.

Work Code: A user defined work code as defined in the List Manager Window. This code can be used for a variety
of reporting purposes.

Charge & Same Day Booking: These fields indicate whether the employee took charge or if this was a same-day
booking. Once checked, Payroll and Billing will add Company wide Charge and Same-Day booking bonuses in
addition to Employee specific Charge and Same-Day booking bonuses. See Company setup for more information
on how Charge and Same-Day booking bonuses are applied.
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3. Shift Comments

The Comments Tab on the Shift Detail Window allows for viewing and editing of comments for the current shift.
Comments help in giving a more detailed description of any problem or requirements for a shift.
You may add new comments by clicking the Add Comment button.

Once a comment has been saved, it cannot be altered or deleted.
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4. Shift History

The Shift History Tab on the Shift Detail Window displays a list of attributes for the selected shift
Every time a shift is modified in any way, MicroStaffer writes the record to this list.

This enables you to view the shift every time a change was made on the General Info Tab, giving you an audit trail for shift
changes.
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5. Shift Invoice and Payroll Info

The Invoice and Payroll tab on the Shift Detail Window allows you to enter overpay, deduction and bonus pay amounts for a
given shift. Italso allows you to view the amount paid and billed for a shift that has been run through payroll and invoicing
respectively as well as the check and invoice numbers for the processed shift.

Data Entry Fields

Amount Overpaid: Enter any amount that was overpaid for the selected shift. Note: This field is only enabled if the
selected shift has been included on a payroll check. Entry of the overpaid amount here will allow for reconciliation
using the Advances & Deductions Report. Adding a Comment to the shift regarding this information is highly recom-
mended.

Deduction Amount: Enter any amount you wish to deduct from the shift pay rate for this check. This amount will be
deducted when this shift is run through payroll processing. Note: This field is only enabled if the selected shift has
NOT yet been processed through payroll. Entry of the deduction amount here will allow for reconciliation using the
Advances & Deductions Report. Adding a Comment to the shift regarding this information is highly recommended.

Bonus Pay: Enter any amount you wish to add to the regular rate for this shift. This amount will be added once the shift
is processed by payroll. Note: This field is only enabled if the selected shift has NOT yet gone through payroll
processing.

Custom Pay and Bill Amounts: You may override the pay and billing amounts here. These are the lowest levels that
can be set and will override any other rates in the system.

Custom Pay Start & End Times: Use these fields to override the regular payroll hours for this shift.

Custom Bill Start & End Times: Use these fields to override the regular billed hours for this shift. Note that both the
custom pay and bill times are useful when payroll and billing hours are different such as Pay 4, Bill 8.

Additional Payroll and Billing Items: Allows you to enter additional items for invoices and checks such as Travel
Reimbursements, Bonuses, Expense Reimbursements etc. These items will be included in payroll and invoice
processing and listed separately on the payroll check stub.

8. Mark as Advance: Allows you to tag shifts to be used in advance payroll processing. (On the Payroll Processing

window, you may select to “Process only shifts marked as Advance on the Shift Detail window”).

9. Check Note & Invoice Note: Used to print information on Custom Invoices and Payroll Export.

10. Skip for OT: Check the box if you wish this shift to be skipped for overtime (OT). Overtime can be skipped for a vareity

of selections from the dropdown: no, payroll only, billing only, payroll and billing.
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6. Call List

The Call List tab on the Shift Detail Window is used to store the names of employees that are likely candidates for filling a
particular shift. You may add names to this list and set the appropriate status of the employee.

The status is the reason or outcome code selected for the result of the call.

This will then allow you to see if the employee can still work or not.

Note: You also populate this list by Opening the ‘Who's Available’ window and dragging and dropping names from the ‘Who’s
Available’ List onto this Tab. For example, open the ‘Who'’s Available’ window, select one or more names and then, by
holding down the Left Mouse button, drag the selected names onto the Call List tab and, then, release the Left Mouse

button.
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C. Staffing & Scheduling - Shift Browser (Time Card Verification)

The Shift Browser is one of MicroStaffer's most powerful scheduling tools. It’s primary purpose is time card verification.
It allows you to add, modify and delete shifts in a grid like format.

To access the Shift Browser, select the Staffing->Shift Browser from the Main menu.

The Shift Browser’s window incorporates the following functions:

1. Query Criteria: The upper portion of the window lets you specify various fields on which to base the retrieval of the data.
This allows you to retrieve only those shifts that you wish to work on.

2. Results List: The shift results list is located below the query criteria box. It will display the retrieved shifts once the
Search has been performed. The results list functions as the data display and manipulation area for the Shift
Browser.

What makes the Shift Browser unique, is that it allows you to instantly modify shift data. Once you make a
modification on the list, the changes are instantly saved to the database. This allows for very fast and accurate
data manipulation.

Also, you can add, edit details and delete shifts. To do so, you may either right click on the Results List or select
the appropriate menu item from the window’s menu. Either menu offers the following options:

A. Edit: This will open the shift detail window allowing you to edit data that is not contained on the list itself.
You can also access this window by double clicking on the shift.
B. Add: This adds a row to the Results List. Only the shift date and Customer columns will be enabled. Once

you have selected a customer, the shift is saved and you many then proceed to change the remaining
information on the list. The shift is not saved until you select a customer.

Add Multi: Allows you to add more than one new row to the Results List.

Delete: Deletes the shift from the database.

Clear All: Clears the results list. Does NOT delete shifts from the database.

Sort: Opens a sort window that allows you to sort on multiple columns.

mmoo

3. Open Browse, Save Browse, Save Browse As...: These options allow you to save the query criteria and sort order.
This is useful if you intend to do repetitive browsing of shift data.
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D. Staffing & Scheduling - Availability Searches using “Who’s
Available”

The employee availability window allows users to search the MicroStaffer Availabilities database for available employees
based on a variety of optional filters.

This window can be accessed from a number of areas within the system such as:

1. Clicking on any Customer Quick Link and selecting ‘WWho's Available’ from the dropdown menu.
2. Right Clicking on any part of any staffing sheet or calendar and selecting ‘WWho's Available’ from the dropdown menu.
3. Clicking the ‘Who's Available’ button on the Shift Detail Window.

The window is divided into 4 separate tabs:

1. The Availabilities Tab displays a list of employees currently available based on the selected Filter Criteria.
a. Clicking on an Employees name brings up the Employee Quick link menu.
b. When this window is opened from the Shift Detail window, you can double click an employee and this will return
you to the Shift Detail window and fill in the Employee with the selected employee from this window.

2. The Work History Tab displays information of which employees have worked at the selected Facility over the time period
specified. Note that you can also display this information in graphical format by clicking on the graph icons.

3. The Incompatibilities Tab displays a list of employees that are not to be scheduled at the Selected Facility.

4. The Filters Tab allows you to enter a wide variety of filters that determine which availabilities are retrieved on the Avail-
abilities Tab. The following is a list of filters and their specific functions:

a. Date: The date for which to search for availabilities.

b. Shift Class: Matches shift classes which are defined when entering availabilities on the Employee Availability
Window.

c. Min. Hours: Matches Max. Hours which are defined when entering availabilities on the Employee Availability
Window.

d. Employee Type: Limits the retrieved availabilities to only those that match the selected Employee Type.
Selecting the List feature allows you to enter a comma separated list of Employee Type codes (eg. CNA,RN)

e. Work Area: Employees retrieved on the Availability tab must have worked at least one shift in the selected Work
Area. You may use the list feature to enter a comma separated list of Work Areas (eg. ICU,MICU,SICU,ER)

f. Desired Skill: Use this filter to retrieve only available employees who have the selected skill. You may use the
list feature to enter a comma separated list of Skills (eg. ER,SICU,PEDS)

g. Favorite Customer: This filter will retrieve only those employees who have the selected customer listed in their
Favorite Customer list on the Employee Profile.

h. Region: Use the filter to retrieve only those employees which match the selected Region(s) as defined on the
Employee Details window

i. Not Currently Working: Use this filter to remove any ‘Currently Working’ employees from the Open Availabilities
list. Note, you MUST define one or more statuses that are used in your system as Working Statuses.

j- Match by Licenses: Allows you to retrieve only those employees that have licenses of the selected Type and
State.

Properties:

The Properties button allows you to set default filter criteria. Using this window allows you to tell MicroStaffer which
filter criteria you wish have default from the Shift Detail window each time you open the Employee Availability
window.
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E. Staffing & Scheduling - Order Entry

1. Overview

MicroStaffer allows users to Create both Standard PRN orders and Long Term or Travel Orders. Standard PRN orders can be
entered using the Shift Detail window, or, by accessing the Standard Order entry window in MicroStaffer.

2. Standard PRN Orders

Standard PRN Orders are mostly entered on the MicroStaffer Order Entry window. This window can be accessed using
Hyperlink Quick Links from the Customer Setup, Staffing Sheet and a variety of other windows and reports.

To access the Standard PRN Order entry window from the main menu, select Staffing->PRN Order(s) from the Main menu.
The PRN Order entry window allows you to create one or more orders for one or more days. The following fields may be
entered:

Customer: Select the customer for whom the orders are to be generated

Shift: Selects the Shift Type based on the Customer selected.

Start and End Times: You may choose to accept the default or enter custom start and end times.

Area, Skill, Employee Type: Select as desired.

Note: Enter a comment or note.

WC: Custom work code.

Ordered by: Select who placed the order. (Information pulled from Contacts entered on Contacts & Directions tab of
customer setup.)

8. Days and Quantities: Indicate for which days and quantity for each day. This will determine how many orders are

generated for each day that falls within the range period.

NoaplrowwdNd=

-f Add News Orderjs)
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Shift: [Day 7-330___[7:00 am - 330 pm] =]
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Start Date: |05/19/2005 w| EndDate: |05/22/2005 | [ Range Order
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uantity for Monday..............

o
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o

uantity for Wednesdap........
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3. Travel and Long Term Orders

118

Long Term and Travel orders can be entered into MicroStaffer using the Long Term & Travel Order(s) window. To access this

window select Staffing->Long Term & Travel Order(s) from the Main menu.

Once this window opens, you may enter all the information for Long Term and Travel Orders. (Note: This stores the basic

administrative information for the long term order not the actual shift information. In order to generate the long term schedule

for the employee go to the Long Term Schedule generation found within the employee availability tab. Alternatively, the

information may be entered on the staffing sheet).

Once an employee name has been selected, the information will be stored on the Travel tab in the Employee setup area of

MicroStaffer.

To access existing Orders, click on the Search button. This will open the Order search window which allows you to find

existing orders based on the Search criteria you enter.
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F. Staffing & Scheduling - Staffing Center

1. Overview

The MicroStaffer Staffing Center window gives users a quick snapshot of critical scheduling and employee related info for the
currentday. The window can be accessed by selecting Staffing->Staffing Center from the main menu. You may also have the
window automatically open each time you log in by checking the ‘Display when Logging into MicroStaffer’ checkbox. To view
information for Employee Leads only, click on the box at the bottom of the screen.

2. Expirations

The expirations Tab displays a list of all Tickler enabled Profile and Custom info fields for Employees that have expired or are
nearing their target expirations dates. Highlight and right click to access a variety of options from email capability to mail
merge. Double clicking a single highlighted line will access the Employee Setup facility for editing.

3. Unfilled Orders

All open orders for the current day are displayed. Double clicking a highlighted order will access the Shift Detail window for
that order.

4. Open Availabilities

All open availabilities for the current day are displayed. If you check the ‘Suppress if Already Working’ checkbox, any
employee who is available but is already scheduled for this day, will NOT show up in the list. MicroStaffer will use the
specified Status(s) to determine what consitutes a Working shift both when this box is checked and when it is not. Right
click on the underlined employee to access various hyperlink capabilities.

5. Open Travel Orders

All open travel orders for the displayed period selected are displayed. Double clicking a highlighted order will access the
Travel Order window for the specific order.
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G. Employee Availability Tracking & Scheduling

1. Availability & Schedule Overview

120

The Availability & Schedule Window allows you to enter the days and Shift Class plus Comments for any day on which the
selected Employee would like to work and is available. You can also enter long term and permanent availabilities as well as

long term schedules for an employee.

To Access this window click on the Start Button select Employee Availability and Schedule from the menu item list.

Once the window is open you must select an employee and starting date from the dropdowns to view and edit the information

on these three tabs:
1. Availability Tab
2. Schedule Tab

3. Long Term Schedule Tab
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2. Employee Availability

The Employee Availability Tab on the Employee Availability and Schedule window allows for viewing and editing of dates, Shift
Classes and Maximum Hours of an employee’s availability. Employee availability MUST be entered in order to search using
the “Who's Available” feature.

Data Entry Fields

1. Shift Class: Select the Shift Class. If the individual is available for any type of shift then select ‘Any’. If not available at
all then select ‘Not Available’.

2. Max. Hours: Enter the maximum number of hours the employee can work or ‘Any’ if there is no limitation.

3. Note: Enter any description for the availability. For example, you could enter the preferred areas or customers where
this person would like to work.

4. Batch: You can enter long term availabilities using the Batch button located at the bottom of the window. This opens the
Batch Availability window. Here you can indicate a date range and the availability for each day of the week.

ﬁ?MicroStaffer Tip: If you wish to delete an employee’s availability, simply select the desired date range and set
each day’s availability to blank.

5. Always Available: Use this checkbox to indicate a permanent availability. Once checked, the employee’s availability
will NEVER expire. If a permanent schedule is entered, MicroStaffer adds an Availability Exceptions tab to the
choices so that exceptions to the permanent availability may be entered. Please see “Availability Exceptions”.
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3. Employee Schedule
The Employee Schedule tab on the Employee Availability and Schedule Window displays the staffing schedule for
an employee for a given time period.

It allows you to both view and edit this schedule in the same way as data is viewed and modified on the Staffing
Sheet and Calendar.

To display the employee’s availability on the schedule, the “Show Availability on Schedule” box must be checked.

Right click in the scehdule area to review other options for the schedule (email etc.) For more information on how
to manage data on this tab please view the help information on Staffing Sheet and Calendar Overview.
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4. Employee Long Term Schedule

The Employee Long Term Schedule tab on the Employee Availability and Schedule Window allows you to gener-

ate a Long-Term schedule for an employee. This is especially useful for scheduling employees on Travel Assign-
ments such as travelling nurses.

Simply enter a week’s shift assignments and the start and ending dates for the schedule. Then click the Generate
button to generate a recurring schedule for the desired period.

J\. MicroStaffer - Sample Medical Staffing Company
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5. Availability Exceptions

The Availability Exceptions tab appears when an exployee has a permanent availability entered on the Availability tab. This
tab allows for the entry of exceptions to permanent availability: either that the employee is unavailable when they are usually
available or the opposite, available when usually unavailable. The availabilities will appear on the employee schedule window
if the “Show availabilities on schedule” box is checked.
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H. The Job Finder Window

The Employee Job Finder window is intended to assist you in both matching an Employee to an Open Job Order as well as
give you a snapshot of an Employees Work History and Profile. The Job Finder window is located under the Employee menu
as well as other areas where its location would be pertinent. There are various places where the Job Finder window is
available as a hyperlink from an underlined employee name (when you see an underlined item, right click for hyperlink
capabilities).

The Job Finder window is especially useful in locating work for an Employee. Moreover, it serves as a quick way of retrieving
Employee Work history for your on-call staff as well as any newly hired staffers.

The window is divided into three tabs:

1) Work History
You can retrieve an employees work history using several view types and filter criteria:

a)
b)
c)

d)

View data by Customer worked, Work Area, Shift Type, Skill of Job Order

Use the Time Period filter to indicate the time frame on which to base the work history.

Worked Status defines which status your system considers a ‘Worked Shift. You can also use a list of status
numbers separated by commas (eg. 1,5,7...)

To view the data in Graph format simply click on the Graph Icons on the report.

2) Open Orders
This tab retrieves all open orders in the system that match the Filter Criteria indicated. If you wish to staff one of the
listed matched items, double click the order line to quickly access the Shift Detail window.

a)
b)

c)
d)

e)
f

Order Time period indicates the date range for which to retrieve any open orders.

Employee Type filter indicates which employee type an order must be to be retrieved. The employee type code will
always default to same as the selected employee.

Use the Omit Orders Status to Filter our Orders that have been cancelled.

Work history - This filter, when used, will only retrieve orders from Facilities at which the selected employee has
worked in the past. Again, use the status ID or Status ID list to indicate what a ‘Worked Shift’ is in your system.
Skills Filter - This filter will only retrieve orders where the skill code matches a skill code for the selected employee.
Work Areas Filter - This filter, when used, will only retrieve open orders when the Work Area of the Order matches a
Work Area worked by the selected Employee.

3) Profile
This tab gives you a profile of the Selected Employees Orientations, Incompatibilities (i.e. Places they cannot go or may
not go) and Preferred Facilities/WWork Locations. This profile information is taken from the employee setup facility.
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I. Managing Contacts in MicroStaffer

MicroStaffer’'s Contacts Manager interface allows you to enter unlimited contact records for Employees, Customers and
Vendors using the Contacts Windows. This window can be access from the Start Menu as well as any Quicklinks dropdown
menu. These Quicklinks are available throughout the system.

In order to add new contacts you must first define Contact Reason and Result types in the List Manager window.

Existing contacts for Employees, Customers and Vendors can be edited on the Employee Detail, Customer Detail and
Vendor Detail windows.

To review and report on all contacts within the system you can use the Contacts Report located in the Reports section of
MicroStaffer.

The following fields are on the Contacts Entry window:

1. Contact Type: Select whether this is an Employee, Customer or Vendor contact.

2. Reason: Enter a reason for the contact. (Contact “reason” codes are maintained in the List Manager facility)

3. Comments: Enter a short comment if necessary.

4. Outcome: Enter a result for the contact. (Contact “outcome” codes are maintained in the List Manager facility)
5. Date and Time Called

6. Misc. Notes: Enter detailed notes for the contact if necessary.

-§. MicroStaffer - Medical Staffing Agency

woidng  Payroll Reports System User Window Help
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V. Using MicroStaffer - Invoicing & Payroll Processing

A. Invoicing in MicroStaffer

1. Invoicing Overview

The Invoice Window allows for viewing, modifying and editing Invoice data.

128

To access the Invoice Window select Invoicing-> View & Edit Invoices from the Main Menu or click on the Invoicing toolbar.

The Invoice Window allows you to perform the following tasks:

Retrieve Existing Invoices
Create New Invoices

Edit Invoice Details

Print or Preview Invoices
Invoice Payments

Delete Invoices

Exporting Invoice Data

N ok~ wdh =
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2. Invoice Retrieval

You can retrieve Invoices from the Invoice Window.
Search Criteria Fields
1. Client: SelectAll or a specific Client whose invoices you wish to retrieve.

2, Invoice Number: Select All or a range of existing invoice numbers. This dropdown will be populated from entire
invoice register and is never filtered by what customer was selected.

3. Invoice Date: Select All or a range of dates. Arange of dates will include only invoices generated within the
specified date range.

-1\ MicroStaffer - Medical Staffing Agency

Fle Employee (Customer Yendor Staffing Inveicing Payroll Reports System User Window Help
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20444 Mayo Clinic: of Philadelphia $210.00 04/29/2005 pEEEEEE
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3. Creating New Invoices

To create New Invoices, open the Invoice Window and click on the New button or select New from the menu and the
New Invoices Window will open allowing you to create new invoices.

The New Invoices Window allows for creating of new invoices from unbilled shifts that have been scheduled for the
specified criteria and are Billable.

The following steps outline the New Invoice Creation process:

Specify Invoice Filter Criteria:

A. Client: SelectAll or a specific Client for which to generate Invoices.

B. Employee: SelectAll or specify which employee to generate invoices for.

C. Shift Start and End Dates: Specify the starting and ending dates for shifts to include on
invoices.

D. Starting Invoice Number: Specify the starting invoice number for new invoices. You must
ensure that invoice numbers remain unique in the system even though MicroStaffer will not
allow duplicate invoice numbers. This number will automatically increment after every new
invoice generation.

E. Additional Filter: Shift, Area, Skill, Employee Type. Use the ‘List’ feature by entering Comma-Separated Area

codes, Skills, Employee Types and Status ID numbers.

Previewing Invoices:
Before you actually create invoices, you may click on the Preview button to see what invoices will be generated
given the filter criteria you entered. This is a useful tool to make sure you have entered the information correctly.

Generate Invoices:

To generate and save invoices to the database, simply click the Generate button. The New Invoice window will close
and the newly generated invoices will appear on the main invoice window’s invoice list from where they then can be
printed.

.4 =]

ah = = &> E EE & &= Y = 2 B
ocumsnte  Cictomer  Staffn mdore Notifcations it
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4. Invoice Editing

To edit invoice data on existing invoices, you must first retrieve the desired invoice using the Details button on the Invoice
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Window.

After retrieving the invoice and then clicking on the Details button, the Invoice Detail window will open and allow you to do the
following:

1. Delete Invoice Line Item: The delete button will delete the line item (or shift) from the invoice.

Note: Once you delete a line item, the shift will again be available for invoicing. Also, once you
have deleted all items, the entire invoice will be deleted.

2, Edit Invoice Data: You may edit any information in the editable fields.
3. Export Invoice Data: Allows you to export the line items for the selected invoice to various data
file formats.
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5. Invoice Printing

To print or preview existing invoices, you must first retrieve the desired invoices using the Invoice Window.

When you click on the Invoice Print or Print Preview buttons all invoices in the invoice list will be printed or preview respec-

tively.

MicroStaffer - Medical Staffing Agency.

File Employse Customer Yendor Staffing Inwoidng Payrol Reports System User MWindow Help
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6. Publish Invoice to Web Module (Web enabled systems only)

MicroStaffer provides those systems enabled with the optional Web Module to publish invoices to the web for client
access.

Web module access is set up for the client on the Client Setup screen.
After new invoices have been generated, simply click the Web button to publish the invoices to the Web module.

To remove an invoice or group of invoices from the web module, first bring up the invoices to be removed, check the
Remove box and click the Web button. This will remove the invoice(s) from the published web list.
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7. Invoice Payments

You may enter payments for invoices using the Invoice Payments window. This window can be accessed from the main

Invoice Window.

After selecting the desired invoice, then clicking on the Payments button, the Invoice Payments window will open allowing
you to enter one or more payments for the selected invoice.

Alternatively, payments to invoices may be maintained via a back office accounting system.
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8. Invoice Deleting

To delete an entire invoice, you must first retrieve the desired invoice using the Invoice Window. Then select the desired
invoice and click on the Delete button or select Delete from the menu.

Deleting an invoice will reset the ‘Invoiced’ status of the shifts associated with the invoice allowing them to be invoiced again.
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9. Invoice Exporting

You may export both Summary and Detailed invoice information using the Invoice Window.

After retrieving the desired Invoice(s) you can click the Export button which will allow you to save either summary or detailed

invoice data.

To save summary data you must have the Summary Tab selected. For detailed data, select the Detail Tab.

First time export, it is highly recommended that you attempt the export with one invoice to be sure the export feature is set

up properly.
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B. Payroll Processing in MicroStaffer
1. Payroll Overview

The Payroll Window allows for viewing, modifying and editing Payroll data.
To access the select Payroll->View & Edit Payroll from the Main Menu or click on the Payroll Toolbar item.
The Payroll Window allows you to perform the following tasks:

Retrieve Existing Payroll Checks

Create New Payroll Checks

Edit Payroll Check Data

Print Checks and Check Stubs

Delete Payroll Checks

Export Payroll Data to external Systems

Process W2'’s for Export to Accountability Tax Processing Software
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2. Payroll Retrieval

You can retrieve Payroll Check entries from the Payroll Window.
Search Criteria Fields

1. Employee: Select All or a specific Employee whose payroll checks you wish to retrieve.
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2. Check Number: Select All or a range of existing check numbers. This dropdown will be populated from the entire check

register and is never filtered by what employee was selected.

3. Check Date: Select All or a range of dates. Arange of dates will include only checks generated within the specified date

range.

4. Check Type: Select the Types of checks to view (Standard, Advance or Advance Payoff).
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3. New Payroll Checks

To create New Payroll Checks, open the Payroll Window and click on the New button or select New from the menu and the
New Payroll Wizard Window will open allowing you to create new Payroll Checks.

The New Payroll Wizard Window allows for creating of new Payroll Checks from unpaid shifts that have been scheduled for
the specified criteria and qualify as Payable. Payable shifts must have a Status that is checked as Payable and be double-
confirmed. They must also NOT have been paid yet.

The following steps outline the New Payroll Check generation process:

1.

Select the Payroll Processing Method:

A.
B.

Standard Payroll: Generates Standard checks based on shift data.

Advance Checks: This method of payroll processing allows you to generate checks that pay only a portion
of the amount earned. This amount can be specified on the following tab should this Payroll Method be
selected. You may also enter a percentage or amount on the individual employee’s record on the Employee
Setup Window’s payroll tab.

Advance Payoff Checks: This method pays any remaining balance on Advance Checks, thereby complet-
ing the payroll cycle.

Select Advance Calculation Method (Advance checks Only)

A.

C.

You may choose to enter a percentage or maximum amount. Note, that Employee specific Percentages or
Amounts will override these.

If MicroStaffer tax library is installed you may also choose the Net-To-Gross-Ratio method. This method will
use the Tax Withholding information for a given employee to advance the maximum amount based on the
taxes that would be deducted for a regular check. Using this method will always advance the most $$$ per
check.

Specify Check Filter Criteria:

m oowp

@m

Employee: Select All or specify which employee to generate Payroll Checks for.

Customer: Select All or a specific Customer for which to generate Payroll Checks.

Shift Start and End Dates: Specify the starting and ending dates for shifts to include on Payroll Checks.
Payroll Type: This field will allow you to include only those employees that have their payroll period set to
the one you select here. You may, of course, select All.

Starting Check Number: Specify the starting check number for new Payroll Checks. You must ensure
that check numbers remain unique in the system even though MicroStaffer will not allow duplicate check
numbers. This number will automatically increment after every new check generation.

Check Date: Enter the check date. This will always default to the current date.

Separate checks for Each Shift (Standard and Advance Checks only): This option will generate a separate
check for each shift instead of grouping them by Employee.

Pay off Advance Checks: When this box is checked, any outstanding advances will be paid off on any new
checks that are generated.

Previewing Payroll Checks:
Before you actually create Payroll Checks, the Preview tab allows you to see what Payroll Checks will be generated
given the filter criteria you entered. This is a useful tool to make sure you have entered the information correctly.

Generate Payroll Checks:
To generate and save Payroll Checks to the database simply click the Finish button. The New Payroll window will
close and the newly generated Payroll Checks will appear on the main payroll window’s checklist from where they
then can be viewed, edited, exported or printed.
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4. Payroll Check Editing
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To edit payroll data on existing payroll entries, you must first retrieve the desired payroll checks using the Details button on

the Payroll Window.

After retrieving the check and then clicking on the Details button, the Payroll Detail window will open and allow you to do the

following:

1.

Delete Check Line Iltem: The delete button will delete the line item (or shift) from the check.

Note: Once you delete a line item, the shift will again be available for payroll. Also, once you have
deleted all items, the entire check will be deleted.

Edit Payroll Item Data: You may edit any information in the editable fields.

Export Payroll Data: Allows you to export the line items for the selected check to various data file formats.

= 1=]

i @

Employes  Avsilsbilty  Contucks  Documents

:|3enelal I Dretails ] Tares I

Check Ne: |
Check Date: | 05/10/2005
Gross: | 2586.50

Pay Period Start: [05/17/2005

201897 Tupe: |

End:

HelpTopics  Exit

Standard Issued Te: [&braham, Mary &nn

Soe. Sec. Mo | 071-86-6123
Mon Tax Fay: oo 10 45

05/23/2008

Diate Amount
4200

201897 5/18/200

201297 5/19/200

201897 5/20/200

201297 5/23/200

201837 5/21/200

Hours Custarner
8.00 Chester County Hospital
B.00 Chester Courty Hospital
8.00 Chester County Hospital
B.00 Chester Caunty Hospital
8.00 Chester County Haospital

12.00 Chester County Hospital

Day 7-2:30
Day 7-3:30
Day 7330
Day 12

Last Modified by: | Administrator

Or: [i5/10/2005 1:51 PM

& Delste

.~ OK | 3 Cancel |

%@ Help

Fleady

|[Regions: Off

[05/23/2005 3:44 AM
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5. Payroll Checks and Stubs

MicroStaffer allows you to print checks and stubs for every check you generate. Stubs can be included with the employee’s
paycheck to give a detailed explanation of earnings.

You can print checks and stubs by retrieving the desired checks on the Payroll window, then selecting the Stubs or Checks
tab and then clicking on the Print button or selecting Print from the menu.

Finally, you may also add a Note during printing on both Stubs and Checks. This note will only appear on the printed stub.

To align checks for printing, use the ‘Properties’ button to modify the X and Y coordinates of items on each check.

-1 MicroStaffer - Medical Staffing Agency.

File Employee Customer Yendor Staffing Invoicng Payrol Reports System  Ukiities User indow Help

Y Lo i < i By EEE & B iEd] Iy = ? me

Employes  Awsllability  Contacts  Documentz  Customer  Stoffing  Orderz  Inveicing  Paroll  Preferences  Reminders Motificstionz  Emsil  HelpTopicz  Exit

-3 Payroll
Search Criteria
Filter

@ Search

Employes......oooooe |7

Check Number. ..o |77 A1 k3|
Check Date [Range <] [O5/miva00s w| [05/232005 -]
Check Type: [ == |

i Mew

Summaly] Details  Stubs lChecks}

Check Ho: 201394 Hame: Sharon Rogers
Gross Pay:  §3,304.50 Het Pay:  §2,120.59 Date: 05052005

Date OT Pay Bonus Pay | Deduct Amt.

12750 |

Earnings | |Hours | Rate

0442512005 | $225.00 | | $a000 |
4252005 | $240.00 | $3000 |
D4:27/2005 | $a3gz.50 | $3000 |
04/27r2005 | $240.00 | $3000 |
042812005 | $360.00 | $3000 |
| |
| |
\ \
| |

|

|

|

| $12000 |

0442612005 $405.00 | | $30.00

|

|

|

|

$135.00 |
0472812005 $254.00 | $33.00
$420.75 | §33.00
$396.00 | $33.00

@274 oz | @23 nn

0472972005
0453072005

A mnenne

$140.25 |
$132.00 |

aiam s |

<
Print Mote: |

Ready |Regions: Of  |05/23/2005 9:46 &M
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6. Payroll Check Deleting

To delete an entire payroll check, you must first retrieve the desired check using the Payroll Window Then select the desired
check and click on the Delete button or select Delete from the menu.

EEE
EEE

Invaicing

&

Payrall

N

Diccuments

==

Seaffing Orders

2] & Ay

Preferences  Reminders

= ks

Email  HelpTopics

g

Exit

»
Ak
Emploee  Avsikbilty  Contaces Custamer Harifications

Search Criteria

Filter

| Select [

Employee..........

Check Mumber..

Check Type

Check Date..o.oens

N - ﬂ

A = | =

~| |osmis2008 -] [05/23/20058 ~|

= |

[Frange
[

@ Search

N Hew

&} Cloze

Summary | Detaits | Stubs | Checks

Chack Mo

20130
201902
201898
201899
201300
201894
201895
201896

Check Date

05/11/2005 Abraham,
05/11/2005 Abrsham,
05/10/2005 Adeleke

MicroStaffer - Medical Staffing Agency

H?.) Are you sure you wank ko Permanently Delete the Check Mo 201897 7 |8

Mo

05102005 Auqusting
05/11/2005
05/05/2005
05/05/2005
05/05/2005

ToatEn
Augustine, K.aren
Hogers, Sharon
Bogers, Sharon
Roagers, Sharon

fsis 0 s T2 o0 2o
233-36-5321 $863.75
898-83-0544 §3.304.50
838-03-0544 $2.174.00
895-89-0544 $1.111.25

Total: $17.186.79

TFoa3 00T
$2239.000
[$829.00)
[$433.00)
[$203.000
(33.441.00)

Trao.r2)

$52.93]
[$204.88)
[$134.79)
[$68.90]

Medicare M

($10.21)
($25.41)

($919.87) (3$215.13)

Ready

|Regions: Off

() Details
m Ezport
& Fiint

[05/23/2005 .47 AM
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7. Payroll Exporting

You may export both Summary and Detailed payroll information using the Payroll Window.

After retrieving the desired Check(s) you can click the Export button which will allow you to save either summary or detailed
payroll data.

To save summary data you must have the Summary Tab selected. For detailed data, select the Detail Tab.

You can also export payroll information to External Systems such as Quickbooks, Peachtree, Business Works etc.

2 B

Staffing Orderz

Search Criteria
Filter |

@ Search

Employee
N Mew

Check Number......cc....ccooeeenes

Check Date N} Chose

Check Type ... SR S A0 R 1

Summary 1 Dalal\s} Stubs
Export Type:[4. Quickbooks®

EHEEEGN 4_Cluick = icare M) w
[ 5| 5. Peachtree® Payroll Export [EEGN | # poee
E. Business Works® Export [After Tax GL) =
201301 05/11/2005 7. Peachtiee® Payroll using DDE 10.21)
201302 05/11/2005 8. ADPE Pagrol Export ) 25.41) e
9. Bw ceess@ Export (Pre-Tax Timecard) _
201898 05/10/2005 0B\ Sccess® Export (fter Tax & Bt
201899 05/10/2005 34.08]
201900 05/11/2005 Augustine, Karen 299965381 $853.75 [$229.00  [($52.93)
201834 05/05/2005 Roders, Sharon 598830544 $3,304.50 [$829.00]  ($204.88)
201895  05/05/2005 Rogers, Shaion 895830544 $2.174.00 [$493.00)  ($134.79)
201896 05/05/2005 Roders, Sharon 598830544 $1.111.25 [$203.00]  [$58.90)
Total: $17.186.75 ($3.441.00) ($919.87) ($215.13)

Ready |Regions: Off  |05/23/2005 3:48 AM
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VI. Using MicroStaffer - Reports & Queries

A. Query Manager & Report Engine Overview

The MicroStaffer report engine allows you to retrieve data stored within the system using a user driven report engine.

The report engine offers a consistent means at which to retrieve, view, print and export mission critical staffing and financial
information.

MicroStaffer Report Engine Features:

1. User Defined Filter Criteria: Located at the top of all report windows, this area allows you to specify what data to
include in your report.

2 Results and Preview Tabs: These tabs display the retrieved data. The results tab displays raw data, the preview
tab displays data in Print Preview Mode.

3. Options Tab: Some reports feature an Options tab. This tab is used to select such things as which columns to
display as well as summary or detail report formats. Please refer to this often!

4. Sorting: All report data can be sorted by clicking on the column headers on the Results tab.

5. Exporting: All data can be exported to various file formats by clicking on the Export button or selecting Export from
the menu.

6. Saving Reports: You may save all settings for a report including query criteria, formats and display columns. This

can be done using the Report menu option. You can also share your reports with other users.

-} MicroStafter - Sample Medical Sta 2=l
File Employee Facilty Staffing Invoicing  Pawol Reports Swstem View Report User ‘Window Help

oo | mEBEES | B = 2 0

-} Employee List Report - NURSE LIS =0l x|
Tkt T Select T From T To 1 — [ Semrch
License: [ &= =l [=ar=" ][ oomom0  [Too/nsoa | = Bt
Insurance Policy. [ A= | [*ar=" -] [ oo [Too/o0on | —
CEMfiEation. ... cnerveees [ &= ~| [~ ~][ obo0m0 [ oo/ona0 | et |
Health Screening. | Al | [ ] = -1 nnnnnn - [ onsonsnn T = Print
Annual Beview [ A= -f\ Opsn Report
[ 2=
o Repart Mame Created by Shared i s OK
Administrator Ho —
€3 Cancel
Results |mens| Preview | -
& Delete | =
Last Marme First Man =] |Desc.  Incompatibilities ]7
Allegood Charles Alaska Regional Hospite
Comptan Tim Jewish Hospital
Conley David ]
Harris Jeft
Hemandsz Thomas
Farker Feleshia ™ Display Sharsd Reparts
Parker william ber
Parker Jopce 3051 Sikverchase Re Kennesaw ™ 84537 875984-4587  Home
Parkirsan Seott 2170 Dream Park Re Deliay Beach FL 335547 954 897-8974  Home
Feese Tyrone 3246 Woodview D New ‘fork N 3795458745 Home
Resves Hetb 1103 Canton RD SE Anchorage 2K 87459 8746831239 Home
Smith Samuel 126WwestLane  AptE Marywe ather IL 577521 7058552365 Home Jewish Hospital
Thointon Margarita 30 Westland Ave Warren MO 435345 379546-3975  Home
Thrash Michasl 2300 Benson Pooler WWarren ] 480981 4588459875 Home Grady Health Spstem
Ussery Thomas 22547 Duck Street Detroit ] 789458 879894-8345  Home
“asa Clint 3309 Woodin Drive Louisville KY 12545 459 863-5879  Home
asquez Miquel 5894 Bells Farry Rd Philadelphia PA. 02548 7845465846 Home
i ey 4308 P L ps— ma e o ama AETE L T —— _>l;|

|Ready 037212002 10:13 PM
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B. Queries & Reports
1. Employee Listing Report

This report is used to retrieve lists of employees.
Various query criteria can be entered including Custom Data Fields.
The available report formats are list, profile and credentials.

Highlight items and right click the mouse to view report options which include email capabilities, label printing and mail
merge.

icroStaffer - Sample Medical Staffing Company

File Employes Facity Staffing Invoicing Payol Bspots Spstem View Repot User Window Help

lae=e | bER®HES BE =|2 |8

. Employee List Report =] 3
Filter [ Select [ From [ To [ =] | & Search
License. . [ Al ] [==an= ~][ 00/00/00 [ 00/00/00 | 7 Reset
Insurance Policy. [ Al e x| [==an= ][ 00/00/00 [ 00400700 | ==
Certific.ation [ Al e x| [==an= ][ 00/00/00 [ 00400700 | EEL”"
Health & creening [ Al e | [==an= ][ 00/00/00 [ 00400700 | = Print
Annual Review [ sl = | [=ar= ~|[ 00/00/00 [ 00/00/00 | 4| Son
Status. lm By Filter
Skl [l == B2l _ K} Liose |
Results |Elp|mns| Prevlewl
=
Last Name First Mame Address Address? City State Zip Phane 1 Phaone 1 Desc. Incompatibilities ,7
Allegood Charles 146 Lakeside Dr Atlanta GA 404 8345934 Home Alaska Regional Hospits
Compton Tim 321 Hospital Lane Dervver MY 784 895-4587  Home Jewish Hozpital
Conley David 1507 Barkly Drive Bryson City NC 28713 8738735486 Home |
Harris Jelf 2543 Ridgecrest Dr Lauigville K F4624 7996548791 Haome
Hermandez Tharmas 3635 Harmony Lane Burnsville (&1 45873 7894565469 Hame
Parker Feleshia 2285 Precilla Drive Laz Wegas M 55897 874-858-9696  Hame
Parker il 3418V andiver Dr Marietta GA 30078 6785558745  Home MNumber
Parker Joyce 3057 Silverchase Rc Kennesaw TH 84597 875 984-4587  Home
Parkinson Scatt 2170 Dream Park R Delray Beach FL 335547 954 B97-8974  Home
Feese Tyrane 3246 woodview Dr Mew Yark M 879548-8745  Haome
FReeves Herb 1103 Canton RD SE Anchorage K 87453 87468912318 Haome
Smith Sarnuel 126 West Lane Apt B Mamweather IL B77E21 705-855-2365  Hame Jewish Hospital
Tharntan targarita 30Westland Ave waren 1] 435345 879 546-8975  Home
Thrash Michael 2300 Benzon Poolen Waren Ml 480981 455 8459575 Home Grady Health Systern
Uszery Tharnas 22547 Duck Street Detrait M1 789458 879894-8945  Haome
Yaza Clint 3309 oodlin Drive Lowisville K 12546 459 8635579 Home
Wasquez Miquel 5834 Bells Ferry Rid Philadzlphia P& 02548 784 546-5846  Haome
g e GG P o L p— CYSCETITS o1 4Ra 457 b s _>l;|

|Ready |03/21./2002 10:18 PR
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2. Work Summary Report
This report allows you to retrieve work history data. It gives you the ability to answer the question of ‘Who worked Where
and When'?

This report is extremely useful when trying to fill orders or obtaining an instant glimpse into an employees work history. Itis
also ideal for monitoring overtime.

For example, assume a Client calls with an order for a specific Work Area. Use this report to input a date range, Work Area
and the selected customer and instantly view which employees worked for this client.

There are three report type options on the options tab:
1. Employee and Client: Displays hours, shift counts etc. by Employee and Client

2, Employee Only: Displays hours, shift counts totals by employee regardless of where the
employee worked. i.e. Employee Totals.

3. Client Only: Displays hours, shift counts etc. totals by client.

I’ MicroStaffer - Sample Medical Staffing Company

File Employee Facility Staffing  Invoicing Pawall Reports  Spstem  Wiew Heport Uszer Window Help

a2 BEF=S B 2o 2| B
. Work Summary Report _[O]x]
Filter | Select | From | To | | =
Employee [ e = il = Besel
" YD = = |
;aaiilty et e e :Hange ;I I”m - ZII Iyzwoz ;I % Evport
FT TR - =l [ o ﬂ
Canfirmation Status............... |~ & x| Faoility: r Employee - 8l Sot |
Order Status Im B3 Eiter
Paid/lrvoiced Status............. |4l > - —ﬁgluse

Results |Elpt|uns| F'rawewl

Employee Last Mamme Employee First Mame Facility M ame Shift Count Hours 'Worked 1
Thrash Michael Jewish Hozpital 03/21/02 21 157.50
Thornton Margarita Jewish Hozpital 03M17/02 4 30.00
Grady Health System 02/21/02 7
Atlantic Medical Center 03/21/02 28
Parker “illiam Atlantic Medical Center 03/21/02 18 120,00
Wasquez Miquel Atlantic Medical Center 02/23/02 1 7.50
Harris Jeff Atlantic Medical Center 03/18/02 1 T.50
Alaska Regional Hozpital 03419702 22
Comptan Tim Alaska Regional Hozpital 02/25/02 4 30,00
Conley Diavid Alaska Regional Hospital 02/22/02 4 34.00 .
Allegood Charles Alaska Regional Hospital 02/27/02 4 30.00
Harris Jeff Alaska Regional Hospital 02/23/02 1 7.50
Thrash tichael Alaska Regional Hospital 03/20/02 13 97.50
Reese Tyrone Alaska Regional Hospital 03/15/02 7 5260
Wasquez Miquel Alaska Regional Hospital 03/21/02 4 30,00
Avlington Memorial Hospital 03/21/02 45
Waza Clint Avlington Memarial Hospital 03/21/02 21 158.00
Allegoad Charles Avlington Memarial Hospital 02/25/02 1 7.50 LI

[Ready [na/21/2002 10:21 PM
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3. Shift Status Report

The Shift Status Report retrieves information on shifts that have been entered into the system. The query criteria portion of
this report allows you to retrieve existing bookings based upon key elements that are associated with shifts, checks and
invoices.

For example, this report could be used for the following purposes:

1. Confirmed shifts.

2. Canceled shifts that require either the employee or customer to be notified of the cancellation.

3. Unfilled orders. Select ‘Not Filled’ under Employee Name.

4. Shifts that require confirmation.

5. Shifts that have not been paid or billed. Shifts that have been paid and not billed or billed and not paid.

6. The reportincludes hyperlink capabilities to client and employee data by clicking on underlined item and selecting the
hyperlink from the list.

i’ MicroStaffer - Sample Medical Staffing Company

File Employee Facilty Staffing Invoicing Pawoll Beports Swstem “iew Report User 'Window Help

laete MEOFEE [ BE =2 &
f Shilt Status Report _ (O] %]
Filter | Select | From | To | | =
Employee. ..o I*“AII £ ;I il T Resel
FACH. eoers oo oo |mA" - =1 EET
LT =1 = | -
Status [ e = — S Print |
Confirnation Status. Iw All = >| Facility: r Employee: Il ;LL
Titne Shest..... [ar=""1+] B Fiter
Dider Status.......oooovvvvoeennae == ALL i - E (s

Results I Dptinnsl Pleviewl

Facility Mame Shift Date  Employes Last Name  Employes First Shift Name Actual Stat ActualEnd  Conf. With  Conf. With Statuz Orde =
Name Emplayee Facility

Jewizh Hogpital 02/16/02 Day 7:00 AM I00PM [ ] Scheduled/Fim ez
Jewish Hozpital 02/20/02 A, 7:00 AM FO0PM [ O Scheduled/Firm  es
Grady Health System 02/15/02 Day 700 AM 300PM [ O Scheduled/Firm

Grady Health System 02/19/02 Day 7:00 AM F00PM [ O Scheduled/Firm

Jewizh Hospital 02/15/02 Evening 300 PM 1100rM [ O Scheduled/Fim  es
Jewish Hozpital 0zA18/02 Might 11:00 PM 7o08M [ N Scheduled/Firm  res
Grady Health System 02:17/02 Evening 300 PM 1100rM [ O Scheduled/Firm

Grady Health Systern 02417/02 Might 11:00 PM 7ooaM [ 1 Scheduled/Firm

Grady Health System 02/21/02 Day 7:00 AM Z00PM [ O Scheduled/Firm

Grady Health Systern 02/15/02 Day 7:00 AM 0P [ 1 Scheduled/Firm  Yes
Grady Health System 02/15/02 Day 7:00 AM F00PM [ O Scheduled/Firm  es
Alaska Regional Hozpital 02417/02 Day 7:00 AM 0P [ 1 Scheduled/Firm  Yes
Alaska Regional Hospital 02/18/02 Conley David Day 7:00 AM 3:00 PM Scheduled/Firm  es
Albert Einstein Medical Center 02/18/02 Ewvening F00PM 11:00PH [ ] Scheduled/Firm  Yes
Alaska Regional Hospital 02/20/02 Conley David Day 7:00 AM 3:00 PM Scheduled/Firm  es
Alaska Regional Hospital 02/20/02 Day 700 AM 300PM [ O Scheduled/Fim  es
Alaska Regional Hospital 02/22/02  Alegood Charles Day 7:00 AM 3:00 PM Scheduled/Firm "r'e:lll
4| | »

[Ready [na/21/2002 10:23 PM
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4. Employee Availability Report

The Employee Availability Report retrieves data that was entered into the Employee Availability’s Window.

By highlighting items on the list and right clicking the mouse, you may view profiles, print to PDF writer, and email the
results.

;' MicroStaffer - Sample Medical Staffing Company

File Employee Facilty Staffing Inwoicing Paproll Bepaorts Spstern Wiew Report User ‘Window Help
lawsxte DEOE®ES BP o 2| B

;" Employee Availability Report

Filter | Select | From | To =
Employee. [ i = il o —
Shift Class.....ooveeee e |“‘AII o = EET
Shift Date...oovveeeveee e |F!ange =l |3/21J02 =1 |3/21,f02 =1 __—
Employee Type.......o.occoovene |“*AII o =1 &
Desited Skil [=ar=— =] [ = 4l Sot
Favarite Facilty. ..o [ B =] Min Ranking |An—;[ B Eiler
Mat already Scheduled........... m = E Cloze

Results |Dpt\ons| Pleviewl

Avgila[bilitp Shift Type Employee Last Name  Emplapee First Emp\ope1e Phane  Employee Phone 1 Status Booked At Mote
ate:
I

03/21/02  Any Shift Parker ‘william E78 B55-8745 Home Number Scheduled/Booked | Atlantic Medical Center|

03/21/02  Any Shift Parker Jopce 875 984-4587 Home Available

03/21/02 |\ &ny Shift Reeves Heib 874 6891234 Home Available

03/21/02 |\ &ny Shift Parker Feleshia 974-858-9698 Home Available

03/21/02 | Any Shift Parkinzon Scoatt 954 897-8974 Hoame Levailable

03/21/02 | Any Shift Thrash Michael 458 845-9875 Hoame Scheduled/Booked  Jewish Hospital .. 3:00 F

03/21/02 | Any Shift Uszzem Tharnas 879 894-8945 Hoame Scheduled/Booked  Atlanta Medical Center,

03/21/02  Any Shift ‘wiard Gregory 954 453-4575 Horme: Avwailable

03/21/02  Any Shift Reese Tyrane 879 548-8745 Horme: Avwailable

03/21/02  Any Shift Wasquez tiquel 784 546-5846 Home Available Alaska Regional Hospit

03/21/02 |\ &ny Shift Vasa Clint 459 BES-B87I Home Scheduled/Booked  Arlington kemorial Hos

03/21/02 |\ &ny Shift Conley David 979 879-6486 Home Available

03/21/02 | Any Shift Carnpton Tim 784 895-4587 Hoame Levailable

03/21/02 | Any Shift Allegood Charles 404 594-5954 Hoame Levailable

03/21/02 | Any Shift Hernandez Tharnas 789 456-5469 Hoame Levailable

03/21/02  Any Shift Harris Jeff 789 B54-8794 Horme: Avwailable

[Ready [3/21 /2002 10:23 Ph
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5. Client Listing Report

The Client Listing Report allows you to retrieve selected data for one or more Clients.

149

The Options Tab allows you to specify alternate report formats including: Standard Listing, Contacts Listing and Comments

Listing.

Highlight and right click with the mouse to access a variety of functions for the report results which include email and mail

merge.

croStaffer - Sample Medical Staffing Company

E Close |

Results |Dpliuns| F'reviewl

B
Eile Employee Customer Staffing Invoicing Pawoll Beports  Swstem Yiew Heport User Window Help
laese REFES | BRARL= 2 0
.. Customer List Report =] E3
Filter T Select T From T To ]
Statu s | ~
(LTI R Y =1 —
Export
Riegion [~ &= = I IS |
= Prnt
&| Sort
B Filer

Mame Address
i

Grady Health System 80 Butler 5t 5E
Desert Spring Hospital 2075 E Flamingo Rd
University Medical Center 1800 Charleston Bled
Los Angeles Community Hospital 4051 E. Olpmpic Bled
UCLA Medical Center 10833 LE Conte Ave
Cedars Medical Center 1400 N/ 12 Ave
Fairview Ridge Hospital 201 Micollet Blvd.
Califarnia Hozpital Medical Cente 14071 5. Grand Ave
Alantic Medical Center 400 M. Clyde Morris Bhed
Castle Medical Center 640 Ulukahiki St.
Alaska Regional Hospital 2801 DeBan Rd
Adlington Mermarial Hospital 800, Randal Mill Rd
Baptizst Medical Center 111 Dallas 5t
Bellevue Hospital Center Ave 462 1st Ave
Bronx Lebanon Hospital Center 1650 Grand Concourse
Albert Einstein Medical Center 5507 Old York Rd
Deaconess Hospital 211 Straight St
Allanta Medical Center 303 Parkway Dr ME

Adlanta

Las Vegas
Las Vegas
Los Angeles
Los Angeles
tdiarni
Burnzville
Los Angeles
Daytona Beach
Kailua
Ancharage
Adlington

5 an Antonio
New rork
Bronx
Philadelphia
Cincinmnati
Allanta

GA
[FE4

ITRRE

G
G
HI

3
T
T3
e
e
i
OH
G

30335
23119
83102
30023
30095
33136
55337
S0Ms
90423
96734
0598
B2
TEZ05
1006
10457
19141
45219
30335

404 616-4307
702 733-8800
702 383-2000
323 267-0477
30825 9111

E12 892-2000
213 748-2411
904 239-5000

907 276-1131
567-909-1234
210 222-8431
212 562-4141
718 530-1800
215 456-7830
513 559-2100
404 265 4000

Emergency Roar
b it Humber
b ain Mumber
b ain Mumber

td ain Number

b ain Nurmber
b ain Nurmber
bt it Humber

b it Humber
b ity

b ain Mumber
b ain Mumber
td ain Number
b ain Number
b ain Nurmber
b ain Nurmber

|Ready
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6. Employee, Client and Vendor Contacts Report

The ability to maitain contact information, results and notes is crucial to a smooth running staffing agency. This report is
provided to account for contacts between your staff and your employees, clients and vendors.

The report may be run for all contacts regardless of who the contact was with, or separated to be run for each type of
contact.

Double click the contact line item, and access to the actual contact entry screen is provided.

-1\ MicroStaffer - Medical Staffing Agency.

File Employee Client Wendor Staffing Invoicing Payroll Reports  System  Wisw Report  User  Window Help
'y & =2 <& ia] B = &

Employec  Availabilty  Contacez  Documen s Client Seafing Orders  Iwaicing  Pagrall

=l @ ® -

Email  HelpTopics FeGonnect  Exie

-{/Contacts Report

Filter | Select | From | To | ~ ‘@ Search |
Date [Rangs | [oas07/2005 <] [os/08/2008 | T Reset
LTS koY =] B Erport
[Empiopes =] =8 ~ =] B = Bt
Reasare [ a1~ - | 4] Sert

Result: [==&I - | EFT
[ Client =1 [ an= =1 v ) Close

Rcuits | Options | Preview |

Contacted By~ Contact Date Contacted Party Contact Type Contact Reason Contact Result
3 n Qife e Refused Shift

Administrator 1342005 11: 38 Abraham, M Employee Called to Motify of Cancellation Left Message

Administrator 15/2005 10:11 Baker, M Emplopes Offered ‘work Refused Shift
Administrator 1742005 1:26 Rogers, 5 Emplopes Offered ‘work Retused Shift
Administrator 1742005 1:27 Rogers, 5 Ermplayes Called to Natify of Cancellation Left Message
Adrinistratar 13/2005 12:32 Chester County Hospital Client Staffing nesds discussian Resolved issue
Administrator 1772005 1:05 Chester County Hospital Client Staffing needs discussion Left message
Administrator 1772005 2:00 Chester County Hospital Client Staffing needs discussion Fesalved issue
Administrator 13/2005 11:3% Chester County Hospital Client Staffing needs discussion Fesalved issue
Administrator 9/2005 1045 Apex Staffing Wendor Cold Call

Adminiztrator 06,2005 1:37 Get Me & Murse Now Agency  Vendor Cold Call Left Meszage
Adminiztrator 13/2005 12:3%4pex Staffing Wendor Cold Call

Feady |Fregions: Off __[06/08/2005 3:42 AM
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7. Employee Leads Report

The right staffers are important to a well run staffing agency and this MicroStaffer report allows the user to list Employee
Leads for a variety of options which include: print, email, mail merge and more.

The Employee Leads report also includes the ability to run in Profile or Credential format if you wish to collect that informa-
tion from employee leads prior to hiring.

Double click an employee lead line item to access the Employee Lead facility from the report results.

. MicroStaffer - Medical Staffing Agency

File Employee Client Yendor Staffing Inwoicing Payroll Reporks  System View Report  User  Window  Help

sh = s o B EEE &

Emplayee  Avsilabiley  Gontactz  Documents  Clicnt Seaffing Orders Invoicing Payrall

Filker | Select | Frarm | To | | ~ |y§earch
o A | [PFar== ~] [00/00/0000 [00/00/0000 | S
Insurance Policy.. R | [7ar=  ~||00/00/0000 |00/00/0000 | E W
Certification.... == == | [7ar=  ~||00/00/0000 |00/00/0000 | _
Health Screening == == | [7ar=  ~||00/00/0000 |00/00/0000 | S Bt |
AUzl BEVIEW. . ... [= &= | [FFar="" <] [00/00/0000 [00/00/0000 | 8l Sort
Testn.. LA | [FFar="" <] [00/00/0000 [00/00/0000 | B Filter
TR s | B | [FFar= <] [00/00/0000 [00/00/0000 | = ¥} Close ‘
Fesults lUptlons] PIEVIEW]
Last Name First Mame Address i Follow Up Note H
Sandy 45 Oldwick Lane wn [ 0 y

Smith Janet 100 Main Street Totowa P Home 11/07/2004 Call her about her |
Johnsan HMichelle
MeDawell Sandra 100MainStrest  Totowa NC o 10939 Home = 06/03/2005 Call her for svailab
Patterson Sandra 100 Jackson Drive  Mew York NC Hormne
Buiffett James 123 Duvall Street Key West FL 55666 800-4445555  Home = 06/06/2005 Meed to acquire cf

Feady |Regions: Off __ |06/08/2005 3:55 Ak
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8. Client Leads List Report

The Client Leads List Report provides the MicroStaffer user with Client Lead information. This is a valuable report in the
acquisition of new business and provides the opportunity to stay on top of leads and to maintain old lead information for

recontact in the future.
The information may be listed, printed, emailed and more.

Double click a client lead line item to access the Client Lead facility from within the report results.

-{ MicroStaffer, - Medical Staffing Agency
File Employse Clent Yendor Staffing Invoicing Payroll Reporks System  Wiew Report Ussr  Window Help

H ® o B®® B OB = & =B B O = 2? @ I

Employee  Avallsbility  Contaces  Decumen s Glient Seaffing Orders Iwwoicing Pagrell  Prefrences  Feminders Motificstions  Email  HelpToples Re-Gonneer  Exit

- |Client Lead List Report

Filker | Select | From | To [T @ Search

Orientation [ i - 7 Beset
Besel
A

Region..........

= P Euport
= Print

8] Sort
B Fiter

m Cloze
Results l Optiors I Prevlew]

Mame Address City State Zip Phare 1 Phare 1 Desc.
Aernarial Hozpital B! Irit Street Philadelphia i, 9776 6105554545

Fieady |Fegions: Off __|06/08/2005 10:05 &M
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9. Vendor Listing

Allows for a query/report on the vendors managed within MicroStaffer. This information may be used for email, mail merge,
and more.

-\ MicroStaffer - Medical Staffing Agency

File Employse cClisnt Vendor Staffing Inwoicing Payroll Reports System View Report Ussr Window Help

h 2 oot o> i B EEE & = i D = ? ® B

Employee  Awailibility  Contacts  Documents  Client Swaffing  Orders  Inrolcing  Pagroll  Preferences  Reminders Mot Emall  HelpTopics Re-Comnect  Exit

}. Vendor List Report

Filter I Seleat I Fram Ta
SERIS. e |AClive Only ] T Heset
Reson e =l Er
= Frint
R S LY | QI,T
E§ Fiter

Results IEIphnns} Plevnew]

M arme Address City State Zip Phone 1 Phaone 1 Desc.

MM Staffing Agency 77 yesterday ave Exton Pa 19341 E10-555-1252 main
Today's Staffing 88 Today Building “Today ME 15245

Get Me & Murse Mow Agency 99 Humy Lp ave Hurrytowen CT 555E46

Get Me & Murse Mow dgency 99 Humy Up bwve Huirrutown CT 595646

Ready |Regions: OF __ [05/02/2005 10:08 AM
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10. Checklist Report

The Checklist Report may be run for any of the following checklists by selecting it in the Options tab:

Employee Checklist
Employee Lead Checklist
Client Checklist

Client Lead Checklist
Vendor Checklist

The Checklist Report may be run for a single checklist item, a list of checklist items or all checklist items. It may further be
limited by mandatory and completed statuses. The Checklist Report provides a quick way to maintain checklist items
without digging through mounds of paperwork.

To run the Checklist Report, select the report format from the Options tab and the limits from the report selections.

-} MicroStaffer - Medical Staffing Agency
File Employes Client Wendar Staffing Invoicing Payroll Reports System  Wiew Repart Lser  ‘Window Help
aln = = & By EEE

Anailability  Contacts  Docament e Staffing  Orders  Invoicin

Employes

.§ Checklist Report

Filker | Select | From To @ Search

Checklist [tem [ 2= =1 | Tt Besst

Mandatory/Mot Mandatony:.... & a4l " Mandatory Oriy " Non-Mandatory Only [EFE Expont
& Fiint
8] Sort

B Eiter

A} Close

Status: - -

Fesuls Options IPrawew}

Report Type
 Employes Checklist
" Employes Lead Checklist
" Client Checklist
" Client Lead Checklist

" Wendor Checklist

Ready |Regions: Off  |06/08/2005 10:14 AM
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MicroStaffer - Medical Staffing Agency

File Employss Client Vendor Staffing Invoicing Payrol

Reports  System  View Report

Ef HE & i

Orders  Invoicing  Fayroll  Preferenc

User Window Help

=l 7 ®» o

Email  HelpTopics Re-Gonnect  Exit

Filter [ Select [ From | To [ | @ Seaich
Checklst ltem = g Rl 2 Beset
Mamdatoru/Mot Mandatory:.... & Al (™ Mandatory Only ™ Mon-Mandatory Only % Export
Status: - -
Fesults IDptions} F‘lewew}
) -~
Checklist Report =
Name Item Status Note
Abraham, Mary Ann TE Skin Test or CXR " Incamplete @ Complete
Abraham, Mary Snn Med-Sug Test " Incomplete ™ Complete
Abraham, Mary Ann Basic Medication Test " Incomplete ™ Complete
Abrahe W Ak
Abraham, Mary Ann Electrical Safety " Incomplete ™ Complete
Abraham, Mam Ann Universal Precautions " Incomplete ' Complete
Abraharmn, Marye Ann Employment Contract " Incomplete @ Complete
Abraham, Mary Ann HIPAA Test " Incomplete @ Complete
Abraham, Mary Ann Form 1-34 " Incamplete @ Complete
Abraham, Mary Ann Mursing License " Incomplete @ Complete
Abraham, Mary Ann Health Checklist " Incomplete ™ Complete
Abraham, Mary Ann CPR/BCL " Incomplete @ Complete
Abraham, Mary Ann Substance Abuze Policy " Incomplete ™ Complete
Abraham, Mam Ann State Tax Form " Incomplete ' Complete
Page 1 of 265 06/08/2005 i
Ready ‘H_EIQIDHS Off __|06/08/2005 10:15 AM

MicroStaffer

Flle Employes Client Vendor Staffing Invoicng Payroll Reports System View Report Ussr ‘Window Help
s & bt = B &= & B=H

Emplogee  Avallabilty  Gontacts  Documents  Glisnt Seafing Orders  Iwelcing  Pagroll  Prefercnces  Fieminders M.
ploy y

= ? ® o

Emal  HelpTopics FieGonnect  Exie

Filter I Select T Fram I Ta I T
Cheeklist emi....roe.roee T =1 | T Resat
tandatory Mot b andatory: & Al " Mandatory Only " Moret andatar Only [ Expart
Status S o Bint |
4| Sort
E§ Filter

Resuts | Options | Preview |

Checklist Report
Hame Item Status Hote
Jefferson Memorial Hospital Copy of Palicy Manual received & Incamplete ¢ Complete
Jefterson Memarial Hospital Directions ta Facility & Incomplete ¢ Complete
Jefferson Memorial Hospital Executed Contract & Incamplete ¢ Complete
Page 1 of 1 0B/08/2005

Ready |Regions: OfF  |05/08/2005 10:16 AM
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11. Billing Revenue & Profit Report

The Revenue and Profit Report displays profit and loss data on shifts that have been invoiced and/or billed. It will calculate
burdens if entered on the Payroll tab in the Employee Setup facility.

Use this report to manage the profitability of your company.

-} |MicroStaffer - Medical Staffing Agency
File Employse Client Yendor Staffing Invoicing Payroll Reports System  Yiew Report User  Window Help

A B I e B B OB O =HE & B O[O L = 7 9@

Employee  Availibility  Contacts  Documentz  Client Suffing  Orders  Invoicing  Pagroll  Preferences  Reminders Motifications  Email  Help Topics Re-Connest  Exit

Filker | Select | From To | ~
Clight. ..o |w" Al j 7 Reset
Worked Date [Range ] [z -] [6a/30/2005 < —
BIEA. oo s -
rea [ =l & B
Employee/Carporation. Employess Dnly - Al
Employes THRS. ..covveer s [ === =1 =
B Fiter
Shift Class....oeee s )| = - 1
Lewicicia Do [y v 1T 1T 1 b N} Close

Results l Preview ]

Client Revenus Cost Profit  Buiden Proft%  #0fShits  #0fShits #0fHows & OFHous

Amount _Amount Invoiced Paid Irvoiced Paid
St Joeseph's Manor $517350  $B.080.63($2907.13) $0.00  -BEOO0% 18 43 14350 34450
Mercy Hospital $1.000.00 $E00.00  $400.00 $0.00  4000% =] 5 40.00 40.00
Chester County Hospital $3976276  $9.936.76$23544.00 $283.01 F4.00% a8 28 T03.50 22725
Maya Clinic of Philadzlphis $210.00 $0.00  $21000  $0.00  100.00% 1 0 T.50 0.00
Total: $46.146.26 $18.616.3827.246.87 $283.01  39.50% 12 76 89450 611.75

Ready |Regions: O [07/12/2005 10:00 AM
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12. Check Register

The Check Register Report is ideally suited for retrieving a variety of check and payroll related data.

Use this report to access payroll information and export it into various file formats. This data can then be used to feed any
external payroll systems for accounting and tax withholding purposes.

The report allows you to retrieve both summary and detailed check information. You may also select which data columns to
display and/or export.

You can use the ‘Save Report’ feature to save a regularly scheduled payroll extract. This allows you to facilitate payroll
processing to any external payroll systems quickly and easily.

;" MicroStaffer - Sample Medical Staffing Company

File Employee Customer Staffing Inwoising Papoll Repots Spstem Miew Repot User Window Help

a8 LEFES | BFo= | % | B

. Check Register Report =]

Filter [ Select [ From [ To [ | =] 7 Sazch

(20— =1 il ¢ Beset

Parall/Check Date................ [ &I = [ =1 =1 mgT

Check MUMBEr. ... [ A1 | [ =l =l = FErint

CheckTppe. [ i == =1 | &| Sort

Shift Date [ = | =l =l By Eiter

Eranlouee Tun: [eome o o 1 = ﬂ Close

Results IDpliunsl Pleviewl

Check Date Check Murmber lssued To Grass Pay Met Pay 53 Mo Taxld Extemal Id  Check Type |
02/20/02 2000 Charles Allegood 44250 442 B0 783457835 Standard
02/20/02 200 Tim Compton BE7.50 EE7 50 879546387 Standard
02/20/02 (2002 David Conley 471.25 471.25 789154987 Standard
02/20/02 (2003 Jeif Haris 238.00 238.00 456387712 Standard
02/20/02 2004 William Parker 450.00 450.00 555555555 Standard
02/20/02 2005 Herb Reeves £90.00 £50.00 555178955 Standard
02/20/02 2006 Margarita Thomton 702.00 702,00 3215689745 Standard
02/20/02 2007 Michael Thrash 6490.00 E30.00 555121497 Standard
02/20/02 2008 Clint asa 462.00 46200 458795455 Standard
02/20/02 (2009 Miquel Vasquez 238.00 238.00 783451595 Standard
0z/20/02 (2010 Gregory ‘Ward 217.50 217.50123547438 Standard
03/21/02 2011 William Parker 238.00 238,00 555555555 Standard
03/21/02 2012 Margarita Thomton 224.00 224.00 321589745 Standard
03/21/02 2013 Thamas Ussery 1155.00 1155.00 123548798 Standard

6.885.75 6.885.75

|Fieady |03/21/2002 10:26 PM
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13. Invoice Register

The Invoice Register Report is ideally suited for retrieving a variety of invoice related data.

158

Use this report to access invoice information and export it into various file formats. This data can then be used to feed any

external systems for accounting. It may also be useful in performing invoice aging tasks.

The report allows you to retrieve both summary and detailed invoice information. You may also select which data columns to

display and/or export.

4‘ MicroStaffer - Sample Medical Staffing Company

Elle Emplovee Customer 5taffing  |nvoicing Bawroll Beports

Swstern  MWiew Heport User

Window Help

law=e bERES | BFLA: | 2|0

4\ Invoice Register Report
Filter | Select | From | To
[STEIL T ———— - = ¢ Boset
(L= NN T — e =1 B | =1 P2 Epert
Invaice Date. | = =] = = Print
[ = LT —— e = 4| Soit
SHift DatE. e [ A =1 | = ] =l By Fiter
Emnloues Tune [ ) -1 A} Close
Results | Dptions I Freview I
Ihvoice Date  Invoice Nurmber Invoiced To Invoice Total — External Id

02/20/02 1000 Alaska Regional Hospital 2625.000

0z/20/02 1003 Allanta Medical Center E82.500

02/20/02 1004 Atlantic Medical Center 950.000

02/20/02 1002 Arlington Memarial Haspital 682.500

02/20/02 10085 B aptist Medical Center 375.000

02/27/02 1006 Jewish Hospital 2034.7a0

0z/20/02 1007 Albert Eingtein Medical Center 315.000

03/19/02 1007 &tlanta Medical Center 222800

03/21/02 1008 Atlanta Medical Center 2001.500

10,628.78
Ready |03/21/2002 10:27 PM
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14. Advances and Deductions Report

The Advances and Deductions Report allows you to track and manage all payroll amounts that were advanced and/or
deducted from shifts and checks.

When employees are paid in excess of actual work performed, you may enter a payroll advance amount on the Payroll and
Billing tab of the shift detail window. This represents the amount paid but not worked. On a subsequent shift you may then
enter a payroll deductions amount to offset the advanced amount.

The Advances and Deductions report displays all advances and deductions that are entered in this matter, thereby allowing
you to both maintain a proper audit trail as well as ensuring that all overpayments have been properly paid back.

. MicroStaffer - Sample Medical Staffing Company
Eile Employee Customer  Staffing  Invoicing Paproll Beports  Swstem  Wiew Heport User Window Help

lasse | aprEsd | BE A= |2 B

.}, Advances and Deductions Report

P58 [=] S

Fiker I Select I From I Ta I T

Bz Al = =] 7 Resel
[FE Export

Shift Date [ &=~ = ] = =1 = Print

£l 5o
B Filter
v Close I

Fesults | Preview |

Employee: Parker, William
Date | Shift | CheckH [Amount Deducted]Amount Overpaid | ]
342302 Hight 2011 iui] 23.00

Total oo 23.00 Met: [$23.00)

|o3221 /2002 10:56 PM

Ready
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15. Payroll Tax Reports

The Payroll Tax Reports window is used to retrieve data for Taxes and Deductions applied to payroll items.
The Options Tab allows several different views of Payroll and Withholding data:

1. Earnings & Taxes (List Format)

2 Earnings & Taxes (List Format) with State Earnings

3. Earnings & Taxes (Spreadsheet Format)

4. Earnings & Taxes (Spreadsheet Format) with State Earnings

5 Earnings & Taxes (Spreadsheet Format with Earnings for each deduction)
6 Federal and State Payroll Tax Withholding report

4-" MicroStalter - Sample Nursing Service Company
Fil=  Employee  Facilty  Staffing  lnwoicing  Payroll Reports  System View  User  Wwindow Help

aeze | O =ES | @E "= | 28|

_§. Payroll Tax Reports = [=] 3
Filker | Select [ From [ To | |

Employes [=ar— = =] = Besat
% Export

Payioll/Check Date............... [Range =l [1rezn2 £ I EEET T | —_— |
= Print

Check MUMBer.........coooerorns [ 8 = =1 =1 4] Sot
4l s
B Filter
Q Clase I

Resuits | Dptions | Preview |

Check Mo. Checlk Date First Mame Last Name Soc. Sec. Mo, Grogs Pay  Federal Income Tax Fica Medicare Ky Income Tax My Income TaxMpc Resider

1036 01/22/02  ANDREA AGUILAR 125-66-2167 379.50 -34.95 -23.53 5.50 952

1037 01/22/02  PAULINE HUTSON 131-70-0864 379.50 -43.61 -23.53 5.50 -10.53

1044 02/156/02 DOMENICA CARRIER 556-31-0641 39375 -28.44 -24.41 .71 9.25

1045 02/18/02 |JOSEPH FALCON 118-54-7497 37a.50

1046 03/418/02  MARY ABRAHAM 131-76-7285 H36.25 -44.15 -33.25 778 -F8.39

Total: 2,068.50 -151.16)  -104.72 -24.49 -79.39 -29.30 -1

< | 3|

Feady |03¢21/2002 10:57 PM

160



MicroStaffer User Manual

Copyright [1 1999-2005 DCT Computer Systems Inc.

16. Work Codes

This report provides an analysis of work codes. Work Codes are created within the List Manager window and attached to a
shift within the company set up window on the shifts tab. Each shift may have a particular work code assigned with rates
being calculated for items such as worker's compensation where the rate changes based upon the type of work being

performed.

-3 MicroStaffer, - Medical Staffing Agency

File Emplovee Client Vendor Stsffing Invoicing Payroll Repaorts System  Yiew Report User ‘Window Help

ah & = 2

5 B

Emplopes  Awsilabilty  Contactz  Documentz  Client Staffing  Ordurs

-} Work Cade Report

EE & [

i,

= ? ]

Invsicing  Paproll  Preferences  Reminderz Motifications  Email  Help Topics Re-Connect

L

Exit

Fiter T Selenl T From \ To Pyy—
(ST R -] T Besst
Export
Date [Rargs <] [Ge/i/z008 | [06/30/2008 < EEfeert |
= Print
State - 8]
#
WE L0 ha B Fiter
%) Dlose
Results 1 Dpt\ons] Pleview]
‘Work Code Anaysis - Detail Page 1 of 3
Run Dati 07/12/2005 _ "
Range:  05/01/2005 - 05./30/2005 Medical Staffing Agency
For: tedical Staffing Agency
WJ/C WiC GROSS REG oT 551
CODE STATE RATE PAY WwW/C AMT. HOURS HOURS CUST#H# HName
NURH P& 240.00 .00 0.00 120-66-5191 Cherian, Alison
Customer Total: 240.00 0.00 8.00 000 2 St Joeseph's Manor
HURH P& 424.00 8.00 0.00 071-86-6123 Ahraharn, Man Ann
HURH P& 424.00 .00 0.00 071-86-6123 Abraham, Mary dnn
NURH P& 296.00 a.00 0.00 167-80-8151 Wwiang, Susan
HURH P& 296.00 8.00 0.00 167-80-8151 Wwiang, Susan
HURH P& 296.00 .00 0.00 167-80-8151 “wiang, Suzan
NURH P& 296.00 a.00 0.00 167-80-8151 Wwiang, Susan
NURH P& 296.00 .00 0.00 167-80-2151 wiang, Susan
HURH P& 104.00 .00 0.00 555-47-8547 “whenk, Bobbi
NURH P& 104.00 a.00 0.00 555-47-8547 “wienk, Bobbi
NURH P& 104.00 .00 0.00 555478547 wienk, Bobbi

Fisady

[Fegions: Off

|07/412/2005 10:03 AM
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17. Pay and Billing Rates Report

162

The System Pay and Billing Rates report allows you to view and edit all Pay and Billing rates in the MicroStaffer system. The
options tab allows you to view rates for customers or employees. Other options include:

Pay Rates Only: This option displays only pay rates based on the filter criteria specified.
Bill Rates Only: This option displays only bill rates based on the filter criteria specified.

Pay and Bill Rate: Displays both Pay and Bill rates.

The rate types reported on can be selected from:
All

Standard Rates only

Custom Rates only

The report may further be broken down by limiting date active, inactive or non specific dates on the report. (These dates are
set when creating the rate code). For all rates regardless of date, select all.

Please note that this report is editable and you may edit any rates directly.

-3\ MicroStaffer - MedTemps, Inc.

Fle Employes Customer Vendor Staffing Invoicing Payrol Reports  Swstem  View Report User  ‘Window Help

A B N 2 & B OB OB &

"

=

Emplopee  Awailability  Contacts Documents Customer  Staffing  Orders  Ineoicing  Payroll | Preferences  Reminders Notifications  Email

2 & @

HelpTopics Re-Connect  Exit

-} System Pay and Billing Rates Report

Filter | Select | Fram | To
CLUSEOME. . o eve v | Brackwaod Medical Center -
Rate TUpE .o e & Al ((i: ,:nm N
" Standard Rates  Date Act DD |
" Custom Rates i i
" Date Inactive Only
Employes.....co..ooooereveieeeene | Al j

Results lehnnSl F’reviaw}

o Beset
% Export
=y Frint
M Save
L]

§j Close

Brookwood Medical Center
Shift [ Monday | Tuesday [Wednesday[ Thusday [ Friday | Satwday | Sunday
|I—]mukwnod A-P.......[6:45 AM - 715 PM]
Pay Rates

[4029) Standard Fate

6:45 AM - End of Shilt........... I 00 ] 00 ] 00 ] | | 00 ] 00

[4035] AiM M5 CAT1 AP

BrdGab - 1215 PM. 27.00 27.00 27.00 27.00 27.00 27.00 27.00
1215PM - 12:45 PM [Break) ........ 27.00 27.00 27.00 2700 27.00 27.00 27.00
1245PM - 315 PM.. 27.00 27.00 27.00 27.00 27.00 27.00 27.00
3:15 PM - End of Shift 27.00 27.00 27.00 27.00 27.00 27.00 27.00
[4035) M CAT 2 A-P

B Ak - 1215 PM. 28.00 28.00 28.00 28.00 28.00 28.00 28.00
1215 PM - 12:45 PH [Break) 28.00 28.00 28.00 28.00 28.00 28.00 28.00
1245PM - 315 PM. 28.00 28.00 28.00 28.00 28.00 28.00 28.00
3:15 P - End of Shilt 28.00 28.00 28.00 28.00 28.00 28.00 28.00
(40400 LPH &1l Areas AP

Brd4GAb - 1215 PM. 20.00 20.00 20.00 20.00 20.00 21.00 21.00
1215PM - 12:45 PM [Break] 20.00 20.00 20.00 20.00 20.00 21.00 21.00
1245PM - 315 PM. 20.00 20.00 20.00 2000 20.00 21.00 21.00

1171442005 Page 1 of 18

Ready

|Regions: Off  [11414/2005 11:37 &M
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C. Label Printing

Label printing may be completed from a variety of data sources which may include report queries or Staffing Center informa-
tion.

The selected items to print labels for were highlighted and then right clicked to access the label printing option. Choose the
format desired and continue.

--f*-icruSlaffer - Medical Staffing Agenc;

A B N o k B K = & =B OB O = ? & W

Emplopec  Awsilsbilty  Contactz  Documentz  Client saffing  Orderz  Iwoiding  Paprell  Frefersnces Feminderz Nodificstions  Email  Help Topics Re-Connect  Exit

{. Print Labels

Label Format: [Laser dddess 1.00 » 2.63 5160,5280 =

Bold Text: [

Italic Text: [

No. of Capies: |1 =

Exp. Date Days Left #

& Setup

!
o |
o |
o |
o |
o |
o |
o |
o |
o |
o |
o |
o |
—

| &

I Hide all Non-Accredidation ltems

¥ Display when Looging inlo MicraStaffer 5 Print & Send.. P Befich | Giokse |

Fieady |Regions: OF  |07/12/2005 10:27 AM
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D. Custom & Management Reports

Management Reports are designed for reporting tasks that involve detailed and summary analysis of various data for perfor-
mance and trend indicators. These reports are divided into several areas and include complex and user friendly graphical,
sort and filter capabilities.

Custom Reports are programmed and written by MicroStaffer programmers based on specifications of our customers. This is
a fee based service that allows us to offer Custom Reports to our customers.

1. Management Report Overview

In general, all Management Reports within MicroStaffer share common functionality that allow users to Sort, Export, Filter,
Print and Email reports.

Summary Reports also offer the user the ability to drill down into detail level reports by double clicking any given output row
on the Summary report.

Graphical Display mode is also available on select Reports by clicking on the Graph Icons in the Report Header Columns.

Each descriptive column of all Management Reports are based on the Type Classification for every Status Code in the Status
Code List on the System Settings and Utilities’ Status List Tab.

-} MicroStaffer - Medical Staffing Agency

Fil= Employes Client Wendor Staffing  Inveoicing Payroll Reports  System  User  window  Help

N o bt 2> B ] & i H D = ? ® B

Emploges  Availability  Contacts  Documen vz Client Staffing  Orders  Inwoicing  Pagroll  Preferences  Fieminders Metficstions  Emsil  HelpTopies Re-Comnect  Exit

3 Management & Custom Reports

Report 10 D escription

port [Detailed]
Client Order Fill & Cancellation Analysis Report [Summary]
Employee Fill & Cancellation Analysis Report [Summary)
Employee Fill & Cancellation Analpsis Report [Detailed)
Client Manthly Order Fill Trend Analysis Report [Summary]
Client konthly Usage and Biling Report
User Order Fill & Cancellation Analysis Report [Summary]
User Order Fill & Carcellstion Analpsis Report [Detsi)

& Bun | K} Close ‘ @ Help ‘

Ready |Regions: Off__|07/21./2005 10:41 AM
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2. Report 5000 - Customer Order Fill & Cancellation Analysis Report
(Detail)

The Client Order Fill & Cancellation Analysis Report (Detailed) provides a detailed analysis of shifts requested for the speci-
fied client and includes a breakdown that lists the employees involved within each type of status code. The report is run for a
specified client and date range. This analysis includes a breakdown and graphical analysis of shifts requested by:

Unfilled orders cancelled by client
Unfilled orders

Shifts worked

Shifts cancelled by client

Shifts cancelled by employee
Shifts cancelled due to error
Other

The report may also be run for Orders Only when the box is checked. This will include only those shifts which are marked as
a Client Order on the Shift Detail window. (This is automatically checked for new orders entered into MicroStaffer.)
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3. Report 5001 — Client Order Fill & Cancellation Analysis Report
(Summary)

The Client Order Fill & Cancellation Analysis Report (Summary) is run for all clients for a specified date range. Click the box
next to Include Projected Billing and Payroll Numbers if you wish those numbers to be included in the report calculation,
otherwise, leave the box blank. Click the box next to Report on Orders only if you wish to run the report for only items
marked as a Client Order on the Shift Detail window. This report provides an analysis of shifts requested by:

Unfilled orders cancelled by client
Unfilled orders

Shifts worked

Shifts cancelled by client

Shifts cancelled by employee
Shifts cancelled due to error
Other

Billed

Paid

The Client Order Fill & Cancellation Analysis Report (Summary) also provides a drill down capability into Report 5000 - Client
Order Fill & Cancellation Analysis Report (Detailed). Simply double click a client name to display the detailed report for that
location. Click BACK to return to the summary report.

To access a graphical representation of the data listed in the specific columns of the Client Order Fill & Cancellation Analysis
Report (Summary) simply click the graph button. Click BACK to return to the summary report.
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4. Report 5002 — Employee Shift Fill & Cancellation Analysis Report

(Summary)

The Employee Shift Fill & Cancellation Analysis Report (Summary) is run for all employees for a specified date range. Click
the box next to Include Projected Billing and Payroll Numbers if you wish those numbers to be included in the report calcula-

tion, otherwise, leave the box blank. It provides an analysis by employee and is broken down by the following criteria:

Shifts scheduled

Shifts worked

Shifts cancelled by client
Shifts cancelled by employee
Shifts cancelled by error

Other

Billed

Paid

Profit Margin

The Employee Shift Fill & Cancellation Analysis Report ( Summary) also provides a drill down capability into Report 5003 -

Employee Shift Fill & Cancellation Analysis Report (Detailed) by double clicking the employee name. Click BACK to return
to the summary report.

To access a graphical representation of the data listed in the specific columns of the Employee Shift Fill & Cancellation

Analysis Report (Summary) simply click the graph button. Click BACK to return to the summary report.
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5. Report 5003 - Employee Shift Fill & Cancellation Analysis Report
(Detailed)

The Employee Shift Fill & Cancellation Analysis Report (Detailed) is run for a specified employee and date range. It provides
a detailed accounting and graphical analysis of the following items for the specified employee:

Shifts scheduled

Shifts worked

Shifts cancelled by client
Shifts cancelled by employee
Shifts cancelled by error
Other

The Employee Shift Fill & Cancellation Analysis Report (Detailed) also provides a breakdown by facility.
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6. Report 5004 — Client Monthly Order Fill Trend Analysis Report

(Summary)

The Client Monthly Order Fill Trend Analysis Report (Summary) is run for a specified month or range of months. Select the
month to start calculation, the year and the number of months to include on the report. You may also choose to suppress

accounts with no activity. This report provides an analysis of monthly order fill trends by:

Client
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Unfilled Revenue
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7. Report 5005 — Client Monthly Usage & Billing Report

The Client Monthly Usage & Billing Report reports on a client for a specified date range. The report may be run for a specific
area within the client or run for all areas. It may be run for billed shifts only, or run to include projected billing amount for
unbilled shifts.

Depending upon the report limits set by the user, the Client Monthly Usage & Billing Report may include:

Unit Name
Billed Amount
Billed Hours
Shift Count
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8. Report 5006 — User Order Fill & Cancellation Analysis Report
(Summary)

The User Order Fill & Cancellation Analysis Report (Summary) provides an analysis of orders by user name for a specified
date range. It may be run to include projected billing amounts for unbilled shifts. The report includes:

User

Orders Entered
Orders Filled
Cancelled orders
Cancelled by Client
Cancelled by Employee
Cancelled by Error
Other

Billed

Paid

Margin

The User Order Fill & Cancellation Analysis Report (Summary) also provides a drill down capability into Report 5007 - User
Order Fill & Cancellation Analysis Report (Detail) by double clicking the user name. Click BACK to return to the summary
report.

To access a graphical representation of the data listed in the specific columns of the User Order Fill & Cancellation Analysis
Report (Summary) simply click the graph button. Click BACK to return to the summary report.
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9. Report 5007 — User Order Fill & Cancellation Analysis Report
(Detail)

The User Order Fill & Cancellation Analysis Report (Detail) provides an analysis of a selected user for a specified date range.
It provides a detailed accounting and graphical analysis of the following items for the specified user and compares the items
to all users:

Shifts Requested

Shifts Worked

Unfilled Orders

Unfilled Orders Cancelled by Client
Shifts Cancelled by Client

Shifts Cancelled by Employee

Shifts Cancelled Due to Error

Other

Filled Shifts Claimed BY Other Users
Filled Shifts Claimed FROM Other Users

The User Order Fill & Cancellation Analysis Report (Detail) also provides a specific user activity breakdown of the above
listed items that includes date/time stamp, client, shift date, shift name, employee and confirmation status.
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10. Report 5008 - Employee Payroll Quarterly Excess Earnings Re-
port

The Employee Payroll Quarterly Excess Earnings Report provides a report of excess earnings. Select the Tax Year, Quarter
and wagebase for the year to process.
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E. Generation of Form 941 & 941b

MicroStaffer Payroll (when used in conjunction with the MicroStaffer Tax Withholding Library) allows users to create Adobe
Acrobat®© File Data Format (.FDF) files which can be used to populate both Editable IRS forms 941 (Employer's QUAR-
TERLY Federal Tax Return) & 941b (Schedule B Form 941. Report of Tax Liability for Semiweekly Schedule Depositors).
Please note the following prerequisites and recommendations before performing the Step-by-Step Export-Import process for
form 941 & 941b which is located in the second part of this document:

1. You must have Adobe Acrobat®© (Free Reader Version 7.0 or higher) installed on the PC which you will use to import
the MicroStaffer .FDF files into the IRS .PDF files for forms 941 & 941b. Please note the menu layouts to perform
the import are different between the Free Reader version of Adobe Acrobat© and Adobe Acrobat© Standard or
higher (e.g. Professional).

2. You should begin by downloading the most recent versions (Based on the Tax Year you are filing for) of forms 941 &
941b from the IRS web site. These must be in the form of editable .PDF files and can be found on the main IRS
Web Site.

As of May 2007, these forms could be found at:
Form 941: http://www.irs.gov/pub/irs-pdf/f941.pdf
Form 941b: http://www.irs.gov/pub/irs-pdf/f941sb.pdf

Only forms from the IRS Web Site should be used and it is recommended that you always use blank versions of these
forms. This is a list of the only fields that MicroStaffer will populate programmatically during the .FDF import process:

a. Form 941 - Employer’s QUARTERLY Federal Tax Return
1. EIN — Employer Identification Number

2. Name — Company Name

3. Address

4. City

5. State

6. Zip code

7. Quarter

8. Box 1 — Number of Employees

9. Box 2 — Wages, tips...

10. Box 3 — Total income tax...

11. Box 5a — Social Security Wages and liabilities

12. Box 5¢ — Medicare Wages and liabilities

13. Box 5c — Total Social Security & Medicare Taxes

14. Box 6 — Total Taxes before adjustments

15. Box 7a— Current quarter’s fractions of cents (This column will only show the difference in actual (MicroStaffer) vs.
calculated Social Security & Medicare Taxes). This can also be described as the difference between Box 6 and Box
8.

16. Box 7h — Total Adjustments

17. Box 8 — Total taxes after adjustments

18. Box 9 — Advance earned income credit (EIC) payments made to employees

19. Box 10 — Total taxes after adjustments for advance EIC

b. Form 941 — Schedule B — Report of Tax Liability for Semiweekly Schedule Depositors

1. All boxes
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3. You must open the forms using Adobe Acrobat© from within Windows® Directly. Do not open these files from within
Internet Explorer or any other Web Browser.

4, Once you have imported the data from MicroStaffer into the forms you can either print them or perform a ‘Save As’.
We do NOT recommend that you simply hit ‘Save’ as this will save the populated .PDF form file in place of the blank
.PDF form file.

5. Depending of which version of Adobe Acrobat®© you are using, you may receive the following error message during

the import process:

“An error exists on this page. Acrobat may not display the page correctly. Please contact the person who created the PDF
document to correct the problem.”

Please disregard this message. However, it is good practice to make sure that all boxes listed above for either Form 941 or
941b have been filled in regardless of this error.

Step-by-Step MicroStaffer 941 Adobe Export/Import Process

1. Create a 941 Form Data File (.FDF) using MicroStaffer

a. You must be running MicroStaffer Version 8.0 Build 208 or higher.

b. Log into MicroStaffer and open the main Payroll window using the main menu toolbar or the main menu
Payroll->"View and Edit Payroll’ menu item.

C. Once you have the Payroll window open, select Utilities->Process 941’s from the Main Menu. Note: The

utilities menu item will only appear if you are on the Payroll window. It may look as follows:
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d. Under ‘Form Type’, select which form you wish to run.
e. Choose a year and Quarter.
f The ‘Save Copy of Raw Data in Excel© checkbox will allow you to save the data used to create the .FDF file

in an Excel file also. This is used primarily for tech support purposes.

g. Click the ‘Export’ button. This will run the .FDF 941 Export batch and prompt you to enter in a file name
and location in .FDF format. We recommend that you save the file for forms 941 and 941b in files f941.fdf
and f941b.fdf respectively. Make sure you note the folder location (eg. My documents, c:\<drive> etc.). You
will need to know this when you import the data into Adobe Acrobat®©.

2. Importing your MicroStaffer 941 Form Data File (.FDF) using Adobe Acrobat©

a. Begin by opening a blank version of either form 941 or 9431b using Adobe Acrobat®©. This can be done by
opening Adobe Acrobat®© from within Windows®© either by using shortcut to Adobe Acrobat© on your
desktop or from the Start Menu in Windows®© and the selecting File->Open from within Adobe Acrobat©
(Reader or higher).

Or, you can also locate the blank editable .PDF file (941 or 941b) using My Computer or Windows Explorer
and then Right-Clicking and selecting ‘Open With’ or just double clicking the file..

You must open the .PDF files for forms 941 or 941b using Adobe Acrobat®. You can use Adobe Acrobat©
Reader (Free Version), Standard or Enterprise or higher. The Free Version of Adobe Acrobat© can be
downloaded from the Adobe web site: http://www.adobe.com.

b. Once you have opened the .PDF files for either form 941 or 941b in Adobe Acrobat®©, you can then perform
the import:

1. If you are using Adobe Acrobat Reader® (Free Version):

From the Main Menu in Adobe Acrobat Reader© select Document->Forms->Import Data from the Main
Menu in Adobe Acrobat Reader®©.

2. If you are using Adobe Acrobat© Standard of Enterprise:

From the Main Menu in Adobe Acrobat®© select Advanced->Forms->Import Forms Data from the Main Menu
in Adobe Acrobat®©.

Then, navigate to the folder location in Windows®© where you saved the .FDF MicroStaffer form data file(s)
that you created in Step 1 above. Then, click on the ‘Select’ button. This will import the data from
MicroStaffer into your blank 941 or 941b .PDF file.

c. Once the data is imported, please fill out the remaining lines and boxes in form 941 such as, for example:
Box 11 (Total deposits for quarter), Box 14 (State abbreviation) and any other information which is not
populated by MicroStaffer. Form 941b should be completed in full by MicroStaffer; no additional data entry
required for 941b.

Please note it is your responsibility to assure the accuracy of form 941 and 941b.

d. Once you have completed and verified the .PDF files for forms 941 and/or 941b you may then either:
1. Print the forms or,
2. Perform as ‘Save As’ using the Main Menu in Adobe Acrobat®©.

We do not recommend that you simply “Save” the .PDF files since this will replace the Blank versions of these with the
populated versions.
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VIl. Using MicroStaffer — Mail Merge

Mail Merge Manager - Enhance communications with Employees, Client and Vendors using MicroStaffer’s fully integrated
Mail Merge Manager. MicroStaffer’s Mail Merge Manager is a fully integrated document editor and mail merge processor.

A. Template Categories & Creation

MicroStaffer maintains separate document templates within the Mail Merge Manager for Employees, Clients and Vendors.
Once created by a user, these document templates may be accessed within a variety of facilities within MicroStaffer.

Template Category  Data Source within MicroStaffer Frequently Used (User Defined) Formats may Include
Employee Staffing Center Credential Expiration Notice
Employee List Birthday Greetings

Employee Leads List

Customer Customer List Report Thank You for Your Business
Customer Checklist
Customer Leads Checklist Report

Vendor Vendor Listing
Vendor Checklist Maintain Insurance Info
To create a document template, select Mail Merge Manager from the tab you wish to use. The following example is the

creation of a Credential Expiration letter template for employees.

When you first access the Employee Mail Merge Manager, a blank document screen appears. This is where you will create
the template.

-{\ MicroStaffer - Medical Staffing Agency
File Employee Client Wendor Staffing  Inwoicing Payroll Reports  System  User  MWindow  Help

i = et & g EEE & iz Y = 7 ® o

[Page: 1 Line: 1 Cal: 1

Feady |Regions: Off  |05/08/2005 10:51 &AM
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1. Template Creation

The template is created within the Document Editor by writing a blank letter which includes specific merge fields from the
Insert Merge Field dropdown. Please see the following example:

s =

Employes  Awsilability

Ready

File Edit Wiew Insert Font Paragraph  Table Tools Help

NEEEsS| el sl do @

[Mormal

= First and Last Mame
"""""""""""""" First Mame:
Last Name

address 1

Medical Staffing Agency,

MedicalStaffing Agency
100 Exton Pike, Suite 400
Downingtown, PA 19335

<<<address 1===
<<<address2=>>
<<<city=r, <<<state>>> <<<zip>>>

INS [Page: 1 Line: 1

|Fregions: Off _|08/08/2005 11:03 Ab

The document was created with the employee name, address, first name as salutation and a List of Credentials in a table
format. Later, you will see this information merged from a tickler, but for now, the format needs to be saved. When you are
finished creating the document template click File, Save As and type in the name of the format to be saved.

M =

Emploges  Availability

Feady

EEEER R EREE
[Normal =l =Bz u|=

Drescription: m
€3 Cancel

Last Modified By: Iﬁdm\l’\lstlalol Or: [5/3/2005 11:20 &AM @ ol
Help

[<<<address 1=
[<<<address 2>>>
= <<city=5>>, <<<gtater>> <<<gip>>>

INS |Page: 1 Line: 1 Cal: 1

|Fregions: Off__|06/08/2005 1:11 PM
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Now you have a saved document format to use when creating mail merged documents. This example is specifically for an
employee type mail merge, but documents may also be created for clients and vendors by selecting the Mail Merge Manager
found under the specific tab.

2. Mail Merge

Now, to actually process a mail merge using the Credential Expiration Notice Letter. There are a few places to access the
data source for the mail merge, but in this example we will rely on the tickler file generated automatically by MicroStaffer
when a credential item is about to expire — The Staffing Center.

If you wish to include all of the items on the Staffing Center window, you must highlight them all by pressing SHIFT and
clicking the mouse button to highlight a group of items. Then click the RIGHT mouse button to access the options available,
including mail merge.

f. MicroStaffer - Medical Staffing Agency

File Employee Client Yendor Staffing Inveicing Pavroll Reporks System User Sindow Help

mw ' I & B E & = I =] ? ®
"

Emplopes  Availability acumer Cline  Swffing  Orders wsicin Paprall  Preferens 5 Emul  HelpTopics Relomert  Exit

4\ Staffing Center EI@EI

Evpirations | Unfiled Orders | Open Availabiles | Open Travel Orders |

Days Lett &

Print via PDFWriter.,
Send Tou..
Copy Selected Employee(s) to Recipient List

¥ Display when Logging into MicroStaffer & Fiint | ) Send ‘ @ Befiesh ‘ N} Close

Feady [Fegions: 0t |06/08/2005 118 PM

You will be notified that the mail merge will only be processed for the highlighted rows and asked to continue, click Yes or
No. After you continue, the available formats for the employee category will appear. Click the format you wish to use for the
merge and Open.
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-
AR
Emplogee y

g Employee Mail Merge Templates

Doc Description Last Moified By On
hecklist Admiristrator  05/03/2005 11:45 AM
Credential Enpiration Natice Letter Administrator  05/25/2005 10:54 AM
Credentialing Letter Administrator

Credentialing Letter A foi
Follows Up Letter Acministator | (T3/30/2004 232 Phd
termy Christmas Lstter Admiristrator 1040442004 533 AM
Origl Admiristrator  12/13/2004 11:51 &M
Test! Administrator 0341042004 10:05 &M

7 Open | W Close ‘ @ Help |

[Page: 1 Line: 1 Col: 1

¥ Display when Logging inte MicroStaffer & Biint | & Send. ® Hefresh | N} Close |

Feady [Fregions: OFf _ |05/08/2005 1:24 PM

Then you will be asked if you wish to Merge now? Click Yes to merge.

NEEHESR| @R - M edcd T (6 Imu%J| ||nse|lMe|gEFleld
{Marmal = || arial [z -1 B ru|= =F

Medical Staffing Agency,

MedicalStalfing Agency

<<<address1===
ce<address2==>
co<pity>=>, <<<statesss S==zipshs

NS |Page: 1 Line: 1 ol 1

¥ Display when Lagging inte MicraStaffer & Print ‘ & Send... @ Refresh | &} Close |

Fieady [Fiegions: Off _|05/08/2005 1.28 Fi

180

The merge is completed using the document template to generate form letters to all of the employees listed on the Staffing
Center as the data source. There are many other sources of data for the generation of mail merged documents (Please refer

to table). The completed merged documents may be saved.
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- [

Emplogee  Availabiliey

Ky = = =2 B EE & 2] ] as = ? & e
3 Employee Mail Merge Managen
Flle Edit Yisw Insert Font Paragraph Table Tools Help

DSESR| R | # 2o 1@ o ]| [nsetMeageFeld

LU IIELC WAL L A LTl

11314 Hickory Hill Rd.
[Dresher, PA 15025

Employee's Mame: Mary Ann Abraham

(Cur records indicate the following credentials andfor yearly requirements are about to
expire

he fellewing Diocuments need updating/renewal

Professional Liability 07/06/2005

CPE P& (0573172005
NS |Page: 1 Line: G Col 10

[ Display when Logging into MicroStaffer &% Biint ‘ 2 Send.. ‘ ® Fefesh | &} Close

Ready

|Regions: Ot |08/08/2005 1:32 PM

3. Edit Mail Merge Document Templates

To alter a mail merge document template, select Mail Merge Manager and File, Open and select the document template and

either edit, save or delete.

181
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VIIl. Using MicroStaffer - Document Manager

MicroStaffer's Document Manager allows for the maintenance of important documentation for a variety of categories. This
powerful tool provides the documentation you need at your fingertips. Documents may be added to various categories using
the Document Manager facility, or alternatively, via the Documents tab in the following facilities: Employee; Employee Leads;
Company; Company Leads; and Vendor.

MicroStaffer Document Manager allows you to import Rich Text Format (.RTF) documents, Images (Imaging & Scanning
module) and PDF files. MicroStaffer handles each format in a different manner.

Document Type categories include:

Employee Documents

Client Documents

Company Documents

Document Templates (Rich Text Format only)
Employee Leads Documents

Client Leads Documents

Vendor Documents

. MicroStaffer - Sample Medical Staffing Company [EEET]

File Employes Costomer Vendor Staffing Inwoicing Payroll Reports System User Window Help

5 = i3 = B £ & i) [H 1Y = ? ® o

iy
Emplapss  Awsilbilty  Comacts  Decumemts  Cusmemer  Swaffing  Orders  Iweidng  Puroll  Profrsncss  Remindsrs Meodfisstions  Emsil  HelpTepiee Re-Connest  Eit

. Document Managen

Document Type

Compary Documents
Document Templates
Emploves Leads 7 Qpen
Customer Leads
Wendor Dosuments
T LT Barmer, Blake fi
Bell, Lacheisa & Rich Text
Bernett, Joan
Betaudier Addisan. J sanne-Felice
Beverly, Peter
Billups, Janet

Delel
Bowden, Nasheka & Dekle
Boyce. Kimberly
Boyland, Linda

Search
Eregman. Deborah & sear
Bracks, Wilhelmina
Browsn, Patricia

Ermvan, dlthea
Bmant, Charles

© Image
© EDF

Jaooooaooooon

Feady [Fregions: Off _|03/23/2006 11:37 AM
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A. Document Manager - Templates & .rtf files

Adocument template is simply a template (Rich Text Format) that is reused within MicroStaffer for maintenance of extra
informational data for the document type categories. Creating templates for frequently used documents is a time saver that
should be considered when using MicroStaffer. Document Templates could include: Plan of Care (Patient); Interview Ques-
tions (Employee Lead); Basic Contract (Client); Emergency Contact information (Employee).

Click New to select a source for the Document Template and choose from:

Blank document - Opens a new document template.

Using Template - Presents a list of existing templates.

From File on Disk - Opens a window that lists saved .rtf files in the target directory (HINT: You can import editable data from

Microsoft Word documents by saving them in Rich Text Format and then importing them into the MicroStaffer Document
manager)

SE

DERER|: e o [# (8 dd @ o=
[ aiai =l ~Imsulls==s=s|E:=

-3 New Document

Select the Source for the New Documenl

‘E?

Using From File on

Template Disk.

Page: 1 Line: 1

[Fiagions: Off __|03/23/2006 10:57 &M
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Document Templates may be maintained within the Document Template selection in MicroStaffer. Simply open the template
and edit then save. The following screen is an example of the available Document Templates created in this test version of
MicroStaffer.

roStaffer - Sample Medical Staffing Company:
Employee Customer Wendor Staffing Invoicing Payroll Reports System User window Help
By

Staffing Orders

- Document Manager

Document Tups
|Dncumer\t Templates j

Employee lead interview questions (01-16-2008)
Fatient Care & Contact Extia Info [03-20-2008)
Facility & Check In Guidelines (03-20-2008)

& Delets
@ Search

Feady [Fegions: OFf __|03/20/2006 1:53 PM
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To add a document to employees and employee leads; clients and client leads; companies; and vendors using a saved
Document Template: select the employee, click the Rich Text radio button and click New. From the New Document box,

select Using Template to access the list of available Template Documents. Select the template document, edit as needed
and save.

Alternatively, documents may be added using the Documents tab found within each category’s set up area.

=1

- =]

Employes  Availability

A OB N e H® B OB OEH & B OBO»N = O @& B

-} Select Template Document

Select a Template Document

Template Mame
s 01 1]
Fatient Care & Contact Extra Info 03/20/2008
Facility & Check In Guidelines 03/20/2006

Employee lead interview

|Page: 1 Line: 1

Fieady |Regions: Off  |03/23/2008 11:07 AM
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B. Document Manager - Image Files

MicroStaffer allows for the importation of previously scanned image files or, by using the MicroStaffer Scanning & Imaging
module, MicroStaffer will scan in documents directly from your attached device. (NOTE: Atrial version of the MicroStaffer
Scanning & Imaging module is included with MicroStaffer. However, only licensed users of the Scanning & Imaging module
will be eligible for support of same.)

NOTE: Image formats (Incoming & Storage format IDs) are set within System -> System Options -> Scanning & Imaging.
Select the Document Type category to work with and select the Image radio button, then press New. A Select Document
Source window will appear. The example below has the Scanner Settings button clicked so that you may refer to the set-

tings. The available options are:

Scan New Image - Allows you to scan a new image from an attached scanner. Please be sure to use the Settings button. It
is recommended that the Twain Interface be used first.

Paste from Clipboard - Allows image to be pasted from clipboard.

Import from File - Allows for importation of previously scanned images.

-{*| MicroStaffer - Sample Medical Staffing Company

File Edit View Image colors ‘Window Help

”;.s;;@@fsssiﬁw_a_g?mm:

Employes  Availabilit anta. o. Cusked b i rders Inveicing

-{*| MicroStaffer - Sample Medical Staffing Company

-F/Select Document Source

. Select Image Source
= s DK |

% Scan Mew Imags

= < €3 Cancel |
" Paste from Clipboard

" Impart from File % Help I

i~ Scanner Setting:

™ Sean Using MicroStaffer Interface

& Goan Using Twain Interface Select Source |

Feady |Riegions: 0ff __|06/05/2006 10:35
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C. Document Manager - .pdf Files

Document Manager allows for importation of created .pdf files for the various document type categories. First, choose the
Document Type category to work in along with the individual employee, customer or vendor. Click on the PDF radio button
and select New. You will be directed to a window in which you may select the .pdf file from the default directory or an alter-
nate directory.

- MicroStaffer - Sample Medical Staffing Company

Fil= Employes Customer Vendor Staffing  Inwvoicing Pawroll Reports  System  User  window Help
2 g
=]« & EE-

Select PDF File to Import

Look in: | (23 MicraStaffer
os

IC5)SEA_HELP
Qtest schedule.FOF

File name: | Open I
Files of type: | PDF Files [*FDF) ~] Cancel

|Ready |Regions: O |06/06/2006 5:53
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IX. The MicroStaffer Web Access Module
A. Overview

The optional MicroStaffer Web Access Module allows you to grant Internet access to selected Employees and Customers
using any standard Web Browser such as Netscape Communicator or Microsoft Internet Explorer. This module also allows

you to post on-line application forms which flow directly into your MicroStaffer Employee Leads section. Please contact
MicroStaffer to purchase this module.

Employees can access schedules and enter availabilities. Customers can also access schedules, view basic employee
information, enter on-line orders and view published invoices.

The Web Access Module is hosted by you and must be installed on your Windows based Network server.

To grant Web acces to Employees and Customers you must create User ID’s and Passwords in the Employee Setup and
Customer Setup windows within MicroStaffer.

B. Employee Access

1. Accessing Employee Schedules

Employees can view their schedules in both List and Calendar format. The Schedule query window allows them to enter
various filter criteria.

) Sample Medical Stalfing Company Shift Calendar Filter - Microzoft Internet Explorer

J File  Edit “iew Favortes Took Help |

J GBack v = - (D Zat | ‘ChSeach [%]Favoites £ Histon ||%v = -2

| Addhess [#] hitp://207.252.76.104/cac/emp_schedule_auery_cal.asp Tkey=13 =| @6o |j Links *
e £ .
X = f ; - mployees
"‘-’ﬁ‘_\ Medical Staffing Services ~ 7y "~ :LRT
5 o |

User: Conley

Enter the Filter Criteria for Retrieving you current schedule below, then hit the Search button...

Start Date: [Saturday, March 23, 2002 7]
Number of Days: I? 'l

Search | Reset | Back |

MicroStaffer hedical Statfing Software

. microstaffer.com

Copyright @ 2002 [DCT Computer Systems Inc.]. All rights resensed
Revised: Mareh 07, 2002

s

|@ ’7 ’7 ‘O Intemet
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Clicking on the Search button displays the Employees schedule based on the Filter criteria that was entered.

Company Shift Calendar - Microsoft Intemnet Explorer

J File Edit “iew Favoites Tools Help |
J A Back - = - @ 7 | @Seafch (] Favorites @H\stow ||%- = H - 3P
| Address |@ hitp: //207.252.75.104 /e ac/emp_schedule_cal. asp ~| @6o |j Links >
=
BT c |
= : : : mployees
o Medical Staffing Services
/qg E g Web Access_f
i \‘
[Calendar for: David Conley [From: 4/13/2002 [To: 4/19/2002
| Saturday04/1302 | Sunday04/1402 | Monday04/1502 | Tuesday04/1602 |Wednesday04/17/02 | Thursday 04/1802 | Friday 04/19/02
Adington Mernorial Arlington Mermorial
Hospit Hospit
7:00AM - 300AM (ED) 7:002M - 3:004M (ED)
Scheduled/Firm Scheduled/Firm
EC=[x]/ FC=[X] EC=[¥]/ FC=[]
Atlanta Medical Center
11:00PM - 7:00AM
1cu)
Scheduled/Firm
EC=[x] / FC=[¥]
Back |
Micro Staffer Medical Staffing Software
. microstaffer.com
Copyright ® 2002 [DCT Computer Systems Ine]. All rights resenved
Revised: March 07, 2002
H
& l_l_‘ﬂ Intermet o

Schedules can also be displayed in List format.

a Scheduling & Staffing List Report - Microsoft Internet Explorer

| Fie Edt Wiew Fovoites Took  Help

| wBack - = - 2 [F] | Dseach [Favoites (HHisow |- S5 B - 2

| Addiess [&] hitp:/207.252.75.104/2ac/emp_schedule_list.asp ~] @60 H Links >
'ﬁ;*" Empl .
= = q 5 5 mployees
ﬁ\ Medical Staffing Services ~\’ Access !
1 Q i S

[Schedule for: David Conley |From: 3/23/2002 [To: 4:21/2002

m‘ Date | Location | Start | End ’E’L_CIL_C Status Type

|Day |[325/2002 |[Adington temorial Hospital [Fooam  |Z00aM ED [ % [ % |[ScheduledFirm  [RN

|ight |[325/2002 ||atlanta Medical Center [11:00Pm [Fo0am icu [ x [ % |[ScheduledFirm  [RN

|Day |[327/2002 ||adington Memorial Hospital 7o0am  [300Am [ED [ % |[ X |[SchedulsdFirm RN

[Day [#71/2002  [Adingtan Memorial Hospital 7O0AM  [3004M [ED [ % [ X |[Scheduled/Fim RN

[Night |[4/1/2002  |[Atlanta Medical Center 171:00PM|[F:004M ICU |[ % [ % |[Scheduled/Firm |[RN

[Day |[4/32002 |[Adington temorial Hospital [Fo0am |[300aM ED [ [ % |[ScheduledFirm  [RM

|Day |[48/2002 ||Adington temorial Hospital [7o0am  |Zo0am [ED [ ® [ % |[ScheduledFirm  [RM

Might |[4/8/2002  |[atlanta Medical Centar [11:00Pm [[Fo0am [icu [ x [ % |[SchedulediFirm  [RN

[Day |[4/10/2002 |[Adington Memorial Hospital [7o0am  |300am [ED [ % [ % |[Scheduled/Firm  [RM

[Day |[4/1572002 |[Adingtan temarial Haspital [Fo0am |[300AaM [ED [ [ % |[ScheduledFirm  |[RM

[ight |[4/15/2002 |[Atlanta Medical Center [11.00PM [Fo0aM [Ic0 [ [ % |[ScheduledFirm  [RM

[Day |[4/17/2002 |[Adington temorial Hospital [Fo0am  |[300aM |ED [ % [ % |[ScheduledFirm  |[RN

Back l

hdicro Staffer Medical Statfing Sofhware

. microstaffer.com

Copyright @ 2002 [BCT Computer Systems Inc]. All rights resenved
Revised: hMarch 07, 2002

S5

=] [ [ Intemet
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By clicking on the Customer’s name in either the Calendar or List view of the schedule, Employee’s can view information

190

about the selected Facility or Customer. They may also click on the ‘Map It' icon to access MapQuest and view a location

map of the Customer.

) 5ample Medical Staffing Company Address and Directions - Microsoft Internet Explorer

File Edt “iew Favoites JTools Help

e Back v = - (D 7 | D Seach [HFavaies C#Histoy | Th b - &P

Address I@ hitpe /4207252 75.104/eac/ client_detail_a asp?agent_id=28

=] @Go || Links >

=
S E I ;
=X = - - mployees
s Medical Staffing Services
’*’g = g Web Access_#
[ B
Address Information
MName: Arlington Memorial Hospital
Address: 500 Y. Randol Mill Rd
|Cily, State, Zip |Adlington , T 76012
Directions
Take 678 Morth to exit 12 Turn Right Go through 6 Lights and turn Right on Bellview Drive Go 4 Miles Hospital on
Left
Map this Location
Back l
MicroStaffer Medical Staffing Softuare
waow, microstaffer. com
Copyright @ 2002 [DCT Computer Systems Inc]. All rights resenced.
Revized: March 07, 2002
-
|7 hitp:/Avmans mapauest com/maps/map. adp?country=US&address=800 W. Randol Mill Rdbcity=Aringtongstate=T>tkzipcode=76012 [ [ | intemet 4

By clicking on the Shift Description in either the Calendar or List view of the schedule, Employee’s can view detailed informa-

tion about the selected Shift or Job Assigment.

/2 MicroStaffer Shift Detail - Microsoft Internet Explorer

| Fle Edt View Favortes Took Help | =
| wBack - =+ - D &} | @ySearch i Favortes C@Histon | By~ g o]
| s [ @] hitp.//207. 262.75.104/eac/shift_detai_view. aspFshitid=4513 | 6o |J Links >>|
== Hospitals % d
=X = : . . .
/’/&\ Medical Staffing Services |°P) Accest 3\
Shift Detail
Facility Name: Atlanta Medical Center
Employee Name: David Caonley (RN )
Shift: Might
Date: 372672002
Start Time: 11.00P M
End Time: 7:00AM
Status: Scheduled/Firm
Confirmed with
Employee : Yes
Confirmed with Facility : Yes
Unit: e8]
Employee Type: RM
Confirmed With:
Ordered by:
Back l
MicraStatfer Madical Staffing Software
vwww. microstaffer.com
Copyright ® 2002 [DCT Computer Systems Inc.]. All rights reseried
Revised: March 07, 2002
=
|&] Done [ | [ intemet o
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2. Entering Availabilities

Employees can can also Enter New or Edit existing work availability using the Web Module. Both Daily and Permanent
Availability may be entered.

Any changes to the Availability is forwarded directly to the Microstaffer system and displayed on the User Notifications
Window. In order for a user to be alerted to New or Modified Availabilities, he/she must be assigned as an Employee Rep
within MicroStaffer for the given Employee.

Notifications will be displayed in MicroStaffer both when Loging In as well as any time the User is running the MicroStaffer
application.

The first step in entering new or modifying existing Daily Availabilities is to select the starting time period as shown below.

<} Sample Medical Stalfing Company Availability Start Date - Microzoft Internet Explorer

J File Edit “iew Favortes Took Help ‘

J GBack v = - (D 7ot | QhSearch [ Favoites £ % Histo ||%v = .2

J Addiess I@ hitp:#/207. 252.75.104/eac/ shart_term_availability_date_select. aspkey=13 j ﬁﬁo “ Links **

=

A :
=7 Medical Staffing Services Emg‘fgg&ﬁﬁ%

User: Conley

Enter the Starting Date for updating your availability below, then hit the Submit button...

Start Date: ISaturday, arch 23, 2002 j

Submit | Reset | Back |

MicroStaffer Medical Statfing Sottware

wwann. microstaffer.cam

Copyright @ 2002 [DCT Computer Systems Ine. All ights reserved
Revised: March 07, 2002

| B

&1 Dore ’_’_|e Internet
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192

Once the Starting Date for the Availabilties has been selected, Employees may then fill out the form and click on the Submit

Button. Once submitted, a Confirmation page is displayed which the user may view or print.

a Availability - Microsoft Internet Explorer

J File Edit Wiew Fawoites Tools Help

J “=Back ~ = - i 2t | Qi Seach i Favorites & 4 History |%- S @ -2

| address [ http./207. 262, 75.104/eac/shorl_teim_avalabily_load.asp

s
e ; : f Employees
/lfﬁ\ Medical Staffing Services “7 /7 20 )
i \i
Enter your availability for the day of the week below, then hit the Submit button...
Date ‘ Shift ‘ . ‘ Note
ours
! [ !
g;f‘zlgfggy ‘INDtAva\Iahle j ||Anyj ‘I
Sunday [ = |
03/24/02: ||A”YJ ‘|
aond I T T
[Eer S B Efe =
T d | [ |
oz, 0 Hl= =i
"Wad 1 [ T M
032702 ‘lDaV = ||8 = ‘|
1 1 I T T
‘;]2!1‘2811]2:1 ‘l Dy j || il j ‘ll can also do a double here...
" | [ |
E;:.g;}az ‘I Mot Available j ||Anyj ‘IMy kids are outfrom school. Flease don't schedule m
Submit | Reset | Back |

MicroStatfer Medical Staffing Sottware

. microstatfer. com

Copyright @ 2002 [BCT Computer Systems Ine.]. All rights resenved.
Revised: March OF, 2002

=] @G || Links »
=

& ’_ ’_ | Intemer

=z} Sample Medical Staffing Company Availability Saved - Microsoft Internet Explorer

Eile Edit Wiew Favoites Tools Help

S=Back + = - D 7t | Q4 Seaich (G Favortes &4 History | B & Q] - <2

Address I@ http: /#207. 262 75.104/eac/short_term_avail_update_conf. aspPuser_key=13%start_date=03/23/02

=] @0 || Links >

oA S 2
- . . . Employees
ﬁ\ Medical Staffing Services =\ 7 =" %

54

Your new Availability has been Saved as shown below:

| Day ‘ Shift Class | H""']?J’:s | Note

[n3/232002 Mot Available [ any

[03/2472002 [Not Available [ any

[03/25/2002 [Day [ sm0

|p3s26/2002 |Day [ 8o

[n3/27 /2002 [Day [ &oo

0372572002 Day 8.00 | can also do a double here...
03/29/2002 Mot Available Any E“D3;¥‘:§hi'§ufe”‘rggfm Sl FEeE

MicroStatfer Medical Staffing Sothuare

. microstatfer. com

Copyright @ 2002 [DCT Computer Systems Ine]. All fights resenved.
Revised: March 07, 2002

=

|&] Done [ [ |4 Intemnet

S
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Employees may also enter Permanent Availabilities. These are not date specific and indicate a long-term Availability. Again,
once the Permanent Availability form has been submitted the Employee is shown a confirmation page.

All Availabilites, whethere Daily or Permanent flow directly into your central MicroStaffer system.

a Sample Medical Staffing Company Long Term Availability - Microsoft Internet Explorer

J File Edit “iew Favortes Tools Help ‘

| wBack ~ = - 2D &t | ‘@uSeach [iiFavoites CdHiston | EY- Sh - 3

| Address [&] hitp./207,262.76.108/eac ong_tem_availsbilty_load aspkey=13 =] @t H Lirks *

ST . I

SR = . . f Employees
e ﬁ\ Medical Staffing Services ~\/' V2% %

Enter your availability for the day of the week below, then hit the Submit button...

‘ Shift Class ‘Max" Note
Hours

Sunday: ‘lNotAva\Iable J ||AnyJ ||
Monday: ‘lNotAva\Iable J ||8 J ||

Tuesday: ‘lDay J ||8 J ||
Thursday: ‘lDay j ||12 j ||Can do doubles also.
Friday: ‘lDay J ||12 J ||N0 doubles on Friday pleass.

|
|
|
|Wednesday |Day j ||8 ﬂ ||
|
|
|

Saturday: ‘lNotAva\Iable J ||AnyJ ||

Submit | Reset | Back |

MicroStatfer hiedical Statfing Sofware

. microstaffer.com

Copyright @ 2002 [BCT Computer Systems Ine.]. All rights resenved
Revised: Marsh 07, 2002

|@] Done [ |4 intemet

i Sample Medical Staffing Company Availability Saved - Miciosoft Internet E xplorer

J File Edit View Fawortes Tools  Help ‘

J =Back - = - D 7 | @ Seaich (G Favortes &4 History |%- = N s

JAgdress I@ hittp: /207,252, 75.104//eaclong_term_avail_update_conf.asp?use_key=13 j 6’60 |J Links *>
e S ) =
= ;;—" a - - mpiloyees
- Medical Staffing Services
,‘V’\\ < g Web Access
i -
Your new Permanent Availability has been Saved as is shown below:
Day Shift (hax. Note
Sunday: Mot Available Any
|Munday ‘Nut Available | 8.00
|Tuesday ‘Day | 5.00
|Wednesday ‘Day | 5.00
|Thursday ‘Day | 12.00 |Cam do doubles also
|Friday \Day | 12.00 |N0 doubles an Friday please.
|Sa|urday ‘NDI Awailable | Any
Back |

Wicro Statfer Medical Staffing Sothuare

wwnwnn. misrostatfer. com

Copyright @ 2002 [DCT Computer Systems Ine.]. All rights resenved
Revised: March OF, 2002

€] Done

N E

[ [ Intemet
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C. Client Access

1. Accessing Client Schedules

Clients/Facilities can view their schedules in both List and Calendar format. The Schedule query window allows them to
enter various filter criteria.

/3 Scheduling List Query - Microsoft Internet Explorer

J File Edit View Favoites Toolz Help

J dBack + = - 7 | G Search [ Favortes & History |%v =] L]

J Address I@ http: /#4207, 252, 75.104/eac/schedule_quen.asp?key=14

=] o || Links >
)

A

N

_—— ; ; ; Hospitals %
. ﬁ\ Medical Staffing Services Webh Access,.gi

User: Susan Michaels (Murs. Super.)

Enter the Filter Criteria for Retrieving you current schedule below, then hit the Search button...

Facility: [Atlanta Medical Center =]
Start Date: |Saturday, March 23, 2002 j
Number of Days: m

Unit: et

Shift Status: [==tny=— =

Search | Reset | Back |

MicroStatfer Medical Staffing Sottware

warn micrastatter.cam

Copyright ®2002 [BCT Computer Systems Ine). All rights reseved.
Revised: March 07, 2002

| B

’_ ’_ | Intemet
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The Calendar format Customer schedule displays Orders and Shifts in a traditional calendar view.

J File Edit View Favoites Tools Help

/3 Scheduling & Stalfing Calendar - Microsoft Internet Explorer

J “=Back ~ = - i@ 7 | Q) Seaich i Favorites & 4 History |%- = R

J Address I@ http: /#207.252.79.104/eac/fac_schedule_cal.asp

=] oo || ks »

X : . . Hospitals %
Fa—te Medical Staffing Services
,csg 3 g Web Access . @
|C lendar for: Atlanta Medical Center |Frnm: 4/10/2002 |TO: 4/16/2002
Wednesday 04/10/02 | Thursday 04/11/02 Friday 04/12/02 Saturday 04/13/02 Sunday 04/1402 Monday 04/15/02 Tuesday 04/16/02
¥ ¥ Y ¥ Y ¥ ¥
Ussery, T
11.00P - 7:00AM T.00AM - 3.00PM (MS) (£:00AM - 7:00FPM Z:00AM - 3:00PM Z:00AM - F:00PK mﬂ 7004 - 3:00PM
i Urled rder |LE0) MS) (D) SchedulegiFimn |15
Unfilled Order Unfilled Order Unfilled Order Unfilled Order EC=[X]/ FC=[X] Unfilled Order
Ussery, T Ussery, T Ussery, T
3:00PM -11:00P M 3:00PM -11:00P 11.00BM - 7 D04 3:00PM -11:00PM 11-00BM - 7 004 7 O0AM - 7-00EM
(L&0) (&0) Ly (20 ncuy [La0)
Scheduled/Firm Scheduled/Firm Unilled Ordar Scheduled/Firm Uniilled Ordear Unfilled Order
EC=[¥]/ FC=[¥] EC=[¥] / FC=[] EC=[¥]/ FC=[¥]
Thornton, b Ussery, T
11.00PM - 7-00AM 11.00PM - 7-00AM EQEDDD;M S ?Lg‘%':;m e
(Lllgtl'ﬁed Order (Lllﬁrl';:?ed Order Scheduled/Firm Scheduled/Firm
EC=[X] / FC=[X] EC=[X] / FC=[x]
Thornton, b
11:00Ph - 70040
oo 11:00PM - 7:00AM
(PEDS) {L2D)
Scheduled/Firm Uniilled Order
EC=[x]/ FC=[x]
Conley, D
11:00PM - 7:00AK
[(Ls18)] —
Scheduled/Firm
EC=[¥] / FT=[X]
Back | LI
‘@ Done ,_’_|° Internet v

The List Customer schedule displays Orders and Shifts in a tabular format.

=] @60 || Links >

; Sample Medical Staffing Company Schedule List - Microsoft Internet Explorer
J File Edit View Favoites Tools Help
J 4= Back + = - i) it | (@ Search i Favorites & 4 History |%v = N R
| Address [ @] hitp. 44207 262 76.104/eac/schedule asp
= Hospital
= " = . . . ospitals
,’,&\ Medical Staffing Services Web Access -
!Q hedule for: Atl Medical Center |Frnm: 3/23/2002 |Tn: 4/5/2002
[ shit [ Date | Employee [ Stat | End [ Unit | HC [ HC | Status [ Type
[Evening  [3/24/2002 |[Thomas Ussery [3:00PM [[11:00PM L&D [ % | % |[Scheduled/Firm|[RN
[Evening  [3/25/2002 |[Thomas Ussery [3.00PM [[11.00PM [L2D [ % | % [Scheduled/Firm|[RN
‘Night ‘395&002 %ﬁ]ﬁ ‘11:DDF‘M ‘T:DDAM ‘F‘EDS ‘ b ‘ X [Scheduled/Firm |LPN
[ight [3/25/2002 |[Dawid Conley  [11:00PM |[7:0040 [iCU [ % | % |[Scheduled/Firm|[RN
[Evening  [3/26/2002 |[Thomas Ussery [3:00PM  [[11:00PM L&D [ % | X [Scheduled/Firm|[RN
[Evening  [3r28/2002 |[Thomas Ussery [300PM [[11:00PM L&D [ % | % [ScheduledFirm|[RH
‘nght ‘3!’28{2002 %ﬁ “H.DDPM ‘?.DDAM ‘F‘EDS ‘ * ‘ X |ScheduledFirm |LPN
[Evening  [3/29/2002 | Thomas Ussery [3:00PM  [[11:00PM L&D [ % [ % |[scheduledFirm|[RN
[Evening  [3/31/2002 |[Thomas Ussery [300PM - [[11.00PM [L2D [ % | % [Scheduled/Firm|[RN
[Evening  [471/2002 |Thomas Ussery [3:.00PM  [[11:00PM L&D [ % [ % |[3cheduledsFirm|[RN
‘Night ‘mfzmnz %ﬁqﬁ ‘11 0P ‘7 O AN ‘PEDS ‘ ® ‘ % [Scheduled/Firm|LPN
[Might [41/2002 ||Dawid Conley  [11:00PM |[7:004m [iCU [ % | % [Scheduled/Firm|[RN
[Evening  [4/2/2002 |[Thomas Ussery [3:00PM  [[11:00PM L&D [ % | % |[Scheduled/Firm|[RN
[Evening  [4/4/2002 |[Thomas Ussery [3:00PM  [[11:00PM L&D [ % | X [Scheduled/Firm|[RN
‘Night ‘mrzum %}ﬁ ‘11:DDPM ‘T:DDAM ‘F’EDS ‘ b ‘ X [Scheduled/Firm |LPN
[Evening  [4/5/2002 |[Thomas Ussery [3:00PM [[11:00PM L&D [ % | x [ScheduledFirm|[RN
Back |

|&] Done

[ |4 intemet

|
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Clicking on the Emplovee Name on both the Calendar and List view schedule, displavs basic Emplove Information.

<3 MicroStaffer Employee Information - Microsoft Intemnet Explorer

J File  Edit “iew Favortes Took Help

J GBack v = - (D Zat | ‘ChSeach [%]Favoites £ Histon ||%v =h L]

| Agdiess [#] hitp:/207.252.75.104/eac/ agent_detail aspPageni_id=11

e et s =
= f . . Hospitals _
e F\ Medical Staffing Services "\,/" AccesS®
il
Employee Detail
General Info
|Lasl Name: ‘Thurmun ‘Type: |LPN
|Firs1 Name: ‘Margar\ta ‘Gender: |F
[D.0.B: [1/5/1985
Licenses
| License Number ‘ Exp. Date | Issue Date | State | Hote | Description F
[ 2165947 | 2meoons || 2eacom [ wD | [Licensed Practical Murse
Certifications
| Description | Exp. Date | Issue Date ‘ State | Note
[acLs [ 6/12/2002 [ 6/12/2001 \ [
[cPR [ 5/15/2002 [ 5/15/2001 \ [
Health Screenings
| Description | Exp. Date | Issue Date | Note
[rug Sereen [ £/9/2002 [ £/3/2001 [
Llille LI
|@ Dane lili" Intemet 4

3 MicroStaffer Employee Information - Microsoft Internet Explorer

J File  Edit “iew Favortes Took Help

J GBack v = - (D Zat | ‘ChSeach [%]Favoites £ Histon ||%v = L

| Addhess [#] hitp://207.252.75.104/cac/agent_detail aspPagent_id=11

=] @60 ||Liks >

Health Screenings

[~

| Description | Exp. Date | Issue Date | Note
[Drug Sereen [ £/3/2002 [ £/3/2001 [

Skills
| Skill ‘ Description | Ranking | Years Held
[NEONATAL [Neonatal [ 4 [ 3+

Froficient, Able to Supervise

Ranking Legend: 1 =Theory, No Practice 2 = Intermittent Experience 3 = Able To Perform Independantly 4 =

Insurance Policies

| Description | Provider | Exp. Date | Issue Date | Note

[Professional Liability &N [EREZE [ 21242002 [
Employment History

| Employer ‘ Start Date ‘ End Date Unit Hote

|No records returned,

Documents List

| Description
|Ma|graclice Insurance Palicy
Back l

|@ Done

SR

’7 ’7 " Intemet
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/2§ http://207.252.75.104/eac/doc_view_load. asp?doc_id=2 - Microsoft Internet Explorer

J File Edit View Favoites Toolz Help

J dBack + = - 7 | G Search [ Favortes & History |%v =N ]

Documents scanned into MicroStaffer can also be displayed by clicking on their Hyperlinks in the Employee profile.

J Address I@ http: /#207.252.75.104/eac/doc_view_load.asp?doc_id=2

pL/21/1994 2::58

e i
A it R

Z = @
ELTZABETH N7 07208-3323

O R g ———
“ IIEALTHCARE PROVIDERS SERVICE
| e L ORGANIZATION PURCHASING GROUP nnsq

S s of Insurance D222

PRODUCER BRANCH | PREFX POLICY NUMBLR POALICY PERION

018098 - 870 | HPG e | 04/10/01 T0 04/10/02

A A TSRS TR
Adminbi
NAME OF INSURED AND ADDRESS {Number & Sireni, City. S & Zip) mh Peder
139 B Conmty Lise Road
o e = Hamern, PA 1 2000-{318

Insurance provided by
American Casualty

; Company of Reading, PA

Madical Spoalany; Regisierod Nurge Code: 30564 401 Penp St., Reading, PA 19603
Additiona) Inssred A
Lotation

B.

LIMITS OF LIABILITY COVERAGL PART
TR
Per Ocswrence Aggreguic

Al51,000,000.00 |9 3,000,000.00

FROFRUSIONAL LIABKLITY, INCLUDING GUOD
AN

INDIVIDUAL WORKFLACE LEARILITY ¥XTENSION

il

-

‘@ Done

’7 ’7 |O Internet
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2. Entering Orders On-Line

Clients/Facilities can enter new orders into the MicroStaffer Web Access Module. Once submitted, the order information
flows into the MicroStaffer User Notifications window. Only MicroStaffer users who have been assigned as Account Reps to
the submitting Client will be notified of these orders and be able to process them. In effect, they act as ‘Gatekeepers’ and
control the flow of New Orders from clients into MicroStaffer.

Notifications will be posted during Login into MicroStaffer and also anytime the user is in the MicroStaffer system.

Below is a typical Order Entry form.

/3 New Order Entry - Microsoft Internet Explorer M=

J File Edit View Favoites Toolz Help ‘

J dBack + = - 7 | G Search [ Favortes & History |%v =] -2

| Addhess [@] hiip:/207.252.75.104/eac/order_enty. aspTkey=14 x| @60 |j Links »

-

A
S

; ; ; Hospitals %
7 f\ Medical Staffing Services ',/ Access,,.gi

Enter the Criteria for your need(s) below, then hit the Submit button...

[pate: [oncay, March 25, 2002 7]

|Shift: [Day.(7004M - 300PM) =

|Uniu’Area: m

|Employee Type: ‘l (RN - Registered Nurse j

|Ski|l: Jtcow - Criteal Core =l

|0rder Quantity: ‘IE

e e o e o

Submit | Reset | Back |

MicroStatfer Medical Staffing Software
vy, microstatfer.com

‘@ Dane ’7’7|. Internet

LB
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Once the order has been submitted, a confirmation page is displayed which the Customer may view and print.

a Mew Order Confirmation - Microsoft Internet Explorer

J Fle Edit View Favoites Tools Help

J 2 Back - = - @ 4 | @Saalch (k] Favorites @Histow |%- =] - D

J Address I@ hittpe /4207, 252.75.104/eac/arder_entry_conf.asp?hatch_id=61

'S Web Access ..

_-~cﬁ—"\;: . 3
== Medical Staffing Services "9Fals §
A

=l @ro ||k >

Your Orders have been forwarded as listed below:

|Faci|ily: |At|anta Medical Center
[pate: [3r252002

[Shife: [Day....c7:004M - 3:00PM)
[univarea: icu

|Emp|uyee Type: |RN

[skin: [ccu

|0rder Quantity: |3

Please send Sarah Jones, Tarmmy Smith and Ellen Jackson. | already spoke with thern

Comment/Note: and they can

Click Here to Enter Additional Orders |

MicroStatfer Medical Staffing Sottware

i, microstaffer. com

Copyright @ 2002 [DCT Computer Systems Ine.]. All rights resenved.
Revised: March OF, 2002

3]

’_ ’_ | Intemet

B

199



MicroStaffer User Manual 200

Copyright [1 1999-2005 DCT Computer Systems Inc.

3. Viewing of Published Invoices

After Client logs in they select View Invoices and selects criteria in which to view invoices.

2} Medical Staffing Agency Web Access Main Menu - Microsoft Internet Explorer

Fle Edt View Favorites Took Heln | o

DBack ~ ) - x 2] »| 0 Search - Favorites @ Media £ | (- L B

Address [{] hitp:fwn microstaffer comfwebmodulefmain_meny_far. asprkey=18 =] Edeo |unks >
N

S . ; ; Hospitals ?
,//‘:\ Medical Staffing Services "yy7 "2 oo

Welcome: Zally Inman - Chester County Hospital

Please select an Option from one of the following items:

Staffing & Scheduling (List Wiew)
Staffing & Scheduling (Calendar]

Mews Order Entry
Wiew Invoices

Micro Staffer Medical Staffing Software

wmw microstatfer.com

Copyright @ 1998 - 2005 [DCT Computer Systems Inc.]. All rights reserved.
Build 130 & Higher Compatible Revissd: January 03, 2005

&) [ [ @ trusted stes _/,I
Mistart| | (@ @  |[&] Medical staffing Agen... By 1052 am
B invorce st -prcrosoft internet xplorer —_________________________  mEE
File Edt Wiew Favorites Tools Help | &
@Back - ) - [¢] [ | ) search < Favories & Meda ) | (U o B
address [&] s . microstaffer comfwebmoduls finvoice_list asp B Go |Lunks =
. . . Hospitals ¥
Medical Staffing Services ng Access, X
| Invoice No. ‘ Date ‘ Amount | Howrs
[ 20280 I 17772004 I 1,328.00 2100
20285 111472004 2,448 00 41.00
20292 1/23/2004 0.00 1.00
20303 2/3/2004 0.00 1.00
20313 2/25/2004 11,372.75 208 00
20316 31472004 263675 6675
20321 3/11/2004 8,507.50 190,00
20327 3(31/2004 7.922.00 186 25
20334 41212004 9,031.00 227 50
20341 5/14/2004 549,00 15.50
20352 10/21/2004 13,309.63 237.50
20367 11/15/2004 8,505 88 13575
20369 11/18/2004 424 00 800
20378 11/24/2004 9,975.31 165.25 |
20386 12/1/2004 £26.00 3450
20399 1/28/2005 17,307.07 27875
Total Amount Billed: 94,142.89
Total Hours Billed: 1.217.75 =
7] [ | | | Trusted sites v

t'Startl | @2 & || €] invoice List - Microso... & b 1056 am
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D. On-Line Applications

The MicroStaffer Web Access Module allows applicants to enter employee profile data from any Web Browser. They may
even paste in their entire resumes.

Information gathered on the On-Line application form flows into the MicroStaffer Notifications window. Only MicroStaffer users
who have the ‘Review On-Line Applicants’ checkbox on the User Setup Window checked, will see New Applicant data in this
window.

Users may then forward the application into the MicroStaffer Employee Leads window or they may delete it. Once in the
Employee Leads window, the information can then be transferred into the Employee window or be deleted.

2 On-Line Application - Microsoft Intemet Explorer
| Fle Edt View Favaites Toos Help \
| «Back » = - @ [ 4| @scach [ Favoies AHisoy | 5y S @ - 2
| Address (@] hitp://207.252.76.104/cac/agenl_leads.asp7key=1 x| @60 |j Links »
T =
Welcome to Medical Staffing Services On-Line Application!
Please complete the following On-Line Application and Click the Submit button...
= Indicates required field
FirstHame=  [Sarah M.L.: It
|Lasl:" (itter
|Addres:* [4523 E st 45th Street
| ot 4508
(city: [Newvark state: [Ny o [zip: [0z
|Hume Phone: [12-295-0305 |Wurk Phone:  |[212-866-2367
|Other Phone: [iz77e1234 Description: [Cel | |
|Type: [Rr =l ‘Gender: ||F_Ll |D.0.B 72387 (rmddfyy)
|Emai|: [smiller345@home.com
|Pager Email: ‘lsmil\er444@pagemail net
cetl Emait: |
| Skills
‘ Skill ‘ Ranking (Optional) ‘ Date A'(:g;fi'u"n"algmmm’)
| Jeoo 5 [4-Proficen Able o Supervise ¥] | [arz387
| [Picu = [4-Proficient Able to Supervise ] ‘ [55/0m
| [ecc = 3 - Able To Pertom Independanty | ‘ [2r28/91
| | HICL j 2 - [ntermittent Experience ‘ |5;’2 395 Ll
[&] Done [ | Intemet 7
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J GBack v = - (D 7t | ‘ChSeach [%]Favoites £ Histon ||%v =1 ]
| Addess @] hitp://207.252.75.104/eac/ agent_leads. aspPhep=1 =| @6 |j Links *
T T = T s — g Tr==r ~
| [Picu =l [4-Proficient Avle to Supervise j| [56r0m
| |ECC =l |3-Able To Perform Independantly =] | [er28/91
| INICU j ‘IEfIntermmem Experience j | |5j23j95
L H | Hl
C +
I will forward all my paperwork via Express mail. Please ;l
zall me Lo Set up an interview date.
[ -
Resume:
Paste your R MNursing Resume -
Resume
Here-> SARAH MILLEE|
[For Help on E-Mail SylvanfCommunity.net <MAILTO:SvlvanfCommunity.net:>
haw to Copy || ;415) z@1-5883
and Paste Current Chjectiwve: Per Diem R.H. position
Click here . |HTGHLIGHTS OF QUALIFICATIONS
Twenty years of health care experience
Extensive critical care nursing assessment skills
RELATED EZPERIENCE LI —
Submit | Reset | Back |
[~
&1 Dore l_l_‘ﬂ Intermet o
tl n-Line Application - Microsoft Internet Explorer = |E||5|
i J File Edit “iew Favoites Tools  Help

J dBack v = - (D it | Ql Search (3] Favortes 4 History ||%v = B -

|| Addhess [£] htp.//207.252 75104 /23 agent _leads. aspkey=1

j @ Go H Links >

T T — | T ™ — ) T |
! ‘ |PiCU =l |[4-Proficient Able to Superdse ] | [ss5ia0
- [Ecc 5l [3-AbleToPerdorm ndependanty =] | [erzea1
! oo Fl  [2-merminent Expenence <1l [
I — —
¢ ‘ I j fou may paste your resume using any Waord Processor
I—;I such as MS Word, Motepad, YWordPad or WordPerect.
< I - To do so0, you must copy all the text from your Resume
’7 inta the Windows Cliphoard —
e ’ﬁ For example, using M3 YWord: —
Comments: 1. Open your Resume uang M3 Word
! I will 2. From the menu, select Edit->Select Al (or press =]
i call m CTRL-A on vour keyboard)
3. From the menu, select Edit->Copy [or press =
i CTRL-C on your kevboard.
I Resume: 4. Return to the On-Line applcaton and postion
Easte FOUr IR Hur vour cursor on the Resume Tmport text box ?
gsume
e Here-> ShRAE 5. Press CTRL-V on your keyboard
ForHelpon  |(E-Mail .
how to Copy || 415) That's it...
and Paste Curren
I Click here HIGHLI
Twenty LI
Extensive critical care nursing assesswent skills
I RELATED EXPERIENCE =l =
1 Submit | Reset | Back |
=
ﬂ@ Dane ’_’_|. Internet 7
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X. Import/Export of Data

A. System Data Import

1. Importing System Data Overview

The MicroStaffer System Data Import Utility allows you to import data into select areas of the MicroStaffer system such as
Employee and Customer records.

The utility is designed to be used when first starting up a new MicroStaffer system. Continued importing of data is not
recommended.

Please note the following when performing any type of System Data Import:

1. Itis STRONGLY RECOMMENDED that you first make a backup of your database before performing any type
of System Data Import.

2 To access the Import Utility, click on the System button, then select Import.

3. Every column specified in the Import column list MUST be in the source text file. Even if the column is not required,

you must include it in the source text file. In the case of blank or unknown values, just leave a zero space character.

4, The import source file MUST be a tab delimited text file.
5. The import source file MUST NOT have any column headings.
6. The import process will attempt to insert or update as many records as possible that pass validation. You may view

the Error Log file to view the error messages and line numbers that failed during the import.

It is strongly recommended that you first create a data source (eg. a temporary database table) that mimics the data struc-
ture specified for the import. This will ensure that there are no validation errors occurring from mismatched data types of data
lengths.
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2. Importing Employee Records into Microstaffer

Itis possible to Insert and Update Employee Records in MicroStaffer from and external text file. To import or update records
using and External File, click on the System button and Select Import. This file must be a tab delimited text file with NO
HEADERS and must conform to the following data specifications:

Importing Employee Records into MicroStaffer

Column Order | Data Type | Required | Details
External ID 1 CHAR (15) N You may import any ID type filed from the source
system.
Active Flag 2 CHAR (1) N A=Active, I=Inactive
Last Name 3 CHAR (30) Y
First Name 4 CHAR (20) Y
Middle Initial 5 CHAR (1) N
Social Security Number | 6 CHAR (11) Y Must be formatted as: ###-#H#-#####. Duplicates not
allowed. Key field.
System ID 7 CHAR (10) N Leave Blank. Internal use only.
Address1 8 CHAR (30) Y
Address2 9 CHAR (30) N
City 10 CHAR (30) Y
State 11 CHAR (3) N
Zip 12 CHAR (10) N
Phone_1 13 CHAR (15) N
Phone_2 14 CHAR (15) N
Phone_3 15 CHAR (15) N
Phone_1_description 16 CHAR (25) N
Phone_2_description 17 CHAR (25) N
Phone_3_description 18 CHAR (25) N
Sex 19 CHAR (1) N M=Male, F=Female
Date of Birth 20 CHAR (10) N Valid formats: MM/DD/YY or MM/DD/YYYY
Company ID 21 CHAR (10) N Leave blank. Internal use only.
Date Hired 22 CHAR (10) N Valid formats: MM/DD/YY or MM/DD/YYYY
Date Terminated 23 CHAR (10) N Valid formats: MM/DD/YY or MM/DD/YYYY
Email 24 CHAR (70) N
(2) N

Pay Frequency 25 CHAR DY=Daily, WK=Weekly, BW=Bi-Weekly, SM=Semi-
Monthly, MO=Monthly, QA=Quarterly, SA=Semi-
Annually, AN=Annually

Employee Type Code 26 CHAR (5) N These MUST correspond to a valid Employee Type
Code as defined within MicroStaffer. Codes not

located will be added to the Employee Type List.

Employee Type 27 CHAR (40) N When you specify the Employee Type code and it is

Description not found in MicroStaffer. The import process will
add it to the list of employee codes and use this
description.

Federal Filing Status 28 INTEGER N 1=Single, 2=Married, 3=Head of Household,
4=Supplemental

Federal Allowances 29 INTEGER N

Lead Indicator 30 INTEGER Y 1=Lead or Candidate, 0=Regular Employee

Region Type Code 31 CHAR (5) N Leave blank for no region.

Region Description 32 CHAR (50) N A descriptive name for region if it does not exist in

MicroStaffer.
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3. Importing Employee Certification Records

Employee Certifications Import Specifications

Note: When importing Certifications into MicroStaffer, the corresponding employee record must exist. The employee record
is located using the Social Security Number specified in the import file.

Existing Certification records are updated. Certifications are located using the Certification Type Code and State Code.

Column Order Data Type Required | Details

Social Security 1 CHAR (11) Y Must be formatted as #Hf-##-#HHE. Must

Number exist in the Employee Table.

Certification Type | 2 CHAR (5) Y Must exist in the Company certifications list.

Code If not found, it will be added to the Company
Certifications list during the import.

Certification 3 CHAR (40) N Used if the Certification Type Code does not

Description exist in the Company Certifications list. If

omitted and Certification Type Code is not
found, Certification Type Code will be used
as the description.

Expiration Date 4 CHAR (10) N Specifies the Certification expiration date.
Valid formats: MM/DD/YY or MM/DD/YYYY

Enable Tickler 5 INTEGER Y Indicates whether you wish to enable the

Flag Certification Expiration Tickler. 1=Enable,
0=Do Not Enable

Tickler Days 6 INTEGER Y Indicates the number of days before

Certification Expiration at which the Tickler
should appear. You must set the Tickler Flag
to 1 for this to work. A negative number
indicates the days BEFORE expiration
occurs. A positive number indicates the
number of days AFTER expiration. For
example, -7 indicates that the tickler should
fire 7 days before the Certification expires.

Issue Date 7 CHAR (10) N Specifies the Certification issue date. Valid

formats: MM/DD/YY or MM/DD/YYYY
State Code 8 CHAR (2) N Indicates the State for this Certification.
Comment 9 CHAR (255) N

Employee Certification Import Specifications
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4. Importing Employee Health Screening Records

Employee Health Screenings Import Specifications

Note: When importing Health Screenings into MicroStaffer, the corresponding employee record must exist. The employee
record is located using the Social Security Number specified in the import file.

Existing Health Screening records are updated. Health Screening are located using the Health Screening Type Code.

Importing Employee Health Screening Records

Column Order | Data Type Required | Details

Social 1 CHAR (11) Y Must be formatted as: ##H##-#H-#HHHE. Must

Security exists in the Employee table.

Number

Health 2 CHAR (5) Y Must exist in the Company Health

Screening Screenings list. If not found, it will be added

Type Code to the Company Health Screenings list
during the import.

Health 3 CHAR (40) N Used if the Health Screening Type Code

Screening does not exist in the Company Health

Description Screenings list. If omitted and Health
Screening Type Code is not found, health
Screening Type Code will be used as the
Health Screening Description.

Expiration 4 CHAR (10) N Specifies the Health Screening expiration

Date date. Valid formats: MM/DD/YY or
MM/DD/YYYY

Enable 5 INTEGER Y Indicates whether you wish to enable the

Tickler Flag Health Screening Expiration tickler.

Tickler Days 6 INTEGER Y Indicates the number of days before Health
Screening Expiration at which the Tickler
should appear. You must set the Tickler
Flag to 1 for this to work. A negative
number indicates the days BEFORE
expiration occurs. A positive number
indicates the number of days AFTER
expiration. For example, -7 indicates that
the tickler should fire 7 days before the
Health Screening expires.

Issue Date 7 CHAR (10) N Specifies the Health Screening issue date.
Valid formats: MM/DD/YY or MM/DD/YYYY

Comment 8 CHAR (255) N
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5. Importing Employee Insurance Policy Records

Employee Insurance Policies Import Specifications

Note: When importing Insurance Policies into MicroStaffer, the corresponding employee record must exist. The employee
record is located using the Social Security Number specified in the import file. Existing Insurance Policy records are up-
dated. Insurance Policies are located using the Insurance Policy Type Code and State Code.

Column Order | Data Type Required | Details
Social 1 CHAR (11) Y Must be formatted as: #HE-##-HHHHE.
Security Must exist in the employee table.
Number
Insurance 2 CHAR (5) Y Must exist in the Company Insurance
Policy Type Policy list. If not found, it will be added
Code to the Company Insurance Policy list
during the import.
Insurance 3 CHAR (40) N Used if the Insurance Policy Type Code
Policy does not exist in the Company
Description Insurance Policy list. If omitted and
Insurance Policy Type Code is not
found, Insurance Policy Type Code will
be used as the Insurance Policy
Description.
Policy 4 CHAR (50) N
Provider
Policy 5 CHAR (25) N
Number
Coverage 1 6 DECIMAL N
(12,2)
Coverage 2 7 DECIMAL N
(12,2)
Coverage 3 8 DECIMAL N
(12,2
Coverage 4 9 DECIMAL N
(12,2
Deductible 1 10 DECIMAL N
(12,2
Deductible 2 | 11 DECIMAL N
(12,2)
Expiration 12 CHAR (10) N Specifies the Insurance Policy
Date expiration date. Valid formats:
MM/DD/YY or MM/DD/YYYY.
Enable 13 INTEGER Y Indicates whether you wish to enable
Tickler Flag the Insurance Policy Expiration tickler.
1=Enable, 0=Do Not Enable
Tickler Days | 14 INTEGER Y Indicates the number of days before
Insurance Policy Expiration at which the
Tickler should appear. You must set the
Tickler Flag to 1 for this to work. A
negative number indicates the days
BEFORE expiration occurs. A positive
number indicates the number of days
AFTER expiration. For example, -7
indicates that the tickler should fire 7
days before the Insurance Policy
expires.
Issue Date 15 CHAR (10) N Specifies the Insurance Policy issue
date. Valid formats: MM/DD/YY or
MM/DD/YYYY.
State Code 16 CHAR (2) N Indicates the State for this Insurance
Policy
Comment 17 CHAR (255) N
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6. Importing Employee License Records

Employee Licenses Import Specifications

Note: When importing Licenses into MicroStaffer, the corresponding employee record must exist. The employee record is
located using the Social Security Number specified in the import file.

Existing license records are updated. Licenses are located using the License Type Code and State Code.

Column Order | Data Required | Details
Type

Social 1 CHAR Y Must be formatted as: ##H-##-##HHE. Must exist in

Security (11) the Employee Table.

Number

License 2 CHAR (5) | Y Must exist in the Company Licenses list. If not

Type Code found, it will be added to the Company Licenses
list during the import.

License 3 CHAR N Used if the License Type Code does not exist in

Description (40) the Company Licenses list. If omitted and License

Type Code is not found, License Type Code will
be used as the License Description.

License 4 CHAR N

Number (25)

Expiration 5 CHAR N Specifies the license expiration date. Valid

Date (10) formats: MM/DD/YY or MM/DD/YYYY.

Enable 6 INTEGER | Y Indicates whether you wish to enable the License

Tickler Flag Expiration tickler. 1=Enable, 0=Do Not Enable.

Tickler Days | 7 INTEGER | Y Indicates the number of days before License
Expiration at which the Tickler should appear.
You must set the Tickler Flag to 1 for this to work.
A negative number indicated the days BEFORE
expiration occurs. A positive number indicates the
number if days AFTER expiration. For example, -
7 indicates that the tickler should fire 7 days
before the license expires.

Issue Date 8 CHAR N Specifies the license issue date. Valid formats:

(10) MM/DD/YY or MM/DD/YYYY.
State Code | 9 CHAR(2) | N Indicates the State for this license.

Comment 10 CHAR N
(255)
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7. Importing Employee Skills List Records

Note: When importing Skills into MicroStaffer, the corresponding employee record must exist. The employee record is

Employee Skills List Import Specifications

located using the Social Security Number specified in the import file.

(10)

Column Order | Data Required | Details
Type
Social Security 1 CHAR |Y Must be formatted as: ##H-#H#E-#HHHE. Must exist in the
Number (11) Employee table.
Skill Code 2 CHAR |Y Must exist in the Company Skills List. If not found, it will
(10) be added to the Company Skills list during the import.
Skill Description 3 CHAR | N Used if the Skill Code does not exist in the Company
(40) Skills list. If omitted and Skill Code is not found, the Skill
Code will be used as the Skill Description.
Skills Ranking 4 CHAR | N A ranking associated with the skill. Must exist in the SkKill
Code (1) Ranking list within MicroStaffer. If not found in the Skills
Ranking list, it will be added to this list during the import.
Skills Ranking 5 CHAR |Y Used if the Skill Ranking Code does not exist in the Skills
Description (50) Ranking List. If omitted and Skill Ranking Code will be
used as the Skill Ranking Description.
As of date 6 CHAR | N Specifies the date the skill was attained. Valid formats:

MM/DD/YY or MM/DD/YYYY.
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8. Importing Customer Records

Customer/Facility Base Data Import Specifications

located using the Social Security Number specified in the Employee Record.

Notes:

Note that ALL columns listed above must be in the import file. Leave blanks for unknown or missing values.
Customer name is the Key field used in this import. If a records exists with the same Customer name field, that
record is updated not inserted.
However, shift information (i.e. shift types 1 through 5) are never updated.
Shift information for Shift 1 MUST be fully specified (i.e. Name, Type, Start Time, End Time). Note that MicroStaffer
customer records MUST contain at least one shift type.

Shift information must be fully specified in Sequence. For example, if you specify information for Shift 4 but omit
data for Shift 3, Shift 4 information will NOT be imported.

Shift Start time and End time cannot be the same.

Column Order | Data Required | Details
Type
Customer Name | 1 CHAR |Y If the customer already exists, the import job
(50) will update the existing record using the
Customer Name as the key field.
Address 1 2 CHAR N
(30)
Address 2 3 CHAR N
(30)
City 4 CHAR | N
(30)
State 5 CHAR | N
(3)
Zip Code 6 CHAR | N
(10)
Phone Number 1 | 7 CHAR N
(20)
Phone Number2 | 8 CHAR N
(20)
Phone Number 3 | 9 CHAR N
(20)
Phone Number 4 | 10 CHAR | N
(20)
Phone Number 1 | 11 CHAR N Eg. Main office, Nursing office etc.
Description (25)
Phone Number 2 | 12 CHAR N
Description (25)
Phone Number 3 | 13 CHAR | N
Description (25)
Phone Number 4 | 14 CHAR | N
Description (25)
Fax Number 1 15 CHAR | N

(20)
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Fax Number 2 16 | CHAR N
(20)
Fax Number 1 17 | CHAR N
Description (25)
Fax Number 2 18 | CHAR N
Description (25)
Contact 1 19 | CHAR N
(30)
Contact 2 20 | CHAR N
(30)
Contact 3 21 | CHAR N
(30)
Contact 4 22 | CHAR N
(30)
Contact 1 23 | CHAR N
Description (25)
Contact 2 24 | CHAR N
Description (25)
Contact 3 25 | CHAR N
Description (25)
Contact 4 26 | CHAR N
Description (25)
Invoice Attn. to 27 | CHAR N
Note (50)
Invoice Payment 28 | CHAR N
Terms (25)
Invoice Acct./PO# 29 | CHAR N
(15)
External ID 30 | CHAR N | Use this field to insert Customer ID Number from
(20) another system.
Orientation 31 | INTEGER | N | 1=Orientation if Required, 0=Orientation is NOT
Indicator required. Defaults to 0O if left blank.
Inactive Indicator 32 | INTEGER | N | 1=Customer is NOT active, 0=Customer is Active.
Defaults to 0 when left blank.
Email 1 33 | CHAR N
(70)
Email 2 34 | CHAR N
(70)
Email 3 35 | CHAR N
(70)
Email 1 Desc. 36 | CHAR N
(30)
Email 2 Desc. 37 | CHAR N
(30)
Email 3 Desc. 38 | CHAR N
(30)
Billing Customer 39 | CHAR N | Use only when the Billing Address Indicator is set to
Name (50) 1.
Billing Address 1 40 | CHAR N
(30)
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Billing Address | 41 | CHAR N
2 (30
Billing City 42 | CHAR N
(30)
Billing State 43 | CHAR(3) | N
Billing Zip 44 | CHAR N
(10)
Billing Address | 45 | INTEGER | N | Setto 0 if you want to use Billing information that is different from the standard
Indicator Customer Name & Address. Set to 1 if you want to set the Billing Name &
Address the same as the regular name & Address. Defaults to 1 when left
blank.
Region Type 46 | CHAR (5) | N [ Use this code to identify the Geographical Region for this Customer.
Code
Region 47 | CHAR N [ Used if the Region Type Code does not exist in the Company Region list. If left
Description (50) blank and Region Type Code is not found, Region Type Code will be used as
the Region description.
Shift 1 Name 48 | CHAR Y | A descriptive name for the shift. Examples are Day 8, Day 12 etc. REQUIRED.
(40)
Shift 1 Type 49 | CHAR (1) | Y [ Valid Types are: D=Day, E=Evening, N=Night. REQUIRED.
Shift 1 Start 50 | CHAR Y | A string whose value is a valid time (such as 8:00, 10:15, 20:30). MicroStaffer
Time (10) determines whether the time is am or pm based on a 24 hour clock.
REQUIRED. MUST be in increments of 15 minutes (7:33 am is not allowed.
Use 7:30 am or 7:45am)
Shift 1 End 51 | CHAR Y | See Shift 1 Start Time for validation. REQUIRED. Cannot be the same as Start
Time (10 Time.
Shift 2 Type 52 | CHAR (1) | N | Valid types are: D=Day, E=Evening, N=Night.
Shift 2 Name 53 | CHAR N | A descriptive name for the shift. Examples are Day 8, Day 12, etc.
(40)
Shift 2 Start 54 | CHAR N | See Shift 1 Start Time for validation.
Time (10
Shift 2 End 56 | CHAR N | See Shift 1 Start Time for validation.
Time (10
Shift 3 Name 57 | CHAR N | A descriptive name for the shift. Examples are: Day 8, Night 12, etc.
(40)
Shift 3 Type 58 | CHAR (1) | N | See Shift 1 Start Time for validation.
Shift 3 Start 59 | CHAR N | See Shift 1 Start Time for validation.
Time (10)
Shift 3 End 60 | CHAR N | See Shift 1 Start Time for validation.
Time (10
Shift 4 Name 61 | CHAR N | A descriptive name for the shift. Examples are Day 8, Day 12, etc.
(40)
Shift 4 Type 62 | CHAR (1) | N | Valid Types are: D=Day, E=Evening, N=Night.
Shift 4 Start 63 | CHAR N | See Shift 1 Start Time for validation.
Time (10)
Shift 4 End 64 | CHAR N | See Shift 1 End Time for validation.
Time (10
Shift 5 Name 65 | CHAR N | A descriptive name for the shift. Examples are Day 8, Day 12, etc.
(40)
Shift 5 Type 66 | CHAR (1) | N | Valid Types are: D=Day, E=Evening, N=Night.
Shift 5 Start 67 | CHAR N | See Shift 1 Start Time for validation.
Time (10)
Shift 5 End 68 | CHAR N | See Shift 1 End Time for validation.
Time (10)
Units/Work 69 | CHAR N | A comma separated list of Units or Work Areas for this Customer. Each unit
Areas List (255) must be no longer than 10 Characters. Eg. MICU, SICU, MS, ER.
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B. Peachtree Accounting Import

1. Peachtree Accounting Import/Export & DDE Overview

MicroStaffer’s Invoicing and Payroll modules are fully integrated with Peachtree Accounting’s Accounts Receivable and
Payroll systems.

To enable the transferring of data into Peachtree it is required to complete an extensive one-time setup that will facilitate the
accurate synchronization of data between the two systems.

Note also that for Payroll transfer, you must process payroll using MicroStaffer’s built-in payroll tax module.

The following is a step-by-step guide that will help you in setting up the Import/Export and DDE mechanisms between
MicroStaffer and Peachtree Accounting (Version 8 or higher)..

Peachtree Payroll Import & DDE Setup Overview

1. Synchronizing Earnings, Tax, Deduction and Contribution items between Peachtree and MicroStaffer.
2. Synchronizing Employees between Peachtree and MicroStaffer.
3. Setting up the Check Export Item Settings for Earnings, Taxes, Deductions and Contributions in MicroStaffer.

4. Importing Payroll Journal Entries into Peachtree Accounting.

Peachtree A/R Import & DDE Setup Overview

5. Synchronizing Customers between Peachtree and MicroStaffer
6. Exporting Invoice entries from MicroStaffer

7. Importing Sales Journal Entries from MicroStaffer into Peachtree
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2. Peachtree Payroll Item Synchronization

In order to be able to transfer Peachtree payroll journal entries from MicroStaffer, it is required that all necessary payroll items
be created in MicroStaffer and Peachtree Accounting.

MicroStaffer’s payroll module comes with a set of pre-defined taxes which can be viewed on the System Settings and
Utilities window’s Taxes Tab.

It is imperative that all deductions and taxes be set up properly in MicroStaffer in order for the payroll import to be effective.
This includes the creation of Employer Tax fields in MicroStaffer. This must be done by the MicroStaffer user manually.

For example, below is a list of common tax items you may find in a typical company.

Gross Pay (Salary)
Federal Income Tax
FICA (Employee)
Medicare (Employee)
State Tax (Employee)
FICA (Employer)
Medicare (Employer)
State Disability (Employer)
. FUTA (Employer)

0. 401(K) (Employee)

1. 401(K) (Employer)

220NN =

Note that while items 1 though 4 can be assigned to an employee by using the MicroStaffer system supplied taxes, you
must create the other items (FUTA, FICA(Employer) etc.) yourself using the System Settings and Utilities window’s Taxes
Tab. Here you can create custom deductions and taxes which can then be assigned to employees.

Note that only ‘Employee’ taxes get deducted from pay checks in MicroStaffer. Employer taxes are used only for the
purposes of tracking expenses and liabilities and, of course, transferring to Peachtree or other accounting systems.

Itis MOST IMPORTANT that, when using the Peachtree Import Utility or DDE, any tax or deduction item that is being
transferred to Peachtree also exists on the Employee Record within Peachtree. The transfer will fail otherwise. For ex-
ample, if you are exporting a 401(K) deduction for a payroll check in MicroStaffer, you must have the same 401(K) deduction
activated on the employee record in Peachtree. We therefore recommend that you include any and all taxes and deductions
on the Default Taxes list within Peachtree so that whenever an employee is being imported or created in Peachtree that all
these are assigned.

Once you have created all desired taxes, deductions and contributions within MicroStaffer, you must then ensure that
Peachtree earnings and taxes are also set up correctly.

Here are several guidelines that must be followed:

1. Each Peachtree employee must have ‘Salary’ listed and checked with GL Account 77500 on the ‘Maintain Employees/
Sales Reps’ window in Peachtree. Salary MUST be the first item listed on the ‘Pay Info’ tab.

2. All Employee and Employer tax fields that are being used in MicroStaffer must be checked in Peachtree on the EmployEE
and EmployER tabs on the ‘Maintain Employees/Sales Reps’ window in Peachtree.
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3. Peachtree Employee Synchronization

In order to be able to Transfer Payroll Journal entries to Peachtree Accounting it is required that each payroll record sent from
MicroStaffer have a matching Employee ID record in Peachtree.

MicroStaffer uses the ‘External ID’ field on the Employee record for this purpose. Itis the MicroStaffer user’s responsibility to
ensure that each MicroStaffer Employee’s External ID field matches with it's Employee ID counterpart in Peachtree.

While you may achieve this synchronization manually, MicroStaffer also allows you to both populate the MicroStaffer Em-
ployee External ID systematically as well as export Employee Records into Peachtree using both the MicroStaffer Export

window and/or DDE.

Note: If you are planning to use DDE only to transfer and maintain Employee Records between MicroStaffer and
Peachtree you must only complete Steps | and lll below. You do not have to create the MicroStaffer Export file

thatis.

l. Maintaining the External ID Field

I.  Populating the MicroStaffer Employee External ID Field
It is possible to set every Employee External ID field in Microstaffer by accessing the Employee Setup window in
MicroStaffer and then selecting Utilities->Set All External ID’s to...

A. System ID: Sets all External ID fields for all employees to the MicroStaffer internal System ID.
B. S.S. Number: Sets all External ID fields for all employees to the employee’s Social Security Number.
C. Name Alpha-Key: Sets all External ID fields to the employees last name. Duplicates will be set to last

name + internal system ID.

ll. Creating the Employee Export File

Once all External ID’s in MicroStaffer have been set, you may then use the MicroStaffer Employee Export utility for
Peachtree to export employee records into a comma separated text file (CSV) for import into Peachtree.

To create the CSV file, click on System-> Export Data. Once this window opens:

1.
2.
3

Select ‘Employee Record(s): Peachtree Accounting Format’ from the ‘Export Format’ dropdown.
Enter the file name to save the data to in the ‘Export File’ field. For example, C\EMPLOYEE.CSV
Select the Employee(s) to export. Note, to select multiple employees click on each record using
the Mouse while holding down the CTRL key or Shift key. You may also click on the ‘Select All
button to select all records.

Finally, click on export to create the export file.
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lll. Importing Employees into Peachtree

Once the export file has been created (C:\EMPLOYEE.CSV), start Peachtree Accounting and do the following to import the
Employee records:

a. Click on File->Select Import/Export from the main menu within Peachtree.

b. Click on Payroll then Employee List then click on Import from the Toolbar. The Employee List window will open.

c. Onthe ‘Fields’ tab begin by clicking on the Show None button. Then on the ‘Field Settings’ list click each ‘Show’
column in this EXACT order:

1 Employee ID

2 Employee First Name

3 Employee Middle Initial

4. Employee Last Name

5. Employee

6

7

8

9

Inactive
Address Line-One
Address Line-Two
. City
10. State
11. Zip
12. Employee Social Security #
13. Employee Type
14. Telephone

15. Email
16. Federal Filing Status
17. Federal Allowances

18. Additional Fed Withholdings
19. Date Hired

20. Date Terminated

21. Pay Method

22. Pay Frequency

23. Pay Info-Use Standard 1

The numbers under the ‘Col # field on the Peachtree Fields List must match those numbers above.

d. Next, click on the ‘Options’ tab

e. Under ‘Import Options’ check ‘First Row Contains Headings’. This MUST be checked!

f.  Under ‘Import/Export file select the file that was used in Step B above.

g. We now recommend that you click on the ‘Save’ button to save the Import Template. This way, any time you wish to
update the employee records or import new additions to the employee list, you can simply access the Saved Employee
Template which will contain all the current settings and selections.

h. Finally, UNLESS YOU ARE USING DDE click on the ‘OK’ button to import the Employee records. Note, Peachtree will
add new records for employees not found and update those that are already present. This step is done only if doing
\import, not DDE transfer.

IV. Transferring Employees Using DDE

Instead of using the Peachtree Import Utility to import Employees, you can also use DDE to transfer employees from
MicroStaffer to Peachtree. This is a more convenient an simpler method of synchronizing the two employee lists, especially
on an ongoing basis whenever you enter new employees.

The only requirement for using DDE is that you must create an import template in Peachtree Accounting as described in
step 3 above.

The name of this template must be entered into the User Preferences which can be accessed by clicking on the Standard
Windows menu in MicroStaffer and selecting User->Preferences.

This window also contains settings that will automatically update Peachtree accounting each time an Employee record is
added or edited.
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4. Peachtree Check Export

Before you can transfer Payroll Journal entries from MicroStaffer into Peachtree Accounting, you must set up Payroll Field
ID’s, GL account numbers and Payroll Checking account numbers within MicroStaffer. These can only be set up once you
have generated at least one payroll check in MicroStaffer by using the ‘Export’ button on the Main Payroll Window in Micro-
Staffer.

After you have generated a payroll check in MicroStaffer, the check will be displayed on the Payroll Window’s Summary Tab.

Click on the ‘Export’ button, then select Peachtree Payroll Export from the ‘Export Type’ dropdown, then click on the ‘Setup’
button.

On the Peachtree Check Export window you must fill in the Field Number, Field Account and possible the Field Expense
account for each payroll item that is used in your system. You must also enter the Cash Account for Payroll.

Please note that with respect to the Field Number, Peachtree documentation is EXTREMELY vague and we ask you to
forgive us for any difficulty in entering the Field Numbers for each payroll item.

I. Field Number: Each payroll item (eg. Gross Pay, Federal Income Tax, FICA etc.) must have it's appropriate Field
Number filled in. To accurately determine the Field Number applicable to each item you must access the Peachtree
Employee Defaults window. To open this window in Peachtree, from the main menu click on Maintain->Default
Information->Employees.

Export pay field ID numbers range from 1 through 20.
Export Employee tax fields range from 22 through 50
Export Employer tax fields range from 51 through 60

DDE pay field ID number =1
DDE Employee tax fields range from 2 through 30
DDE Employer tax fields range from 31 through 40

The following is an example of Field ID’s in Peachtree and their mappings to MicroStaffer Field Numbers:

Peachtree Field Name Import/ExportiD DDEID MicroStaffer Field

Salary 1 1 Gross Pay

Fed_Income 22 2 Federal Income Tax

Soc_Sec 23 3 FICA

Medicare 24 4 Medicare

State 25 5 State Tax in MicroStaffer

K401 26 6 Custom Deduction in MicroStaffer
Soc_Sec_ER 51 31 Employer Contribution in MicroStaffer
Medicare_ER 52 32 Employer Contribution in MicroStaffer

FUTA_ER 53 33 Employer Contribution in MicroStaffer
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I. Field Account: For each applicable payroll item you must enter the Peachtree Account. These account numbers can
be found on any Peachtree Employee Defaults window. For Gross Pay in MicroStaffer use the G/L account number
for Gross Pay on the Peachtree Employee Defaults window EmployEE Fields tab where it lists Gross (eg. 77500).
For Employee deductions and taxes use the items on this tab below Gross. For Employer contributions use the
EmployER tab Liability Account numbers.

Il. Field Expense Account: These values apply only to Employer contributions. They should be left blank for Non-
Employer-Contributions. Examples here are FUTA, FICA (Employer) etc. The account numbers can be found on the
EmployER tab on the Peachtree Employee Defaults window.

lll. Cash Account: Enter the Cash Account from where Payroll Checking comes from. For example, you could enter
10300. This number comes from your Peachtree Chart of Accounts.

Finally, you can click OK and then select the Export file into which to export the payroll transactions that you later will import

into Peachtree (eg. PAYROLL.CSV)

5. Peachtree Payroll Journal Import

To begin Payroll Journal Entries into Peachtree Accounting you must first create an Import Template.

Once the export file has been created from MicroStaffer (C:\PAYROLL.CSV), start Peachtree Acounting and do the following
to import the payroll entries records:

1. Click on File->Select Import/Export from the main menu within Peachtree.

2. Click on Payroll then Payroll Journal then click on Import from the Toolbar. The Employee List window will open.

3. On the ‘Fields’ tab begin by clicking on the Show None button. Then on the ‘Field Settings’ list click each ‘Show’ column
in this EXACT order:

Col1  Employee D

Col2 Check Number

Col3 Date

Col4 CashAccount

Col5 Pay Period

Col6  Weeks in Pay Period
Col7  Number of Distributions
Col8 Pay Field-Number

Col9 Pay Field-Account
Col10 Pay Field-Expense Account
Col11 Pay Field-Amount
Col12 Pay Field-Memo Amount

The numbers under the ‘Col # field on the Peachtree Fields List must match those numbers above.

4. Next, click on the ‘Options’ tab

5. Under ‘Import Options’ check ‘First Row Contains Headings’. This MUST be checked!

6. Under ‘Import/Export file select the file that was used to export checks from MicroStaffer

7. We now recommend that you click on the ‘Save’ button to save the Import Template. This way, any time you wish to
import new checks into the payroll journal, you can simply access the Saved Import Template which will contain all the
current settings and selections.

8. Finally click on the ‘OK’ button to import the Payroll records. Note, Peachtree will add new records for checks not found
and update those that are already present.
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6. Peachtree Customer Synchronization

In order to be able to Transfer Sales Journal entries to Peachtree Accounting it is required that each invoice record sent from
MicroStaffer have a matching Customer ID record in Peachtree.

MicroStaffer uses the ‘External ID’ field on the Client record for this purpose. It is the MicroStaffer user’s responsibility to
ensure that each MicroStaffer Client's External ID field matches with it's Customer ID counterpart in Peachtree.

While you may achieve this synchronization manually, MicroStaffer also allows you to both populate the MicroStaffer Client
External ID systematically as well as export Client Records into Peachtree using both the MicroStaffer Export window and/or
DDE.

Note: If you are planning to use DDE only to transfer and maintain Customer Records between MicroStaffer and
Peachtree you must only complete Steps | and lll below. You do not have to create the MicroStaffer Export file
thatis.
l. Maintaining the External ID Field
I.  Populating the MicroStaffer Client External ID Field
Itis possible to set every Client External ID field in Microstaffer by accessing the Client Setup window in MicroStaffer
and then selecting Utilities->Set All External ID’s to...

A System ID: Sets all External ID fields for all clients to the MicroStaffer internal System ID.

B. Name Alpha-Key: Sets all External ID fields to the client’'s name. Duplicates will be set to name +
internal system ID.

C Business Works Name Key

D Peachtree Classic Name Key

ll. Importing Customers into Peachtree
Once the export file has been created (C:\CUSTOMER.CSV), start Peachtree Acounting and do the following to import the

Customer records:

I.  Click on File->Select Import/Export from the main menu within Peachtree.

Il. Click on Accounts Receivable then Customer List then click on Import from the Toolbar. The Customer List window will
open.

lll. On the ‘Fields’ tab begin by clicking on the Show None button. Then on the ‘Field Settings’ list click each ‘Show’
column in this EXACT order:

A. Customer ID

Customer Name

Contact

Bill to Address Line-One

Bill to Address Line-Two

Bill to City

Bill to State

Bill to Zip

Telephone 1

Telephone 2

Fax Number

E-Mail Address

FRC~"IETMMOO®

The numbers under the ‘Col # field on the Peachtree Fields List must match those numbers above.
V. Next, click on the ‘Options’ tab

V. Under ‘Import Options’ check ‘First Row Contains Headings’. This MUST be checked!

VI. Under ‘Import/Export’ file select the file that was used in Step B above.
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VII. We now recommend that you click on the ‘Save’ button to save the Import Template. This way, any time you wish to
update the customer records or import new additions to the customer list, you can simply access the Saved Customer
Template which will contain all the current settings and selections.

VIII. Finally, UNLESS YOU ARE USING DDE click on the ‘OK’ button to import the Customer records. Note, Peachtree will
add new records for customers not found and update those that are already present. This step is done only if doing
import, not DDE transfer.

lll. Transferring Customers Using DDE

Instead of using the Peachtree Import Utility to import Customers, you can also use DDE to transfer customers from Micro-
Staffer to Peachtree. This is a more convenient and simpler method of synchronizing the two customer lists, especially on
an ongoing basis whenever you enter new customers.

The only requirement for using DDE is that you must create an import template in Peachtree Accounting as described in
step 3 above.

The name of this template must be entered into the User Preferences which can be accessed by clicking on the Standard
Windows menu in MicroStaffer and selecting User->Preferences.

This window also contains settings that will automatically update Peachtree accounting each time a Customer record is
added or edited.
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7. Peachtree Invoice Export

To export Invoices from MicroStaffer for later Import into Peachtree Accounting you must first retrieve the desired invoices on
the MicroStaffer Main Invoice window.

Click on the Export button and Select Peachtree Accounting from the Export Type dropdown.

Click on the ‘Options Button’ to enter the proper Peachtree Accounts Receivable and GL Account Numbers for invoices.
These can be viewed in the Peachtree Chart of Accounts.

To export the invoices just click OK and enter the desired file location and name.

To use DDE, just select the DDE transfer/export option.

8. Peachtree Sales Journal Import

To begin Sales Journal Entries into Peachtree Accounting you must first create an Import Template.

You can create the Peachtree Import file by accessing the MicroStaffer main invoice window, retrieving one or more invoices
and clicking the Export button. Then select the Peachtree Export format from the dropdown.

Once the export file has been created from MicroStaffer (C:\\SALES.CSV), start Peachtree Acounting and do the following to
import the sales journal entry records:

I.  Click on File->Select Import/Export from the main menu within Peachtree.

IIl. Click on Accounts Receivable then Sales Journal then click on Import from the Toolbar. The Sales Journal window will
open.

lll. On the ‘Fields’ tab begin by clicking on the Show None button. Then on the ‘Field Settings’ list click each ‘Show’
column in this EXACT order:

A. Customer ID

Invoice ID

Date

Date Due

Accounts Receivable Account

Number of Distributions

Description

G/L Account

Tax Type

Amount

CTIEMMUOW

The numbers under the ‘Col # field on the Peachtree Fields List must match those numbers above.

IV. Next, click on the ‘Options’ tab

V. Under ‘Import Options’ check ‘First Row Contains Headings’. This MUST be checked!

VI. Under ‘Import/Export’ file select the file that was used to export invoices from MicroStaffer

VII. We now recommend that you click on the ‘Save’ button to save the Import Template. This way, any time you wish to
import new Invoices into the Sales Journal, you can simply access the Saved Import Template which will contain all the
current settings and selections.

VIII. Finally click on the ‘OK’ button to import the Sales Journal records. Note, Peachtree will add new records for checks
not found and update those that are already present.
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9. Peachtree DDE Preferences

MicroStaffer allows you to set preferences for DDE transfer of Accounts Receivable, Customer, Payroll and Employee
records.

These settings can be used to automatically update Peachtree Accounting when generating new Invoices and Payroll and
when both updating and creating new Employees and Customers.

The user preferences window can be accessed from anywhere in the system by clicking on the Standard Windows menu at
the very top of the MicroStaffer application and selecting User->Preferences.
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Xl. Troubleshooting

A. System Crashes

Unfortunately, Windows is not always a stable environment. Factors such as the number of processes, memory, CPU,
display types etc. affect each PC differently.

Occasionally, MicroStaffer may experience what is called a System Crash. Usually, this is a Fatal Error that will shut down
the application completely and generate an operating system error log entry.

The first thing to do in such an event is to restart the computer. This usually remedies these problems and also completely
restarts the MicroStaffer database server (desktop systems only).

If the problems persist, call technical support.

Systems running on Windows 95, 98 or ME are also susceptible to crashes because of the built-in resource limitations of
these versions of Windows. We highly recommend that all MicroStaffer desktop PC’s run Windows NT 4.0, 2000 Profes-
sional or XP (Home or Professional). Remember that Windows 95,98 and ME are Home Based version of windows and are
not intended for use with business applications such as MicroStaffer.

If you must run on windows 95, 98 or ME, you should not open more than one window simultaneously within MicroStaffer.
You should also run the Windows Resource Meter (located under the Accessories Program Group within Windows) to
monitor the resources on an ongoing basis while running MicroStaffer.
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B. Logins Exceeded Message

The ‘Logins Exceeded’ message appears on user licensed systems whenever the number of users has exceeded the license
maximum. This can occur on both desktop and network systems.

Should the message appear on a desktop system, we recommend that you restart the PC. This should make the message
disappear.

On network systems you will be shown the currently logged in sessions. These each represent one connection to the
database server.

Normally, each process is from a different machine on the network. However, if you or another user had to ‘Hard Boot’ or
Power down the PC unexpectedly without shutting down properly, you will remain logged into the server even though your PC
is shut down. This is what ‘s called ‘Orphaned Processes’. While the SQL Database server will eventually terminate the
Orphaned process, it may take considerable time before the job is killed.

The logins’ window allows you to kill any orphaned processes owned by your PC as well as any other processes (given you
have been granted Kill permission).

Killing processes frees up user login licenses.

1‘* System Settings

Statuz Codes | Modules | Ticklers Logins |Ta:-:e& |
Currently active MicraStaffer zezsions
SFID Metwork User Mame Login Time Ihactive Since  Minutes Inactive iy 2 kil
2p250 Thursday 2:54 PM BT —
9 ap2hl Thursday 2254 PM 2:54 PM 0.00
| | 2+

0K I &3 Cancel | 2 Apply | =¢ Piint % Help |
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C. Unable to Insert Unpaid Break into Rates Setup

Whenever you are entering Pay or Billing rates, you will notice a checkbox called ‘Unpaid Break'.

This checkbox indicates that the period covered by the start and end time of the selected rate row will not be billed (unless of
course the break was not taken) or paid.

This checkbox is only enabled when the rate row resides between two non-break rows.

For example, you must enter at least 3 rows and then only the middle row would have the checkbox enabled.

Row1 7a-12p
Row?2 12p-12:30p
Row 3 12:30p - End of Shift

.J MicroStaffer - Sample Medical Staffing Company

File Emplopee Customer Staffing Invoicing Payroll Beports  Spstem  Edit User Window Help

lae=e EBEES® BEH =2 |8

| Rates Setup

Customer: [#laska Fiegional Hospital =] I Display Inactive

Shifts and Rates | Description
= Rgh Day.......[7:00 am - 3:00 pm) Faio D 113
andard Rate
"gei - p1-DD o) Description: Standard Rate
4 Hight.......(11:00 pm - 7:00 am)] Last Mocified On: D2/20/2002
o i 0 2 700 pn) Last Modified By: Admiristrator

-4 7P [7:00 pm - 700 am] R} Efoperties |
ST DeEe |
l) Eopy |

Shift Period: [7:00 Ak - 3:00 Ph) Sodd|Fate Period!
[Rate Starts at___ Ends at WMor | Tue | Wed | Thu | Fi | Set | Sun [dnpaid Break?
1. [7o0am I 200 PM azon] 4zo0] 4zo0] 4zoo] szoof 4aoo0] 4300 Leleiz Fiaiz Paiod

2 [izooFM fizzopM | [ 4zoo[ azod[ 4200 4zoof 2200 4zo0f 4300

B [iz30Fm [Erdershit [ 4zoo| 4zoo| 4zoof 4zoo] azoo| asoo[ asog Il Epgatiom
ads

—

Erint

[Right Click to Copy Aate Rows or Rate Grid)

|Ready |03/21/2002 11:01 FM
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D. Unable to Connect

Whenever you start the MicroStaffer application it will automatically attempt to connect to the database. This action occurs
during the time the MicroStaffer splash screen is displayed.

Even though you are prompted by a login window which asks you for your user id and password, MicroStaffer has already
connected to the database at this point. So, once you get the login window, your connection has already been made.

The following are some guidelines for when the database connection fails.

|.  Desktop Systems:

A

Incorrect connection settings. Check you ODBC settings in the Control Panel for the MicroStaffer Database
Server

B. Insufficient memory: Ensure that you have at least 32MB of Ram.

C. Corrupt Database: Contact technical support.

D. OS Failure: Try restarting the computer

Il. Network Systems:

A. Incorrect connection settings: Open the MicroStaffer Connect window and click on properties to ensure the
proper entries have been made

B. Database Server not running: Ensure that the Microsoft or Sybase database server is running on the
Network server

C. Unable to Ping Server: Go to DOS prompt and try entering PING followed by the Network server name or IP
address. If you cannot PING successfully, contact your Network support staff.

D. Restart Server: Try restarting the Network server.

E. Not Logged in Properly: You must have Client for Windows Network installed on you PC (See

Network Neighborhood or My Network Places) and you MUST have logged into your PC with a
valid User ID Password.
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XIl. Notes
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